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Executive Summary 1 

▪ Mobile devices provide access to workplace data and resources that are vital for organizations 2 
to accomplish their mission while providing employees the flexibility to perform their daily 3 
activities. Securing these devices is essential to the continuity of business operations. 4 

▪ While mobile devices can increase organizations’ efficiency and employee productivity, they can 5 
also leave sensitive data vulnerable. Addressing such vulnerabilities requires mobile device 6 
management tools to help secure access to the network and resources. These tools are different 7 
from those required to secure the typical computer workstation. 8 

▪ To address the challenge of securing mobile devices while managing risks, the National 9 
Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 10 
Technology (NIST) built a laboratory environment to explore how various mobile security 11 
technologies can be integrated within an enterprise’s network. 12 

▪ This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-13 
based, commercially available products to help meet their mobile device security and privacy 14 
needs. 15 

CHALLENGE 16 

Mobile devices are a staple within modern workplaces. As employees use these devices to perform 17 

everyday enterprise tasks, organizations are challenged with ensuring that devices regularly process, 18 

modify, and store sensitive data securely. These devices bring unique threats to the enterprise and 19 

should be managed in a manner distinct from traditional desktop platforms. This includes securing 20 

against different types of network-based attacks on mobile devices that have an always-on connection 21 

to the internet.  22 

Managing the security of workplace mobile devices and minimizing the risk posed can be challenging 23 

because there are many mobile device security tools available. Proper implementation is difficult to 24 

achieve for an end user because the method of implementation varies considerably from tool to tool. In 25 

addition, unfamiliarity with the threats to mobile devices can further compound these implementation 26 

difficulties. 27 

SOLUTION 28 

To address the challenge of securing mobile devices within an enterprise, NIST built an example solution 29 

in a lab environment at the NCCoE to demonstrate mobile management tools that enterprises can use 30 

to secure their networks. These technologies are configured to protect organizational assets and end-31 

user privacy, providing methodologies to enhance the security and privacy posture of the adopting 32 

organization.  33 

Both Apple iOS and Android devices are used in the example solution, which includes detailed device 34 

configurations and enterprise mobility management policies provisioned to the devices. The foundation 35 

of this architecture is based on federal U.S. guidance, including that from NIST 800 series publications, 36 

National Information Assurance Partnership, U.S. Department of Homeland Security, and the Federal 37 
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Chief Information Officers Council. These standards, best practices, and certification programs help 38 

ensure the confidentiality and integrity of enterprise data on mobile systems. 39 

This guide provides: 40 

▪ a detailed example solution and capabilities that address risk and implementation of security 41 
controls 42 

▪ a demonstration of the approach using commercially available products 43 

▪ how-to instructions for implementers and security engineers, with instructions on integrating 44 
and configuring the example solution into their organization’s enterprise in a manner that can 45 
achieve security goals with minimum impact on operational processes 46 

The NCCoE sought existing technologies that provided the following capabilities: 47 

▪ enhanced protection of data that resides on the mobile device  48 

▪ centralization of management systems to deploy policies and configurations to devices 49 

▪ ability to evaluate the security of mobile applications 50 

▪ inhibition of the eavesdropping of mobile device data when traversing a network 51 

▪ privacy settings that protect end-user data 52 

▪ protection from phishing attempts 53 

Commercial, standards-based products such as the ones we used are readily available and interoperable 54 

with existing information technology (IT) infrastructure and investments. 55 

While the NCCoE used a suite of commercial products to address this challenge, this guide does not 56 

endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your 57 

organizationʼs information security experts should identify the products that will best integrate with 58 

your existing tools and IT system infrastructure. Your organization can adopt this solution or one that 59 

adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 60 

implementing parts of a solution. 61 

BENEFITS  62 

The NCCoE’s practice guide Mobile Device Security: Corporate-Owned Personally-Enabled (COPE) can 63 

help your organization: 64 

▪ reduce adverse effects on the organization if a device is compromised 65 

▪ reduce capital investment by embracing modern enterprise mobility models 66 

▪ apply robust, standards-based technologies using industry best practices 67 

▪ reduce privacy risks to users through privacy protections 68 

▪ provide users with enhanced protection against loss of personal and business data when a 69 
device is stolen or misplaced 70 

▪ deploy enterprise management technologies to improve the security of enterprise networks, 71 
devices, and applications 72 
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▪ reduce risk so that employees can access the necessary data from nearly any location, using a 73 
wide selection of mobile devices and networks 74 

▪ enhance visibility for system administrators into mobile security events, quickly providing 75 
notification and identification of device and data compromise 76 

▪ implement government standards for mobile security  77 

SHARE YOUR FEEDBACK 78 

You can view or download the guide at https://www.nccoe.nist.gov/projects/building-blocks/mobile-79 

device-security/enterprise. Help the NCCoE make this guide better by sharing your thoughts with us as 80 

you read the guide. If you adopt this solution for your own organization, please share your experience 81 

and advice with us. We recognize that technical solutions alone will not fully enable the benefits of our 82 

solution, so we encourage organizations to share lessons learned and best practices for transforming the 83 

processes associated with implementing this guide.  84 

To provide comments or to learn more by arranging a demonstration of this example implementation, 85 

contact the NCCoE at mobile-nccoe@nist.gov.  86 

TECHNOLOGY PARTNERS/COLLABORATORS 87 

Organizations participating in this project submitted their capabilities in response to an open call in the 88 

Federal Register for all sources of relevant security capabilities from academia and industry (vendors 89 

and integrators). The following respondents with relevant capabilities or product components (identified 90 

as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 91 

Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution. 92 

 93 

Certain commercial entities, equipment, products, or materials may be identified by name or company 94 

logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 95 

experimental procedure or concept adequately. Such identification is not intended to imply special 96 

status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 97 

intended to imply that the entities, equipment, products, or materials are necessarily the best available 98 

for the purpose. 99 

 

The National Cybersecurity Center of Excellence (NCCoE), a part of 
the National Institute of Standards and Technology (NIST), is a 
collaborative hub where industry organizations, government 
agencies, and academic institutions work together to address 
businesses’ most pressing cybersecurity challenges. Through this 
collaboration, the NCCoE develops modular, easily adaptable 
example cybersecurity solutions demonstrating how to apply 
standards and best practices using commercially available 
technology. 

 LEARN MORE  

Visit http://www.nccoe.nist.gov  
nccoe@nist.gov  
301-975-0200 

 

 

https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/enterprise
https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/enterprise
mailto:mobile-nccoe@nist.gov
http://www.nccoe.nist.gov/
mailto:nccoe@nist.gov
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority. 26 

ABSTRACT 27 

Mobile devices provide access to workplace data and resources that are vital for organizations to 28 
accomplish their mission while providing employees the flexibility to perform their daily activities. 29 
Securing these devices is essential to the continuity of business operations.  30 

While mobile devices can increase organizations’ efficiency and employee productivity, they can also 31 
leave sensitive data vulnerable. Addressing such vulnerabilities requires mobile device management 32 
tools to help secure access to the network and resources. These tools are different from those required 33 
to secure the typical computer workstation.  34 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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To address the challenge of securing mobile devices while managing risks, the NCCoE at NIST built a 35 
reference architecture to show how various mobile security technologies can be integrated within an 36 
enterprise’s network.  37 

This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-based, 38 
commercially available products to help meet their mobile device security and privacy needs. 39 

KEYWORDS 40 

Bring your own device; BYOD; corporate-owned personally-enabled; COPE; mobile device management; 41 
mobile device security, on-premise. 42 
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The Technology Partners/Collaborators who participated in this build submitted their capabilities in 45 
response to a notice in the Federal Register. Respondents with relevant capabilities or product 46 
components were invited to sign a Cooperative Research and Development Agreement (CRADA) with 47 
NIST, allowing them to participate in a consortium to build this example solution. We worked with: 48 

Technology Partner/Collaborator Build Involvement 

Appthority  Appthority Cloud Service, Mobile Threat Intelligence 

Kryptowire  Kryptowire Cloud Service, Application Vetting 

Lookout  Lookout Cloud Service/Lookout Agent Version 5.10.0.142 
(iOS), 5.9.0.420 (Android), Mobile Threat Defense 

MobileIron  MobileIron Core Version 9.7.0.1, MobileIron Agent 
Version 11.0.1A (iOS), 10.2.1.1.3R (Android), Enterprise 
Mobility Management 

Palo Alto Networks Palo Alto Networks PA-220 

Qualcomm Qualcomm Trusted Execution Environment (version is 
device dependent) 
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1 Summary 205 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide seeks to address 206 
mobile device security implementation challenges in several ways: by analyzing a set of mobile security 207 
and privacy threats; exploring mitigating technologies; and describing a reference design based upon 208 
those technologies to help mitigate the identified threats. 209 

Incorporating mobile devices into the organizational enterprise provides greater flexibility in how 210 
employees access organizational resources. For some organizations, this flexibility supports a hybrid 211 
approach enhancing their traditional in-office processes with more responsive communication and 212 
adaptive workflows. 213 

For others, this flexibility, combined with growing mobile functionality, fosters a mobile-first approach in 214 
which their employees primarily communicate and collaborate using mobile devices. However, some of 215 
the features that make mobile devices increasingly flexible and functional also make them challenging to 216 
deploy and manage with security in mind. 217 

Further, organizations are becoming progressively cognizant of the privacy implications for their 218 
employees that arise from using mobile security technologies. Therefore, developing a successful mobile 219 
deployment strategy requires organizations to evaluate their security and privacy requirements. 220 

Although organizations may be aware of the security and privacy risks that can be introduced by mobile 221 
devices, addressing them strategically and technically can pose a barrier to implementing mobile device 222 
security capabilities. This barrier is particularly challenging for businesses to overcome. As a result, they 223 
may choose to enable mobile access with minimal acceptable use policies, employee awareness, or 224 
security controls to limit implementation challenges. 225 

To help address mobile device security and privacy risks, this document’s reference design provides: 226 

 a description of a mobile deployment strategy featuring an on-premises enterprise mobility 227 
management (EMM) solution integrated with cloud- and agent-based mobile security 228 
technologies to help deploy a set of security and privacy capabilities in support of a corporate-229 
owned personally-enabled (COPE) mobile device usage scenario 230 

 a series of How-To Guides—step-by-step instructions covering the initial setup (installation or 231 
provisioning) and configuration for each component of the architecture—to help security 232 
engineers rapidly deploy and evaluate our example solution in their test environment 233 

The example solution of our reference design uses standards-based, commercially available products. It 234 
can be used directly by any organization with a COPE usage scenario by implementing a security 235 
infrastructure that supports integration of on-premises with cloud-hosted mobile security technologies. 236 
Alternatively, an organization may use our reference design and example solution in whole or part as 237 
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the basis for a custom solution that realizes the security and privacy characteristics that best support its 238 
unique mobile device usage scenario. 239 

1.1 Challenge 240 

Mobile devices are a staple within modern workplaces, and as employees use these devices to perform 241 
everyday enterprise tasks, organizations are challenged with ensuring that devices regularly process, 242 
modify, and store sensitive data securely. They bring unique threats to the enterprise and need to be 243 
managed differently from traditional desktop platforms. 244 

 Due to their unique capabilities, mobile devices’ specific security challenges can include: 245 

 securing their always-on-connections to the internet from network-based attacks 246 

 securing the data on devices to prevent compromise via malicious applications 247 

 protecting them from phishing attempts that try to collect user credentials or entice a user to 248 
install software 249 

 selecting from the many mobile device management tools available and implementing their 250 
protection capabilities consistently 251 

 identifying threats to mobile devices and how to mitigate them 252 

Given these challenges, managing the security of workplace mobile devices and minimizing the risk 253 
posed can be complex. By providing an example solution that organizations can make immediate use of, 254 
this guide provides an example solution to help simplify deployment of mobile device security 255 
capabilities. 256 

1.2 Solution 257 

In our lab at the National Cybersecurity Center of Excellence (NCCoE), NIST engineers built an 258 
environment that contains an example solution for managing the security of mobile devices. In this 259 
guide, we show how an enterprise can leverage this infrastructure to implement on-premises enterprise 260 
mobility management (EMM), mobile threat defense (MTD), mobile threat intelligence (MTI), 261 
application vetting, secure boot/image authentication, and virtual private network (VPN) services. 262 

Further, these technologies were configured to protect organizational assets and end-user privacy, 263 
providing methodologies to enhance the security posture of the adopting organization. The foundation 264 
of this architecture is based on federal United States guidance, including that from the NIST 800 series 265 
publications [1], the National Information Assurance Partnership (NIAP) [2], the Department of 266 
Homeland Security [3], and the Federal Chief Information Officers (CIO) Council [4]. These standards, 267 
best practices, and certification programs help ensure the confidentiality, integrity, and availability of 268 
enterprise data on mobile systems. 269 

This guide provides: 270 
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 a detailed example solution with capabilities that mitigate common mobile threats 271 

 a demonstration of an approach that uses commercially available products 272 

 step-by-step installation how-to guidance for implementers, which is designed to easily 273 
integrate with existing systems to improve the organization’s mobile security posture with 274 
minimal disruption to operations 275 

The NCCoE sought existing technologies that provided the following capabilities: 276 

 ability to help protect data resident on the mobile device  277 

 utilization of centralized management systems to deploy policies and configurations to devices 278 

 vetting the security of mobile applications 279 

 ability to help protect data from eavesdropping while traversing a network 280 

 privacy settings to enable the predictability, manageability, and disassociability of end-usersʼ 281 
personally identifiable information (PII) 282 

Commercial, standards-based products such as the ones we used are readily available and interoperable 283 
with existing information technology (IT) infrastructure and investments. 284 

1.2.1 Standards and Guidance 285 

The following standards and guidance have been consulted for this publication: 286 

 NIST Cybersecurity Framework Version 1.1 [5] 287 

 NIST Mobile Threat Catalogue [6] 288 

 NIST Risk Management Framework [7] 289 

 NIST Special Publication (SP) 1800-4, Mobile Device Security: Cloud and Hybrid Builds [8] 290 

 NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments [9] 291 

 NIST SP 800-37 Revision 2, Risk Management Framework for Information Systems and 292 
Organizations [10] 293 

 NIST SP 800-46 Revision 2, Guide to Enterprise Telework, Remote Access, and Bring Your Own 294 
Device (BYOD) Security [11] 295 

 NIST SP 800-52 Revision 1, Guidelines for the Selection, Configuration, and Use of Transport 296 
Layer Security (TLS) Implementations [12] 297 

 NIST SP 800-53 Revision 4, Security and Privacy Controls for Federal Information Systems and 298 
Organizations [13] 299 

 NIST SP 800-63-3, Digital Identity Guidelines [14] 300 

 NIST SP 800-113, Guide to SSL VPNs [15] 301 
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 NIST SP 800-114 Revision 1, Userʼs Guide to Telework and Bring Your Own Device (BYOD) 302 
Security [16] 303 

 NIST SP 800-124 Revision 1, Guidelines for Managing the Security of Mobile Devices in the 304 
Enterprise [17] 305 

 NIST SP 800-163 Revision 1, Vetting the Security of Mobile Applications [18] 306 

 NIST SP 800-171, Protecting Controlled Unclassified Information in Nonfederal Systems and 307 
Organizations [19] 308 

 NIST SP 800-181, National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce 309 
Framework [20] 310 

 Center for Internet Security [21] 311 

 Executive Office of the President, Bring Your Own Device Toolkit [22] 312 

 Federal Chief Information Officers (CIO) Council and Department of Homeland Security (DHS) 313 
Mobile Security Reference Architecture, Version 1.0 [23] 314 

 Digital Services Advisory Group and Federal Chief Information Officers Council, Government Use 315 
of Mobile Technology Barriers, Opportunities, and Gap Analysis [24] 316 

 International Organization for Standardization (ISO), International Electrotechnical Commission 317 
(IEC) 27001:2013, Information technology–Security techniques–Information security 318 
management systems–Requirements [25] 319 

 Mobile Computing Decision Example Case Study [26] 320 

 Mobile Services Category Team (MSCT) Advanced Technology Academic Research Center 321 
(ATARC), Mobility Strategy Development Guidelines Working Group Document [27] 322 

 MSCT ATARC, Mobile Threat Protection App Vetting and App Security Working Group Document 323 
[28] 324 

 MSCT, Device Procurement and Management Guidance [29] 325 

 MSCT, Mobile Device Management (MDM), MDM Working Group Document [30] 326 

 MSCT, Mobile Services Roadmap, MSCT Strategic Approach [31] 327 

 NIAP U.S. Government Approved Protection Profile—Extended Package for Mobile Device 328 
Management Agents Version 3.0 [32] 329 

 NIAP U.S. Government Approved Protection Profile—Protection Profile for Mobile Device 330 
Fundamentals Version 3.1 [33] 331 

 NIAP U.S. Government Approved Protection Profile—Protection Profile for Mobile Device 332 
Management Version 3.0 [34] 333 

 NIAP Product Compliant List [35] 334 
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 United States Office of Management and Budget (OMB), Category Management Policy 16-3: 335 
Improving the Acquisition and Management of Common Information Technology: Mobile 336 
Devices and Services [36] 337 

 The United States Government Configuration Baseline (USGCB) [37] 338 

 United State Department of Homeland Security (DHS) Study on Mobile Device Security [38] 339 

Note that Defense Federal Acquisition Regulation Supplement regulations are out of scope for this 340 
effort. 341 

1.3 Benefits 342 

The potential business benefits of the example solution explored by this project are to: 343 

 provide users with enhanced protection against both malicious applications and loss of personal 344 
and business data when a device is stolen or misplaced 345 

 reduce adverse effects on an organization if a device is compromised 346 

 reduce capital investment by embracing modern enterprise mobility models 347 

 provide visibility for system administrators into mobile security events, enabling automated 348 
identification and notification of a compromised device 349 

 provide modular architecture based on technology roles while remaining vendor-agnostic 350 

 facilitate multiple mobile device usage scenarios using COPE devices 351 

 apply robust, standards-based technologies using industry best practices 352 

 demonstrate secure mobile access to organizational resources such as intranet, email, contacts, 353 
and calendar 354 

 illustrate the application of the NIST Risk Management Framework to mobility scenarios 355 

2 How to Use This Guide 356 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 357 
users with the information they need to replicate how to improve mobile device security with on-358 
premises mobile device management solutions. This reference design is modular and can be deployed in 359 
whole or in part. 360 

This guide contains three volumes: 361 

 NIST SP 1800-21A: Executive Summary  362 

 NIST SP 1800-21B: Approach, Architecture, and Security Characteristics – what we built and why 363 
(you are here) 364 

https://usgcb.nist.gov/
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 NIST SP 1800-21C: How-To Guides – instructions for building the example solution 365 

Depending on your role in your organization, you might use this guide in different ways: 366 

Business decision makers, including chief security and technology officers, will be interested in the 367 
Executive Summary, NIST SP 1800-21A, which describes the following topics: 368 

 challenges that enterprises face in securing mobile devices from threats that are distinct from369 
traditional desktop platforms370 

 example solution built at the NCCoE371 

 benefits of adopting the example solution372 

Technology or security program managers who are concerned with how to identify, understand, assess, 373 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-21B, which describes what we 374 
did and why. The following sections will be of particular interest: 375 

376 

377 

 Section 3.4, Risk Assessment, provides a description of the risk analysis we performed

 Section 4.3, Security Control Map, maps the security characteristics of this example solution to 
cybersecurity standards and best practices 378 

You might share the Executive Summary, NIST SP 1800-21A, with your leadership team members to help 379 
them understand the importance of adopting standards-based solutions to improve mobile device 380 
security with on-premises mobile device management solutions. 381 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 382 
You can use the how-to portion of the guide, NIST SP 1800-21C, to replicate all or parts of the build 383 
created in our lab. The how-to portion of the guide provides specific product installation, configuration, 384 
and integration instructions for implementing the example solution. We do not re-create the product 385 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 386 
incorporated the products together in our environment to create an example solution. 387 

This guide assumes that IT professionals have experience implementing security products within the 388 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 389 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 390 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 391 
parts of this guide’s example solution for on-premises mobile device security management. Your 392 
organization’s security experts should identify the products that will best integrate with your existing 393 
tools and IT system infrastructure. We hope that you will seek products that are congruent with 394 
applicable standards and best practices. Section 3.6, Technologies, lists the products we used, and 395 
Appendix H maps them to the cybersecurity controls provided by this reference solution. 396 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 397 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 398 
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success stories will improve subsequent versions of this guide. Please contribute your thoughts to 399 
mobile-nccoe@nist.gov. 400 

2.1 Typographic Conventions 401 

The following table presents typographic conventions used in this volume. 402 

Typeface/ 
Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new terms; 
and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, onscreen 
computer output, sample code 
examples, and status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

3 Approach 403 

The NIST build team surveyed reports of mobile device security trends and openly invited the mobile 404 
device security community—including vendors, researchers, administrators, and users—to engage in a 405 
discussion about pressing cybersecurity challenges. The community expressed two significant messages. 406 

First, administrators experienced confusion about which policies and standards—out of myriad 407 
sources—should be implemented. Second, mobile device users were frustrated by the degrees to which 408 
enterprises have control over their mobile devices and maintain visibility into their personal activity. 409 

mailto:mobile-nccoe@nist.gov?subject=NIST%20SP%201800-21%20Thoughts
http://nccoe.nist.gov/
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Therefore, the NIST build team reviewed the primary standards, best practices, and guidelines from 410 
government sources and implemented a COPE usage scenario within this build. Additionally, this effort 411 
highlights several security characteristics and capabilities that are documented within the Mobile Device 412 
Security for Enterprises building block [39]. 413 

3.1 Audience 414 

This practice guide is for organizations that want to enhance mobile device deployment and 415 
management security, principally smartphones and tablets. It is intended for executives, security 416 
managers, engineers, administrators, and others who are responsible for acquiring, implementing, and 417 
maintaining mobile enterprise technology, including centralized device management, application 418 
vetting, and endpoint protection systems. 419 

This document will be of particular interest to system architects already managing mobile deployment 420 
solutions and those looking to deploy mobile devices in the near term. It assumes readers have a basic 421 
understanding of mobile device technologies and enterprise security principles. Please refer to Section 2 422 
for how different audiences can effectively use this guide. 423 

3.2 Scope 424 

The scope of this build includes managing mobile smartphones and tablets with on-premises EMM. 425 
Laptops are excluded from the scope of this publication, as the security controls available today for 426 
laptops differ significantly from those available for smartphones and tablets, although this is changing 427 
with the emergence of unified endpoint management capabilities.  428 

Devices with minimal computing capability are also excluded, including feature phones, wearables, and 429 
devices classified as part of the Internet of Things. Classified systems, devices, data, and applications are 430 
not addressed within this publication. 431 

The build team devised a fictional scenario centered around a mock organization (Orvilia Development) 432 
to provide context to our risk assessment and to enable us to architect a reference design to solve 433 
common enterprise mobile security challenges. Use of a scenario like Orvilia Development’s exemplifies 434 
the issues that an organization may face when addressing common enterprise mobile security 435 
challenges. We intend for the example solution proposed in this practice guide to be broadly applicable 436 
to enterprises, including both the public and private sectors. 437 

To focus specifically on mobile device threats that Orvilia may be exposed to with its recent 438 
organizational changes, the example solution does not specifically focus on insider threat events with 439 
corresponding mitigations. 440 

Additional options for deployment of Android, Apple, and Samsung Knox managed devices are discussed 441 
in Appendix D. 442 
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3.2.1 Orvilia Development 443 

The fictional organization, Orvilia Development, is a small start-up company providing IT services to 444 
many private sector organizations. Its service offerings include developing scalable web applications, 445 
improving existing IT systems, project management, and procurement. Orvilia recently won its first 446 
government contract. Given the organization’s current security posture, particularly in its use of mobile 447 
devices, complying with government regulations and heightened cybersecurity standards presents it 448 
with new challenges. 449 

Orvilia has a simple deployment of on-premises IT resources. It hosts its own Microsoft Active Directory 450 
domain, Microsoft Exchange email server, and web-based resources for employees, such as timekeeping 451 
and travel support. All enterprise resources can be directly accessed by employees locally or remotely 452 
from any internet-connected device by using password-based authentication. Orvilia also provides its 453 
employees with corporate-owned mobile devices. These may be used for personal activity, including 454 
phone calls, instant messaging, and installation and use of social applications. Employees also regularly 455 
work outside the office and frequently use public Wi-Fi networks at hotels, airports, and coffee shops. 456 

Orvilia’s mobile device deployment practice is still developing; it has minimal mobile device policies and 457 
has not implemented any additional security mechanisms such as enterprise mobility management. All 458 
policy and security enforcement actions are performed manually on an ad-hoc basis. Employees are 459 
expected to secure their own COPE devices, for instance via the timely installation of operating system 460 
(OS) updates, and to exercise good judgment regarding any personal use. 461 

However, no mechanisms have been put into place to prevent or detect misuse or device compromise. 462 
Further, corporate policy prohibits access to the corporate network from personally owned mobile 463 
devices, but no technical safeguards have been implemented to prevent employees from doing so. This 464 
posture had been promoted based on the organization’s small size, high level of employee technical 465 
acumen, and lack of awareness that it has been significantly impacted by any cybersecurity incidents. 466 

However, Orvilia’s new status as a contractor to a civilian government agency calls for it to achieve and 467 
maintain compliance with government policies, which require compliance with cybersecurity best 468 
practices and applicable standards. For example, Orvilia is required to secure its access to and storage of 469 
sensitive government information, which its employees will need to access from their mobile devices, 470 
both locally at agency sites and remotely from Orvilia or during travel. 471 

In addition to meeting compliance requirements rising from its contractual obligations to a government 472 
agency, Orvilia leadership is concerned about the potential for future incidents where nation-state 473 
malicious actors might obtain sensitive government data from unsecured devices and infrastructure. 474 
Therefore, a risk assessment as described in NIST SP 800-30 Revision 1, Guide for Conducting Risk 475 
Assessments [9] was performed using the risk management concepts shown in Figure 3-1. 476 
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Figure 3-1 Risk Management Approach 477 

The risk assessment revealed that Orvilia’s current mobile infrastructure places the organization at risk 478 
of intrusion and compromise of sensitive data. The results of the risk assessment process are presented 479 
in Appendix E. 480 

Based on the risk assessment findings, Orvilia chose to invest in security improvements to its mobile 481 
infrastructure. Details of Orviliaʼs new mobile device security infrastructure are provided in Section 4. As 482 
described in Section 4’s architecture design, Orviliaʼs new infrastructure addressed the concerns 483 
identified in its risk assessment. Orviliaʼs risk assessment team reviewed guidance by standards 484 
organizations and government agencies as part of its process and identified the standards and guidance 485 
identified in Section 1.2.1 as applicable to its organizational mobile use case. 486 

3.3 Assumptions 487 

This project is guided by the following assumptions: 488 

 The solution was developed in a lab environment based on a typical organization’s IT enterprise.489 
It does not reflect the complexity of a production environment.490 

 An organization has access to the skills and resources required to implement a mobile device491 
security solution.492 

 The benefits of adopting this particular mobile device security solution outweigh any additional493 
performance, reliability, or security risks that may be introduced. However, we draw the494 
reader’s attention to the fact that implementation of any security controls has the potential to495 
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increase or decrease the attack surface within an enterprise, the actual impact of which will vary 496 
from organization to organization. Because the organizational environment in which this build 497 
could be implemented represents a greater level of complexity than is captured in the current 498 
guide, we assume that organizations will first examine the implications for their current 499 
environment before implementing any part of the proposed solution.  500 

 Organizations have either already invested or are willing to invest in the security of mobile501 
devices used within their organization and of their IT systems more broadly. As such, we assume502 
they either have the technology in place to support this implementation or have access to the503 
off-the shelf information security technology used in this build, which we assume will perform as504 
described by the respective product vendor.505 

 Organizations have familiarized themselves with existing standards and any associated506 
guidelines (e.g., NIST Cybersecurity Framework [5], NIST SP 800-124 Revision 1 [17], NIST SP507 
1800-4 [8]) relevant to implementation of the solution proposed in this practice guide. We also508 
assume that any existing technology to be used in the proposed solution has been implemented509 
in a manner consistent with these standards.510 

 Organizations have instituted relevant mobile device security policies and that these will be511 
updated based on implementation of this solution.512 

3.3.1 Systems Engineering 513 

Some organizations use a systems engineering-based approach in planning and implementing their IT 514 
projects. Organizations wishing to implement IT systems are encouraged to conduct robust 515 
requirements development, taking into consideration the operational needs of each system stakeholder. 516 

The information contained within Section 4 of this volume provides architecture details to help 517 
understand the operational capabilities of the example solution. Guidance is also provided in standards 518 
such as the ISO/IEC/Institute of Electrical and Electronics Engineers 15288:2015, Systems and software 519 
engineering–System life cycle processes [40]; and NIST SP 800-160, Systems Security Engineering: 520 
Considerations for a Multidisciplinary Approach in the Engineering of Trustworthy Secure Systems [41], 521 
which provide guidance in this endeavor. With these standards, organizations can choose to adopt only 522 
those sections that are relevant to their environment and business context. 523 

3.4 Risk Assessment 524 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments [9], states that risk is “a measure of 525 
the extent to which an entity is threatened by a potential circumstance or event, and typically a function 526 
of: (i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 527 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 528 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 529 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 530 
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an information system. Part of risk management incorporates threat and vulnerability analyses, and 531 
considers mitigations provided by security controls planned or in place.” 532 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 533 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 534 
Information Systems and Organizations [10]−material that is available to the public. The Risk 535 
Management Framework (RMF) guidance [7], as a whole, proved to be invaluable in giving us a baseline 536 
to assess risks, from which we developed the project, the security characteristics of the build, and this 537 
guide. 538 

This section provides information on the risk assessment process employed to improve the mobile 539 
security posture of Orvilia Development. Typically, a NIST SP 800-30 Revision 1-based risk assessment 540 
follows a four-step process as shown in Figure 3-2: Prepare for assessment, conduct assessment, 541 
communicate results, and maintain assessment. Full details of the risk assessment can be found in the 542 
Risk Assessment Appendix. 543 

Figure 3-2 Risk Assessment Process 544 

The purpose of the risk assessment of Orvilia Development is to identify and document new risks to its 545 
mission resulting from Orvilia’s new status as a contractor to government agencies. 546 
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3.4.1 Risk Assessment of the Fictional Organization Orvilia Development 547 

This risk assessment is scoped to Orviliaʼs mobile deployment, which consists of mobile devices used to 548 
access Orvilia enterprise resources along with any backend IT components used to manage or provide 549 
services to those mobile devices. 550 

Risk assessment assumptions and constraints were developed using a NIST SP 800-30 Revision 1 Generic 551 
Risk Model as shown in Figure 3-3 to identify the following necessary components of the risk 552 
assessment: 553 

 threat sources554 

 threat events555 

 vulnerabilities556 

 predisposing conditions557 

 security controls558 

 adverse impacts559 

 organizational risks560 

Figure 3-3 NIST 800-30 Generic Risk Model 561 
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3.4.2 Development of Threat Event Descriptions 562 

Orvilia examined the sample tables in NIST SP 800-30 Revision 1—Table E-1, Table E-2, Table E-3, Table 563 
E-4, and Table E-5—and analyzed the sources of mobile threats. Using this process, Orvilia leadership 564 
identified the potential mobile device threat events that are described in the following subsections. A 565 
mapping of the threat events considered in this guide’s example solution to the Mobile Threat 566 
Catalogue can be found in Table 3-1. 567 

A note about selection of the threat events: These threat events were developed by identifying threats 568 
from the NIST Mobile Threat Catalogue [6] that would have the ability to significantly disrupt Orvilia’s 569 
processes. In the interest of brevity, we limited our identified threat events of concern to those that 570 
were presumed to average a foreseeably high likelihood of occurrence and high potential for adverse 571 
impact in Orvilia’s specific scenario. The threats from the NIST Mobile Threat Catalogue that could have 572 
less impact to Orvilia were not prioritized as high and did not become part of the following 12 threat 573 
events that Orvilia prioritized for inclusion in its mobile device security architecture. 574 

Table 3-1 Threat Event Mapping to the Mobile Threat Catalogue 575 

Threat Event NIST Mobile Threat Catalogue Threat ID 

TE-1 APP-2, APP-12 

TE-2 AUT-9 

TE-3 APP-5, AUT-10, APP-31, APP-40, APP-32, APP-2 

TE-4 STA-9, APP-4, STA-16, STA-0, APP-26 

TE-5 APP-32, APP-36 

TE-6 STA-7, EMM-3 

TE-7 CEL-18, APP-0, LPN-2 

TE-8 AUT-2, AUT-4 

TE-9 APP-9, AUT-0 

TE-10 EMM-5 

TE-11 PHY-0 

TE-12 EMM-9 
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3.4.2.1 Threat Event 1—Unauthorized Access to Sensitive Information via a Malicious or 576 
Privacy-Intrusive Application 577 

Summary: A mobile application can attempt to collect and exfiltrate any information to which it has 578 
been granted access. This includes any information generated during use of the application (e.g., user 579 
input), user-granted permissions (e.g., contacts, calendar, call logs, camera roll), and general device data 580 
available to any application (e.g., International Mobile Equipment Identity, device make and model, 581 
serial number). Further, if a malicious application exploits a vulnerability in other applications, the OS, or 582 
device firmware to achieve privilege escalation, it may gain unauthorized access to any data stored on or 583 
otherwise accessible through the device. 584 

Risk Assessment Analysis: 585 

Overall Likelihood: Very High 586 

Justification: Employees have easy access to download any applications at any time. If an employee 587 
requires an application that provides a desired function, the employee can download that application 588 
from any available source (trusted or untrusted). If an application performs an employee’s desired 589 
function, they may download an application from an untrusted source and have no regard for granted 590 
privacy intrusive permissions. 591 

Level of Impact: High 592 

Justification: Employees may download an application from an untrusted source and have no regard for 593 
granted privacy intrusive permissions. This poses a threat for sensitive corporate data, as some 594 
applications may include features that access corporate data, unbeknownst to the user. 595 

3.4.2.2 Threat Event 2—Theft of Credentials Through a Short Message Service (SMS) or 596 
Email Phishing Campaign 597 

Summary: Malicious actors may create fraudulent websites that mimic the appearance and behavior of 598 
legitimate ones and entice users to authenticate to them by distributing phishing messages over SMS or 599 
email. Effective use of social engineering techniques such as impersonating an authority figure or 600 
creating a sense of urgency may compel users to forgo scrutiny of the message and proceed to 601 
authenticate to the fraudulent website; it then captures and stores the userʼs credentials before 602 
(usually) forwarding them to the legitimate website to allay suspicion.  603 

Risk Assessment Analysis: 604 

Overall Likelihood: Very High 605 

Justification: Phishing campaigns are a common threat that occurs almost daily. 606 

Level of Impact: High 607 
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Justification: A successful phishing campaign could provide the malicious actor with corporate 608 
credentials, allowing access to sensitive corporate data, or personal credentials that could lead to 609 
compromise of corporate data or infrastructure via other means. 610 

3.4.2.3 Threat Event 3—Malicious Applications Installed via Uniform Resource Locators 611 
(URLs) in SMS or Email Messages 612 

Summary: Malicious actors may send users SMS or email messages that contain a URL where a 613 
malicious application is hosted. Generally, such messages are crafted using social engineering 614 
techniques designed to dissuade recipients from scrutinizing the nature of the message, thereby 615 
increasing the likelihood they access the URL using their mobile device. If they do, it will attempt to 616 
download and install the application. Effective use of social engineering by the attacker will further 617 
compel an otherwise suspicious user to grant any trust required by the developer and all permissions 618 
requested by the application. Granting the former facilitates the installation of other malicious 619 
applications by the same developer, and granting the latter increases the potential for the application to 620 
do direct harm. 621 

Risk Assessment Analysis: 622 

Overall Likelihood: High 623 

Justification: Installation of malicious applications via URLs is less common than traditional phishing 624 
attempts. The process for sideloading applications requires much more user input and consideration 625 
(e.g., trusting the developer certificate) than standard phishing, which solely requests a username and 626 
password. A user may proceed through the process of sideloading an application to acquire a desired 627 
capability from an application. 628 

Level of Impact: High 629 

Justification: Once a user installs a malicious sideloaded application, this could provide a malicious actor 630 
with full access to a mobile device, and therefore access to corporate data and credentials, without the 631 
user’s knowledge. 632 

3.4.2.4 Threat Event 4—Confidentiality and Integrity Loss due to Exploitation of Known 633 
Vulnerability in the OS or Firmware 634 

Summary: When malware successfully exploits a code execution vulnerability in the mobile OS or device 635 
drivers, the delivered code generally executes with elevated privileges and then issues commands in the 636 
context of the root user or the OS kernel. These commands may be enough for some to accomplish their 637 
goal, but advanced malicious actors will usually attempt to install additional malicious tools and to 638 
establish a persistent presence. If successful, the malicious actor will be able to launch further attacks 639 
against the user, the device, or any other systems the device connects to. As a result, any data stored 640 
on, generated by, or accessible to the device at that time−or in the future−may be compromised. 641 
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Risk Assessment Analysis: 642 

Overall Likelihood: High 643 

Justification: Many public vulnerabilities specific to mobile devices have been seen over the years, such 644 
as Stagefright. Users jailbreak iOS devices and root Android devices to download third-party applications 645 
and apply unique settings/configurations that the device would not typically be able to apply/access. 646 

Level of Impact: High 647 

Justification: Exploiting a vulnerability allows circumventing traditional security controls and modifying 648 
protected device data that should not be modified. Jailbroken and rooted devices exploit kernel 649 
vulnerabilities and allow third-party applications/services root access that can also be used to bypass 650 
security controls built-in or applied to a mobile device. 651 

3.4.2.5 Threat Event 5—Violation of Privacy via Misuse of Device Sensors 652 

Summary: Malicious actors with access (authorized or unauthorized) to device sensors (microphone, 653 
camera, gyroscope, Global Positioning System [GPS] receiver, and radios) can use them to conduct 654 
surveillance. It may be directed at the user, as when tracking the device location, or it may be applied 655 
more generally, as when recording any nearby sounds. Captured sensor data may be immediately useful 656 
to a malicious actor, such as a recording of an executive meeting. Alternatively, the data may be 657 
analyzed in isolation or in combination with other data to yield sensitive information. For example, 658 
audio recordings of on-device or proximate activity can be used to probabilistically determine user 659 
inputs to touchscreens and keyboards−essentially turning the device into a remote keylogger. 660 

Risk Assessment Analysis: 661 

Overall Likelihood: Very High 662 

Justification: This has been seen on public application stores in the past, with simple applications 663 
allegedly being data collection applications for nation-states [42]. As mentioned in Threat Event 1, 664 
unbeknownst to the user, a downloaded application may be granted privacy intrusive permissions that 665 
allow access to device sensors.  666 

Level of Impact: High 667 

Justification: When the sensors are being misused, the user is typically not alerted. This allows collection 668 
of sensitive enterprise data, such as location, without knowledge of the user. 669 
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3.4.2.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network 670 
Communications via Installation of Malicious EMM/MDM, Network, VPN Profiles, 671 
or Certificates 672 

Summary: Malicious actors who successfully install an EMM/MDM, network, or VPN profile or 673 
certificate onto a device will gain a measure of additional control over the device or its communications. 674 
Presence of an EMM/MDM profile will allow an attacker to misuse existing OS application programming 675 
interfaces (APIs) to send the device a wide variety of commands. This may allow a malicious actor to 676 
obtain device information; install or restrict applications; or remotely locate, lock, or wipe the device. 677 
Malicious network profiles may allow a malicious actor to automatically compel the device to connect to 678 
access points under their control to achieve a man-in-the-middle attack on all outbound connections. 679 
Alternatively, VPN profiles assist in the undetected exfiltration of sensitive data by encrypting it, thus 680 
hiding it from network scanning tools. Additionally, malicious certificates may allow the malicious actor 681 
to compel the device to automatically trust connections to malicious web servers, wireless access 682 
points, or installation of applications under the attacker’s control. 683 

Risk Assessment Analysis: 684 

Overall Likelihood: Moderate 685 

Justification: Unlike installation of an application, installation of EMM/MDM, network, VPN profiles, and 686 
certificates requires additional effort and understanding from the user to properly implement. 687 

Level of Impact: Very High 688 

Justification: If a malicious actor were able to install malicious configuration profiles or certificates, they 689 
would be able to perform actions such as decrypt network traffic and possibly even control the device. 690 

3.4.2.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via Eavesdropping 691 
on Unencrypted Device Communications 692 

Summary: Malicious actors can readily eavesdrop on communication over unencrypted, wireless 693 
networks such as public Wi-Fi access points, which are commonly provided by coffee shops and hotels. 694 
While a device is connected to such a network, a malicious actor would gain unauthorized access to any 695 
data sent or received by the device for any session not already protected by encryption at either the 696 
transport or application layers. Even if the transmitted data were encrypted, an attacker would be privy 697 
to the domains, internet protocol (IP) addresses, and services (as indicated by port numbers) to which 698 
the device connects; such information could be used in future watering hole attacks or man-in-the-699 
middle attacks against the device user.  700 

Additionally, visibility into network layer traffic enables a malicious actor to conduct side-channel 701 
attacks against its encrypted messages, which can still result in a loss of confidentiality. Further, 702 
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eavesdropping on unencrypted messages during a handshake to establish an encrypted session with 703 
another host or endpoint may facilitate attacks that ultimately compromise security of the session. 704 

Risk Assessment Analysis: 705 

Overall Likelihood: High 706 

Justification: Users require network access to retrieve email and access cloud services and other 707 
necessary data on the internet. Users can connect to readily available free internet access in public 708 
venues such as coffee shops, hotels, and airports. 709 

Level of Impact: High 710 

Justification: Users may connect to unencrypted wireless networks, and many applications do not 711 
properly encrypt network communications. Improper use of encryption, or lack thereof, allows a 712 
malicious actor to eavesdrop on network traffic. 713 

3.4.2.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or Brute-714 
Forced Device Unlock Code 715 

Summary: A malicious actor may be able to obtain a user’s device unlock code by direct observation, 716 
side-channel attacks, or brute-force attacks. Both the first and second can be attempted with at least 717 
proximity to the device; only the third technique requires physical access. However, side-channel attacks 718 
that infer the unlock code by detecting taps and swipes to the screen can be attempted by applications 719 
with access to any peripherals that detect sound or motion (microphone, gyroscope, or accelerometer). 720 
Once the device unlock code has been obtained, a malicious actor with physical access to the device will 721 
gain immediate access to any data or functionality not already protected by additional access control 722 
mechanisms. Additionally, if the user employs the device unlock code as a credential to any other 723 
systems, the attacker may further gain unauthorized access to those systems. 724 

Risk Assessment Analysis: 725 

Overall Likelihood: High 726 

Justification: Unlike shoulder-surfing to observe a user’s passcode, brute-force attacks are not as 727 
common or successful due to the built-in deterrent mechanisms. These mechanisms include exponential 728 
back-off/lockout period and device wipes after a certain number of failed unlock attempts. 729 

Level of Impact: High 730 

Justification: If a malicious actor can successfully unlock a device without the user’s permission, they 731 
could have full control over the user’s corporate account and thus gain unauthorized access to corporate 732 
data. 733 
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3.4.2.9 Threat Event 9—Unauthorized Access to Backend Services via Authentication or 734 
Credential Storage Vulnerabilities in Internally Developed Applications 735 

Summary: If a malicious actor gains unauthorized access to a mobile device, the attacker also has access 736 
to the data and applications on that mobile device. The mobile device may contain an organization’s in-737 
house applications and can subsequently gain access to sensitive data or backend services. This could 738 
result from weaknesses or vulnerabilities present in the authentication or credential storage 739 
mechanisms implemented within an in-house application. 740 

Risk Assessment Analysis: 741 

Overall Likelihood: Very High 742 

Justification: Often applications include hard-coded credentials for the default password of the 743 
administrator account. Default passwords are readily available online. These passwords may not be 744 
changed to allow for ease of access and to eliminate the pressure of remembering a password. 745 

Level of Impact: High 746 

Justification: Successful extraction of the credentials allows an attacker to gain unauthorized access to 747 
enterprise data. 748 

3.4.2.10  Threat Event 10—Unauthorized Access of Enterprise Resources from an 749 
Unmanaged and Potentially Compromised Device 750 

Summary: An employee who accesses enterprise resources from an unmanaged mobile device may 751 
expose the enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do 752 
not benefit from security mechanisms deployed by the organization such as mobile threat defense, 753 
mobile threat intelligence, application vetting services, and mobile security policies. These unmanaged 754 
devices limit an organization’s visibility into the state of a mobile device, including if the device is 755 
compromised by a malicious actor. Therefore, users who violate security policies to gain unauthorized 756 
access to enterprise resources from such devices risk providing attackers with access to sensitive 757 
organizational data, services, and systems. 758 

Risk Assessment Analysis: 759 

Overall Likelihood: Very High 760 

Justification: This may occur accidentally when an employee attempts to access their email.  761 

Level of Impact: High 762 

Justification: Unmanaged devices pose a sizable security risk because the enterprise has no visibility into 763 
their security or risk posture. Due to this lack of visibility, a compromised device may allow an attacker 764 
to attempt to exfiltrate sensitive enterprise data. 765 
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3.4.2.11  Threat Event 11—Loss of Organizational Data Due to a Lost or Stolen Device 766 

Summary: Due to the nature of the small form factor of mobile devices, they are easy to misplace or be 767 
stolen. A malicious actor who gains physical custody of a device with inadequate security controls may 768 
be able to gain unauthorized access to sensitive data or resources accessible to the device. 769 

Risk Assessment Analysis: 770 

Overall Likelihood: Very High 771 

Justification: Mobile devices are small and very easy to misplace. Enterprise devices may be lost or 772 
stolen at the same frequency as personally owned devices. 773 

Level of Impact: High 774 

Justification: Similar to Threat Event 9, if a malicious actor can gain access to the device, they could 775 
potentially have access to sensitive corporate data. 776 

3.4.2.12  Threat Event 12—Loss of Confidentiality of Organizational Data Due to Its 777 
Unauthorized Storage in Non-Organizationally Managed Services 778 

Summary: If employees violate data management policies by using unmanaged services to store 779 
sensitive organizational data, this data will be placed outside organizational control, where the 780 
organization can no longer protect its confidentiality, integrity, or availability. Malicious actors who 781 
compromise the unauthorized service account or any system hosting that account may gain 782 
unauthorized access to the data. 783 

Further, storage of sensitive data in an unmanaged service may subject the user or the organization to 784 
prosecution for violation of any applicable laws (e.g., exportation of encryption) and may complicate 785 
efforts by the organization to achieve remediation or recovery from any future losses, such as those 786 
resulting from the public disclosure of trade secrets. 787 

Risk Assessment Analysis: 788 

Overall Likelihood: High 789 

Justification: This could occur either intentionally or accidentally (e.g., taking a screenshot and backup 790 
up pictures to an unmanaged cloud service). 791 

Level of Impact: High 792 

Justification: Storage in unmanaged services presents a risk to the confidentiality and availability of 793 
corporate data because the corporation would no longer control it. 794 
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3.4.3 Identification of Vulnerabilities and Predisposing Conditions 795 

In Section 3.2.1, we identified vulnerabilities and predisposing conditions that increase the likelihood 796 
that identified threat events will result in adverse impacts for Orvilia Development. Each vulnerability or 797 
predisposing condition is listed in Table 3-2 along with the corresponding threat events and ratings of 798 
threat pervasiveness. More details on the use of threat event ratings can be found in the Risk 799 
Assessment Appendix. 800 

Table 3-2 Identify Vulnerabilities and Predisposing Conditions 801 

Vulnerability 
ID 

Vulnerability or Predisposing Condition Resulting 
Threat Events 

Pervasiveness 

VULN-1 Email and other enterprise resources can be 
accessed from anywhere, and only 
username/password authentication is 
required. 

TE-2, TE-10, TE-
11 

Very High 

VULN-2 Public Wi-Fi networks are regularly used by 
employees for remote connectivity from 
their corporate mobile devices. 

TE-7 Very High 

VULN-3 No EMM/MDM deployment exists to enforce 
and monitor compliance with security-
relevant policies on corporate mobile 
devices. 

TE-1, TE-3, TE-4, 
TE-5, TE-6, TE-7, 
TE-8, TE-9, TE-
11, TE-12  

Very High 

3.4.4 Summary of Risk Assessment Findings 802 

Table 3-3 summarizes the risk assessment findings. More detail about the methodology used to rate 803 
overall likelihood, level of impact, and risk can be found in the Risk Assessment Appendix. 804 

Table 3-3 Summary of Risk Assessment Findings 805 

Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall 
Likelihood 

Level of 
Impact 

Risk 

TE-1: Unauthorized access to sensitive 
information via a malicious or privacy-
intrusive application 

VULN-3 Very High High High 
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Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall 
Likelihood 

Level of 
Impact 

Risk 

TE-2: Theft of credentials through an 
SMS or email phishing campaign 

VULN-1 Very High High High 

TE-3: Malicious applications installed 
via URLs in SMS or email messages 

VULN-3 High High High 

TE-4: Confidentiality and integrity loss 
due to exploitation of known 
vulnerability in the OS or firmware 

VULN-3 High High High 

TE-5: Violation of privacy via misuse of 
device sensors 

VULN-3 Very High High High 

TE-6: Compromise of the integrity of 
the device or its network 
communications via installation of 
malicious EMM/MDM, network, VPN 
profiles, or certificates 

VULN-3 Moderate Very High High 

TE-7: Loss of confidentiality of sensitive 
information via eavesdropping on 
unencrypted device communications 

VULN-2, VULN-3 High High High 

TE-8: Compromise of device integrity 
via observed, inferred, or brute-forced 
device unlock code 

VULN-3 High High High 

TE-9: Unauthorized access to backend 
services via authentication or 
credential storage vulnerabilities in 
internally developed applications 

VULN-3 Very High High High 

TE-10: Unauthorized access of 
enterprise resources from an 
unmanaged and potentially 
compromised device 

VULN-1 Very High High High 
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Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall 
Likelihood 

Level of 
Impact 

Risk 

TE-11: Loss of organizational data due 
to a lost or stolen device 

VULN-1, VULN-3 Very High High High 

TE-12: Loss of confidentiality of 
organizational data due to its 
unauthorized storage in non-
organizationally managed services 

VULN-3 High High High 

Note 1: Risk is stated in qualitative terms based on the scale in Table I-2 of Appendix I in NIST Special 806 
Publication 800-30 Revision 1 [9]. 807 

Note 2: The risk rating itself is derived from both the overall likelihood and level of impact using Table I-808 
2 of Appendix I in NIST Special Publication 800-30 Revision 1 [9]. Because these scales are not true 809 
interval scales, the combined overall risk ratings from Table I-2 do not always reflect a strict 810 
mathematical average of these two variables. This is demonstrated in the table above where levels of 811 
moderate weigh more heavily than other ratings. 812 

Note 3: Ratings of risk relate to the probability and level of adverse effect on organizational operations, 813 
organizational assets, individuals, other organizations, or the nation. Per NIST SP 800-30 Revision 1, 814 
adverse effects (and the associated risks) range from negligible (i.e., very low risk), limited (i.e., low), 815 
serious (i.e., moderate), severe or catastrophic (i.e., high), to multiple severe or catastrophic effects (i.e., 816 
very high). 817 

3.4.5 Privacy Risk Assessment 818 

This section describes the privacy risk assessment conducted on Orvilia’s enterprise security 819 
architecture. To perform the privacy risk assessment, the NIST Privacy Risk Assessment Methodology 820 
(PRAM) was used. The PRAM is a tool for analyzing, assessing, and prioritizing privacy risks to help 821 
organizations determine how to respond and select appropriate solutions. The PRAM can also serve as a 822 
useful communication tool to convey privacy risks within an organization. A blank version of the PRAM is 823 
available for download on NIST’s website [43]. 824 

The PRAM uses the privacy risk model and privacy engineering objectives described in NIST Internal 825 
Report (NISTIR) 8062, An Introduction to Privacy Engineering and Risk Management in Federal Systems 826 
[44], to analyze for problematic data actions. Data actions are any system operations that process PII. 827 
Processing can include collection, retention, logging, analysis, generation, transformation or merging, 828 
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disclosure, transfer, and disposal of PII. A problematic data action is one that could cause an adverse 829 
effect for individuals. The PRAM activities identified the following potential problems for indivduals. 830 

3.4.5.1 Potential Problems for Individuals 831 

Three data actions were identified in the PRAM that have the potential to create problems for 832 
individuals. Those three data actions, along with their risk assessment analysis, follow: 833 

 blocking access and wiping devices 834 

 employee monitoring 835 

 data sharing across parties 836 

3.4.5.1.1 Data Action 1: Blocking Access and Wiping Devices 837 
Employees are likely to use their devices for both personal and work-related purposes. Therefore, in a 838 
system that features the capability to wipe a device entirely, there could be an issue of employees losing 839 
personal data. This is a potential problem for individuals because employee use of work devices for both 840 
personal and work-related purposes is common. 841 

Devices that might pose a risk to the organization’s security posture can be blocked from accessing 842 
enterprise resources or wiped and reset to factory setting defaults, which could result in loss of 843 
information contained on the device. Potential options for minimizing the impact to the employee 844 
include: 845 

 blocking the device’s access to enterprise resources until it is granted access permission again 846 

 selectively wiping elements of the device without removing all data on the device. Within the 847 
example solution, this option is available for iOS devices. 848 

 advising employees to back up the personal data maintained on devices 849 

 limiting staff with the ability to perform wipes or block access 850 

3.4.5.1.2 Data Action 2: Employee Monitoring 851 
Employees may not be aware of the monitoring of their interactions with the system and may not want 852 
this monitoring to occur. Employer-owned or -controlled networks like Orvilia’s often can monitor 853 
activities, and many do on a regular basis. 854 

The assessed infrastructure offers Orvilia a number of security capabilities, including reliance on 855 
comprehensive monitoring capabilities. A significant amount of data relating to employees, their 856 
devices, and their activities is collected and analyzed by multiple parties. Potential options for 857 
minimizing the impact to the employee include: 858 

 limit staff with ability to review data about employees and their devices 859 

 develop organization policies and techniques to limit collection of specific data elements 860 
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 develop organization policies and techniques regarding disposal of PII 861 

3.4.5.1.3 Data Action 3: Data Sharing Across Parties 862 
Data transmission about individuals and their devices among a variety of different parties could be 863 
confusing for employees who might not know who has access to different information about them.  864 

The infrastructure involves several parties that serve different purposes supporting Orvilia’s security 865 
objectives. As a result, a significant flow of data about individuals and their devices occurs across various 866 
parties. 867 

If a wide audience of administrators and co-workers know which of their colleagues are conducting 868 
activity on their devices that triggers security alerts, it could lead to undesired outcomes such as 869 
employee embarrassment. Potential options for minimizing the impact to the employee include: 870 

 developing organization policies and techniques for the de-identification of data 871 

 using encryption 872 

 limiting or disabling access to data 873 

 developing organization policies and techniques to limit the collection of specific data elements 874 

 using contracts to limit third-party data processing 875 

Additional information regarding these potential problems for individuals and potential options for 876 
minimizing the impact to the employees is provided in the Privacy Risk Assessment Appendix. 877 

3.5 Preliminary Solution Goals 878 

This section describes the preliminary solution goals for revising Orvilia’s mobile security architecture. 879 
Here is an overview of the security issues identified within Orvilia’s original (also known as current) 880 
mobile device infrastructure architecture. To address these issues, a list of security goals was developed 881 
to provide a high-level overview of factors that could be applied to improve the security of Orvilia’s 882 
mobile architecture. 883 

3.5.1 Current Architecture 884 

Prior to investing in security improvements to their mobile infrastructure—as identified based on the 885 
aforementioned risk assessment—Orvilia Development had not implemented a mobile security strategy. 886 
Several weaknesses were identified based on their use of mobile devices. A subset of these weaknesses 887 
is presented in Figure 3-4. 888 
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Figure 3-4 Orvilia’s Mobile Deployment Before Security Enhancements 889 

 890 

The following issues are highlighted in Figure 3-4 with a red exclamation mark: 891 

1. Organizational and personal data can become commingled if either the same application 892 
is used in both contexts or if multiple applications access shared device resources (e.g., 893 
contacts or calendar). 894 

2. Mobile devices are connecting to Orvilia from unencrypted public Wi-Fi hot spots; data 895 
transmitted prior to a secure connection is subject to eavesdropping, including 896 
passwords. 897 

3. Applications for work or personal use may contain unidentified vulnerabilities or 898 
weaknesses that increase the risk of device compromise. 899 

4. Applications may be obtained outside official application stores, increasing the risk that 900 
they are malware in disguise. 901 

5. Because mobile devices can connect from unknown locations, firewall rules must allow 902 
inbound connections from unrecognized, potentially malicious IP addresses. 903 
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3.5.2 Preliminary Security Goals 904 

In considering improvement to the security of their current deployment, Orvilia was able to identify 905 
high-level preliminary security goals to correct these shortcomings, as illustrated in Figure 3-5. 906 

Figure 3-5 Orvilia’s Preliminary Security Goals 907 

 
The following strategies are highlighted in Figure 3-5 with a green exclamation mark: 908 

1. Organizational and personal information can be separated by restricting data flow 909 
between organizationally managed and unmanaged applications. Sensitive data is 910 
protected from crossing between work and personal contexts. 911 

2. Mobile devices can connect to Orvilia over a VPN or similar solution to encrypt all data 912 
before it is transmitted from the device, protecting otherwise unencrypted data from 913 
interception. 914 

3. Identifying applications with significant vulnerabilities or weaknesses facilitates blocking 915 
or uninstalling those applications from managed devices, reducing their risk to the 916 
organization. 917 

4. Malware detection could be deployed to devices to identify malicious applications and 918 
facilitate remediation. 919 
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5. Mobile devices can be provisioned with a security certificate that allows them to be 920 
identified and authenticated at the connection point, which combines with user 921 
credentials to create two-factor authentication from mobile devices. 922 

These high-level goals, obtained from a review of their current mobile security posture, provide 923 
examples of why a thorough risk assessment process is beneficial to organizations implementing mobile 924 
device security capabilities. 925 

3.6 Technologies 926 

This section describes the mobile-specific technology components used within this example solution. 927 
These technologies were selected to address the preliminary security goals and threat events identified 928 
in the risk assessment. This section provides a brief description of each technology and discusses the 929 
security capabilities that each component provides to address Orvilia’s security issues. For additional 930 
information, Appendix H provides the technologies used in this project and provides a mapping between 931 
the specific product used and the cybersecurity standards and best practices that the product provides 932 
in the example solution discussed in this guide. 933 

3.6.1 Architecture Components 934 

The security components in this section are combined into a cohesive enterprise security architecture to 935 
enable enterprises to address mobile security threats and provide secure access to enterprise resources 936 
from mobile devices. The security components described in this section provide protection for the 937 
following enterprise architecture components that are accessed by Orvilia’s users with their mobile 938 
devices. 939 

 email/Outlook Web Access–contacts940 

 private chat server941 

 travel support942 

 organization intranet (e.g., internal announcements, organizational charts, policies)943 

 time reporting944 

3.6.1.1 Trusted Execution Environment 945 

A trusted execution environment (TEE) is “a tamper-resistant processing environment that runs on a 946 
separation kernel. It guarantees the authenticity of the executed code, the integrity of the runtime 947 
states (e.g., central processing unit registers, memory and sensitive I/O), and the confidentiality of its 948 
code, data and runtime states stored on a persistent memory. In addition, it shall be able to provide 949 
remote attestation that proves its trustworthiness for third-parties [45].” 950 
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3.6.1.2 Enterprise Mobility Management 951 

Organizations use Enterprise Mobility Management solutions to secure the mobile devices of users who 952 
are authorized to access organizational resources. Such solutions generally have two main components. 953 
The first is a backend service that mobile administrators use to manage the policies, configurations, and 954 
security actions applied to registered mobile devices. The second is an on-device agent, usually in the 955 
form of a mobile application, that integrates between the mobile OS and solution’s backend service. 956 
Alternatively, iOS supports a web-based EMM enrollment use case. 957 

At a minimum, an EMM solution can perform MDM functions, which include the ability to provision 958 
configuration profiles to devices, enforce security policies on devices, and monitor compliance with 959 
those policies by devices. The on-device MDM agent can typically notify the device user of any 960 
noncompliant settings and may be able to remediate some noncompliant settings automatically. The 961 
organization can use policy compliance data to inform its access control decisions so that it grants access 962 
only to a device that demonstrates the mandated level of compliance with the security policy that 963 
applies to it. 964 

EMM solutions commonly include any of the following: mobile application management, mobile content 965 
management, and implementations of or integrations with device- or mobile OS-specific 966 
containerization solutions, such as Samsung Knox. These capabilities can be used to manage installation 967 
and usage of applications based on the applications’ trustworthiness and work relevance. Additionally, 968 
they can control how managed applications access and use organizational data and possibly strengthen 969 
the separation between a user’s personal and professional usage of the device. 970 

Further, EMM solutions often have integrations with a diverse set of additional tools and security 971 
technologies that enhance their capabilities. An example is an EMM embedded with a mobile threat 972 
defense tool that serves to perform on-device behavioral-based threat-detection and to trigger policy 973 
remediation without the need to communicate to any server or service outside the device. This type of 974 
integration allows one application, the EMM agent, to manage, detect, and remediate device, network, 975 
application, malware, and spear phishing attacks. Additionally, because the remediation is autonomous 976 
at the device (does not require reaching a policy server), it has the advantage in addressing network-977 
based threat vectors such as Pineapple or Stingray impersonation of valid Wi-Fi or cellular networks 978 
[46]. 979 

For further reading, NIST SP 800-124 Revision 1, Guidelines for Managing the Security of Mobile Devices 980 
in the Enterprise [17], provides additional information on mobile device management with EMM 981 
solutions. Further, NIAP’s Protection Profile for Mobile Device Management Version 4.0 [47] describe 982 
important capabilities and security requirements to look for in EMM systems. 983 
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3.6.1.3 Virtual Private Network 984 

A VPN gateway increases the security of remote connections from authorized mobile devices to an 985 
organization’s internal network. A VPN is a virtual network, built on top of existing physical networks, 986 
which can provide a secure communications mechanism for data and control information transmitted 987 
between networks. VPNs are used most often to protect communications carried over public networks 988 
such as the internet. A VPN can provide several types of data protection, including confidentiality, 989 
integrity, data origin authentication, replay protection, and access control that help reduce the risks of 990 
transmitting data between network components. 991 

VPN connections apply an additional layer of encryption to the communication between remote devices 992 
and the internal network, and VPN gateways can enforce access control decisions by limiting which 993 
devices or applications can connect to it. Integration with other security mechanisms allows a VPN 994 
gateway to base access control decisions on more risk factors than it may be able to collect on its own; 995 
examples include a device’s level of compliance with mobile security policies or the list of installed 996 
applications (blacklisted applications) as reported by an integrated EMM. 997 

NIAP’s Extended Package for VPN Gateways [48], in combination with the internationally and 998 
collaboratively developed Protection Profile for Network Devices [49], describes important capabilities 999 
and security requirements to expect from VPN gateways. 1000 

3.6.1.4 Mobile Application Vetting Service 1001 

Mobile application vetting services use a variety of static, dynamic, and behavioral techniques to 1002 
determine if an application demonstrates any behaviors that pose a security or privacy risk. The risk may 1003 
be to a device owner or user, to parties that own data on the device, or to external systems to which the 1004 
application connects. The set of detected behaviors is often aggregated to generate a singular score that 1005 
estimates the level of risk (or conversely, trustworthiness) attributed to an application. Clients can often 1006 
adjust the values associated with given behaviors (e.g., hard-coded cryptographic keys) to tailor the 1007 
score for their unique risk posture. Those scores may be further aggregated to present a score that 1008 
represents the overall risk or trustworthiness posed by the set of applications currently installed on a 1009 
given device. 1010 

Mobile applications, malicious or benign, have high potential to negatively impact both security and user 1011 
privacy. A malicious application can contain code intended to exploit vulnerabilities present in 1012 
potentially any targeted hardware, firmware, or software on the device. Alternatively, or in conjunction 1013 
with exploit code, a malicious application may misuse any device, personal, or behavioral data to which 1014 
it has been explicitly or implicitly granted access, such as contacts, clipboard data, or location services. 1015 
Benign applications may still present vulnerabilities or weaknesses that malicious applications can 1016 
exploit to gain unauthorized access to its data or functionality. Further, benign applications may place 1017 
user privacy at risk by collecting more information than is necessary for the application to deliver 1018 
functionality desired by the user. 1019 
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While not specific to applications, some services may include device-based risks (e.g., lack of disk 1020 
encryption or vulnerable OS version) in their analysis to provide a more comprehensive assessment of 1021 
the risk or trustworthiness presented by a device when running an application or service. 1022 

NIAP does not provide a Protection Profile for application vetting services themselves. However, NIAP’s 1023 
Protection Profile for Application Software [50] describes security requirements to be expected from 1024 
mobile applications. Many mobile application vetting vendors provide capabilities to automate 1025 
evaluation of applications against NIAP’s requirements. 1026 

3.6.1.5 Mobile Threat Defense 1027 

MTD generally takes the form of an application that is installed on the device, which provides the widest 1028 
and most timely access to information about what activity is taking place. Ideally, the MTD solution will 1029 
be able to detect unwanted activity and properly inform the user so they can act to prevent or limit the 1030 
harm an attacker could cause. Additionally, MTD solutions may integrate with EMM solutions to 1031 
leverage the EMM agent’s on-device capabilities, such as blocking a malicious application from being 1032 
launched until the user can remove it. 1033 

MTD products typically analyze device-based threats, application-based threats, and network-based 1034 
threats. Device-based threats include outdated operating system versions and insecure configuration 1035 
settings. Application-based threats include the issues discussed above regarding the mobile application 1036 
vetting service, though sometimes without the same breadth or depth found in services dedicated to 1037 
application vetting. Network-based threats include use of unencrypted or public Wi-Fi networks and 1038 
attacks such as active attempts to intercept and decrypt network traffic. 1039 

3.6.1.6 Mobile Threat Intelligence 1040 

In this guide, we describe mobile threat intelligence as actionable information that mobile 1041 
administrators can use to make changes to their security configuration to improve their posture relative 1042 
to recent discoveries. Intelligence data include malicious URLs, IP addresses, domain names, and 1043 
application names or package/bundle IDs, as well as malware signatures or vulnerabilities in 1044 
applications, mobile devices, device platform services, or mobile security products. This list is not all-1045 
encompassing, as any recent information that could inform rapid changes to enable an enterprise to 1046 
better secure a mobile deployment against novel or newly enhanced threats is equally applicable to the 1047 
term. This capability may be found in various other types of technology, such as MTD and other network 1048 
analysis tools. 1049 

3.6.1.7 Native Mobile OS Capabilities 1050 

Native mobile OS capabilities are available without the use of additional security features. They are 1051 
included as part of the mobile device’s core capabilities. The following mobile OS capabilities can be 1052 
found in mobile devices, particularly smartphones. 1053 
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3.6.1.7.1 Secure Boot 1054 
Secure boot is a general term that refers to a system architecture designed to prevent and detect any 1055 
unauthorized modification to the boot process. A system that successfully completes a secure boot has 1056 
loaded its start-up sequence information into a trusted operating system. A common mechanism is for 1057 
the first program executed (a boot loader) to be immutable (stored on read-only memory or 1058 
implemented strictly in hardware). Further, the integrity of mutable code is cryptographically verified 1059 
prior to execution by either immutable or verified code. This process establishes a chain of trust that can 1060 
be traced back to immutable, implicitly trustworthy code. Use of an integrated TEE as part of a secure 1061 
boot process is preferable to an implementation that uses software alone [51]. 1062 

3.6.1.7.2 Device Attestation 1063 
This is an extension of the secure boot process that involves the operating system (or more commonly, 1064 
an integrated TEE) providing cryptographically verifiable proof that it has a known and trusted identity 1065 
and is in a trustworthy state, which means all software running on the device is free from unauthorized 1066 
modification. 1067 

Device attestation requires cryptographic operations using an immutable private key that can be verified 1068 
by a trusted third party, which is typically the original equipment manufacturer of the TEE (e.g., 1069 
Qualcomm or Samsung) or device platform vendor (e.g., Google, Apple, or Microsoft). Proof of 1070 
possession of a valid key establishes the integrity of the first link in a chain of trust that preserves the 1071 
integrity of all other pieces of data used in the attestation. It will include unique device identifiers, 1072 
metadata, and the results of integrity checks on mutable software, and possibly metrics from the boot 1073 
or attestation process itself [51]. 1074 

3.6.1.7.3 Device Management and MDM API 1075 
Mobile operating systems and platform-integrated firmware (e.g., Samsung Knox) provide a number of 1076 
built-in security features that are generally active by default. Examples include disk and file-level 1077 
encryption, verification of digital signatures for installed software and updates, a device unlock code, 1078 
remote device lock, and automatic device wipe following a series of failed device unlock attempts. Some 1079 
of these features are directly configurable by the user via a built-in application or through a service 1080 
provided by the device platform vendor (e.g., Google, Apple, or Microsoft). 1081 

Additionally, mobile operating systems expose an API to MDM products that allow an organization that 1082 
manages a device to have greater control over these and many more settings that might not be directly 1083 
accessible to the device user. Management APIs allow enterprises using integrated EMM or MDM 1084 
products to manage devices more effectively and efficiently than they could by using the built-in 1085 
application alone. 1086 
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4 Architecture 1087 

This example solution consists of the six mobile security technologies described in Section 3.6: trusted 1088 
execution environment, enterprise mobility management, virtual private network, mobile application 1089 
vetting service, mobile threat defense, and mobile threat intelligence. Table 4-1, Commercially Available 1090 
Products Used, identifies the commercially available products used in this example solution and how 1091 
they aligned with the six mobile security technologies. 1092 

Table 4-1 Commercially Available Products Used 1093 

Commercially Available Product Mobile Security Technology 

Appthority Cloud Service Mobile threat intelligence 

Kryptowire Cloud Service Mobile application vetting service 

Lookout Cloud Service/Lookout 
Agent Version 5.10.0.142 (iOS), 
5.9.0.420 (Android) 

Mobile threat defense 

MobileIron Core Version 9.7.0.1 
MobileIron Agent Version 11.0.1A 
(iOS), 10.2.1.1.3R (Android) 

Enterprise mobility management 

Palo Alto, PA-220 Version 8.1.1 Virtual private network 

Qualcomm, (version is mobile 
device dependent) 

Trusted execution environment 

These components are further integrated with broader on-premises security mechanisms and a VPN 1094 
gateway as shown in Figure 4-1. This integrated solution provides a broad range of capabilities to help 1095 
securely provision and manage devices, protect against and detect device compromise, and help provide 1096 
security-enhanced access to enterprise resources by only authorized mobile users and devices. 1097 

Organizations exploring the use of on-premises EMM technology should be aware they will be 1098 
responsible for installing and configuring the on-premises instances of the EMM technology. This will 1099 
include the software licenses that must be paid for directly by the organization for any underlying 1100 
platforms or components. Pre-built software images and containers may be available that can help ease 1101 
installation and configuration work. As a recommended best practice, if prebuilt containers and images 1102 
are used, it is recommended that they be checked for common software vulnerabilities. 1103 
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On-premises mobile device management solutions offer the benefit that enterprise data resides within 1104 
the organization. Allowed devices may still send and receive information from the mobile device 1105 
solution that they are authorized to obtain. Organizations that are interested can explore monitoring 1106 
data flows from the EMM to other devices. Additionally, on-premises mobile device management 1107 
solutions provide the organization with the capability to maintain physical security of the EMM. 1108 

Figure 4-1 Example Solution Architecture 1109 

4.1 Architecture Description 1110 

The NCCoE worked with industry subject matter experts to develop an open, standards-based, 1111 
commercially available architecture that addresses the risks identified during the risk assessment 1112 
process in Section 3.4. 1113 

Where possible, the architecture uses components that are present on NIAP’s Product Compliant List 1114 
[35], meaning the product has been successfully evaluated against a NIAP-approved Protection Profile 1115 
[50]. NIAP collaborates with a broad community, including industry, government, and international 1116 
partners, to publish technology-specific security requirements and tests in the form of Protection 1117 
Profiles. The requirements and tests in these Protection Profiles are intended to ensure that evaluated 1118 
products address identified security threats. 1119 
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The example solution architecture supports its desired security characteristics as a result of the 1120 
following integrations. 1121 

4.1.1 Enterprise Integration 1122 

This example solution extends central identity and access management to mobile devices via an 1123 
integration between both MobileIron Core and Palo Alto Networks GlobalProtect with Microsoft Active 1124 
Directory Domain Services (ADDS). The integrity of identification and authentication by mobile devices 1125 
to the enterprise is further enhanced by using device certificates issued by local Microsoft Active 1126 
Directory Certificate Services (ADCS). 1127 

By integrating with Active Directory (AD), MobileIron Core allows administrators to authorize select 1128 
groups of users to register a mobile device, limiting mobile access to only those users who require it. 1129 
Additionally, different security policies, device configurations, and authorized applications can be 1130 
deployed to different AD groups, allowing administrators to centrally manage distinct mobile use cases. 1131 
MobileIron Core queries AD using the lightweight directory access protocol. 1132 

Through its integration with ADCS, MobileIron Core automatically configures devices to obtain locally 1133 
managed device certificates by using the Simple Certificate Enrollment Protocol (SCEP). Our example 1134 
solution mitigates the potential of remote exploitation of SCEP by restricting certificate enrollment to 1135 
mobile devices that are connected to a dedicated enterprise-managed Wi-Fi network that allows devices 1136 
to access only MobileIron Core and the Network Device Enrollment Service server. Further, this example 1137 
solution uses a dynamic SCEP scheme, in which MobileIron Core supplies a registered mobile device 1138 
with a onetime password to include in its SCEP request, thus helping prevent unknown and untrusted 1139 
devices that gain unauthorized access to the dedicated Wi-Fi network from obtaining a trusted device 1140 
certificate. 1141 

The example solution’s chosen certificate enrollment configuration includes the mobile user’s User 1142 
Principal Name (UPN) in the device certificate’s Subject Alternative Name field, which the Palo Alto 1143 
Networks GlobalProtect VPN gateway uses to perform identity verification and enforce access control 1144 
for the unique combination of mobile user and device. 1145 

MobileIron Core-registered devices also utilize the device certificate indirectly to enhance the security of 1146 
remote connections to the enterprise in two ways. First, communication with MobileIron Core (which 1147 
must be accessible from the internet in the demilitarized zone) is secured using two-way Transport Layer 1148 
Security (TLS). This protects MobileIron Core from establishing secure connections with untrusted 1149 
mobile devices. Second, the device certificate is used in the GlobalProtect VPN configuration, which 1150 
restricts access to the VPN to only trusted devices. Further, GlobalProtect uses the device user’s UPN to 1151 
grant appropriate access to enterprise resources based on the device user’s UPN through its integration 1152 
with ADDS. 1153 
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As shown in Figure 4-2 [52], devices present the certificates to the VPN and EMM authentication 1154 
services after the certificate have been successfully issued. The GlobalProtect VPN authenticates the 1155 
device user by mapping the common name field in the client certificate to an account stored in the local 1156 
ADDS. On successful authentication, the GlobalProtect application prompts the user to authenticate 1157 
using a second factor–their Active Directory domain password. Once this is verified, GlobalProtect 1158 
establishes a tunnel with the gateway and is assigned an IP address from the IP pool in the gateway’s 1159 
tunnel configuration. 1160 

Figure 4-2 Example Solution Gateway Architecture 1161 

 

4.1.2 Mobile Component Integration 1162 

This section describes how the various mobile technology components integrate with one another. The 1163 
majority of these components integrate with the EMM, MobileIron. MobileIron supports the integration 1164 
of third-party cloud services through a defined API. MobileIron Core authenticates external systems by 1165 
using basic authentication, so TLS protects the confidentiality of API account credentials and 1166 
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MobileIron’s responses to clients’ RESTful calls. MobileIron API client accounts for Kryptowire, Lookout 1167 
Mobile Endpoint Security, and Appthority Mobile Threat Protection (MTP) are each assigned 1168 
administrative roles that grant the minimum set of permissions necessary to achieve integration [53], 1169 
[54]. 1170 

4.1.2.1 Appthority–MobileIron 1171 

The Appthority application reputation service provides an integration with MobileIron Core systems 1172 
through implementation of connector software provided by Appthority. The connector provides the 1173 
code that exercises the APIs provided by MobileIron Core and the Appthority cloud service. In this 1174 
integration, an API user was created within the MobileIron Core system and assigned specific roles 1175 
required for successful operation of the application vetting service. Automatic syncing between the 1176 
Appthority service and MobileIron Core system can occur on a configurable basis. Specifically, the 1177 
application and device inventory data are synced between the two systems. In this integration, syncing 1178 
occurs every hour, but this value should be adjusted to fit the needs of the organization. 1179 

In this example solution, the integration provides the primary security benefit of compliance 1180 
enforcement and remediation escalation. In the initial step of the process, the application inventory is 1181 
gathered from the MobileIron Core system, and each application is assigned a threat measurement 1182 
score. If an application is installed on a device that is not compliant with the configured policy, 1183 
Appthority MTP communicates with the MobileIron Core system to identify those devices, which 1184 
triggers MobileIron compliance enforcement actions. 1185 

4.1.2.2 Lookout–MobileIron 1186 

The Lookout mobile threat defense service provides integration with MobileIron Core systems through 1187 
implementation of connector software provided by Lookout. The connector provides the code that 1188 
exercises the APIs provided by MobileIron Core and the Lookout cloud service. This integration allows 1189 
Lookout to retrieve device details as well as application inventory information and to apply labels to 1190 
devices as necessary. 1191 

Following analysis, Lookout uses the API to apply specific labels to devices to categorize them based on 1192 
risk posture, which is calculated based on the severity of issues detected on the device. MobileIron can 1193 
then automatically respond to application of specific labels based on built-in compliance actions. This 1194 
allows administrators to configure exactly how MobileIron will respond to devices in the following 1195 
categories: 1196 

 Pending–Lookout not yet activated 1197 

 Secured–Lookout active 1198 

 Threats Present–Lookout has detected threats 1199 

 Deactivated–Lookout has been deactivated 1200 
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 Low Risk–devices with a low risk score in Lookout 1201 

 Moderate Risk–devices with a moderate risk score in Lookout 1202 

 High Risk–devices with a high-risk score in Lookout 1203 

4.1.2.3 Kryptowire–MobileIron 1204 

Kryptowire obtains device details, such as device platform, OS version, and the universally unique 1205 
identifiers assigned to each registered device by MobileIron Core to enable clear identification of a 1206 
particular device across systems. Kryptowire obtains the inventory of applications from all of the devices 1207 
enrolled in MobileIron. Kryptowire performs static, dynamic, and behavioral binary code analysis on 1208 
mobile applications against government (NIAP) and industry (The Open Web Application Security 1209 
Project, or OWASP) [55] standards. Kryptowire provides both a detailed security analysis, provides 1210 
pass/fail evidence down to the line of code, and provides a summary weighted risk score for each 1211 
application. Mobile application administrators can use these detailed reports to inform decisions on 1212 
which applications are trusted and compliant with enterprise security and privacy policies and which are 1213 
restricted for enterprise or personal use. 1214 

4.1.2.4 Palo Alto Networks–MobileIron 1215 

Palo Alto Networks’ GlobalProtect VPN is used to secure remote connections from mobile devices. 1216 
MobileIron Core offers specific configuration options for the GlobalProtect client available on Android 1217 
and iOS that facilitates secure deployment of VPN clients and enablement of VPN access using 1218 
certificate-based authentication to the GlobalProtect gateway. Details of the certificate enrollment 1219 
process are provided in Section 4.1.1. 1220 

The VPN architecture used in this example solution is composed of two components of the Palo Alto 1221 
Networks next-generation firewall–a GlobalProtect portal and a GlobalProtect gateway. The portal 1222 
provides the management functions for VPN infrastructure. Every endpoint that participates in the 1223 
GlobalProtect network receives configuration information from the portal, including information about 1224 
available gateways as well as any client certificates that may be required to connect to the GlobalProtect 1225 
gateway(s). The gateway provides security enforcement for traffic from GlobalProtect applications. It is 1226 
configured to provide access to specific enterprise resources only to mobile device users after a 1227 
successful authentication and authorization decision. 1228 

The VPN tunnel negotiation between the VPN endpoint/mobile device and the VPN gateway is 1229 
presented in Figure 4-3 [56]. It demonstrates a user logging into the system (1), the portal returning the 1230 
client configuration (2), the agent automatically connecting to the gateway and establishing a VPN 1231 
tunnel (3), and the gateway’s security policy enabling access to internal and external applications (4). 1232 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 40 

Figure 4-3 Example Solution VPN Architecture 1233 

 

For our example solution, we chose to enforce an always-on VPN configuration. This configuration 1234 
causes registered devices to establish a VPN connection to the GlobalProtect gateway whenever they 1235 
have network connectivity–this occurs over cellular or Wi-Fi and is persistent across device reboot. This 1236 
configuration affords devices with the greatest degree of protection, as additional Palo Alto Networks 1237 
services can be extended to GlobalProtect. This example solution uses URL filtering, which blocks mobile 1238 
devices from accessing blacklisted internet domains or any domain that Palo Alto Networks associates 1239 
with active exploits (e.g., phishing campaigns, watering hole attacks, botnet command and control). NIST 1240 
SP 800-46 Revision 2, Guide to Enterprise Telework, Remote Access, and BYOD Security [11], describes 1241 
the most common VPN options used for remote workers. 1242 

4.1.2.4.1 FIPS Compliance 1243 
Any sensitive information passing over the internet, wireless networks, and other untrusted networks 1244 
should have its confidentiality and integrity preserved through cryptography [11]. While federal 1245 
agencies are required to use cryptographic algorithms that are NIST-approved and contained in Federal 1246 
Information Processing Standards (FIPS)-validated modules, adoption of these standards is available to 1247 
private and commercial organizations [57]. This example solution uses these best practices to the extent 1248 
possible in the following ways: 1249 

 FIPS-CC mode in the GlobalProtect VPN appliance is enabled, which requires TLS 1.1 (or above) 1250 
and limits the public key use to FIPS-approved algorithms. This example solution’s 1251 
implementation uses the highest version of TLS available, with TLS 1.2 being the minimum 1252 
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acceptable version. A full list of security functions can be found on the Palo Alto Networks FIPS-1253 
CC Security Functions documentation site [58]. 1254 

 As described in Section 4.1.1, dynamic SCEP challenges are enabled.  1255 

To align our example solution with guidance in NIST SP 800-52 Revision 1. Guidelines for the Selection, 1256 
Configuration, and Use of Transport Layer Security (TLS) Implementations [12], this example solution 1257 
implements the following configuration: 1258 

 The GlobalProtect portal and gateway restrict the list of cipher suites available to the client 1259 
application by using a TLS service profile. The minimum version of TLS is set to 1.2 as 1260 
recommended by NIST SP 800-52. 1261 

 The GlobalProtect portal and gateway server certificates use 2048-bit RSA key modulus signed 1262 
with sha256WithRSAEncryption algorithm.  1263 

4.1.2.5 iOS and Android EMM Integration 1264 

iOS and Android-based devices both integrate directly with EMM solutions, providing enterprise-level 1265 
management of security controls based on policy. iOS devices are managed by configuration profiles. 1266 
Configuration profiles can force security policies such as VPN usage, enterprise Kerberos support, and 1267 
access to cloud services. iOS further incorporates a set of additional security controls in what is termed 1268 
supervised mode, which denotes a corporately owned device. Typically, organizations choose to use the 1269 
Device Enrollment Program [59] for large-scale deployments of iOS devices in supervised mode due to 1270 
the reduction of labor involved in manually configuring each device. However, due to the small number 1271 
of devices in our reference design, we have configured supervised mode using the Apple Configurator 2 1272 
tool [60]. A full description of iOS capabilities can be found in the iOS Security Guide [61].  1273 

Similarly, Android-based devices offer security controls that an EMM can leverage for enterprise 1274 
deployments. The Android Enterprise program by Google is available on devices with Android 5.0 1275 
(Lollipop) and higher. An EMM deploys a device policy controller [62] as part of its on-device agent that 1276 
controls local device policies and system applications on devices. Android Enterprise supports COPE and 1277 
BYOD deployment scenarios through work-managed [63] and work-profile [64] device solutions. In 1278 
work-managed mode, the device is corporately owned, and the entire device is managed by the 1279 
enterprise, whereas work profiles can be added to personally owned devices. A newer mode introduced 1280 
in Android 8.0 supports a combination of work-managed and work profiles on the same device [65]. In 1281 
this scenario, the device is corporately owned, in that device level controls such as device wipe and reset 1282 
to factory default settings are available. A work profile is also created to keep enterprise applications 1283 
and data separate from any personal data. This scenario allows for some flexibility of the device owner 1284 
to permit personal use of the device while retaining device controls and is the chosen deployment of 1285 
this reference implementation.1286 
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4.2 Enterprise Security Architecture Privacy Data Map 1287 

Orvilia performed a privacy analysis using both the information gathered in the initial PRAM effort and the identified mobile security 1288 
technologies included in the revised architecture. The output from the PRAM activities, including data flows between the components, along 1289 
with their on-premises or cloud-based location, resulted in the information contained in Figure 4-4. For additional information on the PRAM 1290 
activities, see the Privacy Risk Assessment Appendix. 1291 

Figure 4-4 NIST Privacy Risk Assessment Methodology Data Map for Orvilia’s Enterprise Security Architecture 1292 
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4.3 Security Control Map 1293 

Using the developed risk information as input, the security characteristics of the solution were 1294 
identified. A security control map was developed documenting the example solution’s capabilities with 1295 
applicable Subcategories from the NIST Cybersecurity Framework Version 1.1 [5]; NIST SP 800-53 1296 
Revision 4, Security and Privacy Controls for Federal Information Systems and Organizations [13]; 1297 
International Organization for Standardization (ISO), International Electrotechnical Commission (IEC) 1298 
27001:2013, Information technology–Security techniques–Information security management systems –1299 
Requirements [25]; the Center for Internet Security’s Control set [21] Version 6; and NIST SP 800-181, 1300 
National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce Framework [20]. 1301 

The security control map identifies the security characteristic standards mapping for the products as 1302 
they were used in the example solution. The products may be capable of additional capabilities not used 1303 
in this example solution. For that reason, it is recommended the mapping not be used as a reference for 1304 
all of the security capabilities these products may be able to address. The security control map can be 1305 
found in Table H-1. 1306 

5 Security Characteristic Analysis 1307 

The purpose of the security characteristic analysis is to understand the extent to which the project 1308 
meets its objective of demonstrating how to increase the security of mobile devices within an enterprise 1309 
by deploying EMM, MTD, MTI, application vetting, secure boot/image authentication, and VPN services. 1310 

5.1 Assumptions and Limitations 1311 

The security characteristic analysis has the following limitations: 1312 

 It is neither a comprehensive test of all security components nor a red-team exercise. 1313 

 It cannot identify all weaknesses. 1314 

 It does not include the lab infrastructure. It is assumed those systems are hardened. Testing 1315 
these devices would reveal only weaknesses in implementation that would not be relevant to 1316 
those adopting this reference architecture. 1317 

5.2 Build Testing 1318 

Functional testing was used to confirm the example solution’s capabilities. We use the test activities to 1319 
demonstrate Orvilia’s susceptibility to the threat before implementing the architecture detailed in this 1320 
practice guide. We use the test activities again after implementing the architecture to demonstrate that 1321 
the threats have been appropriately addressed. 1322 
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5.2.1 Threat Event 1 —Unauthorized Access to Sensitive Information via a Malicious 1323 
or Privacy-Intrusive Application 1324 

Summary: Unauthorized access to sensitive information via a malicious or privacy-intrusive application 1325 
is tested. We tested this threat by placing a mock sensitive enterprise contact list and calendar entries 1326 
on devices, then attempted to install and use applications on the Apple App Store and Google Play Store 1327 
[66] that access and back up those entries. Ideally, the enterprise’s security architecture would either 1328 
detect or prevent use of these applications, or it would block the applications from accessing enterprise-1329 
controlled contact list and calendar entries. 1330 

Test Activity: 1331 

Install an iOS or Android application that accesses the contact and calendar entries and backs them up 1332 
to a cloud service. We have no reason to believe these applications are malicious. However, the 1333 
behavior of accessing and backing up enterprise-controlled data (contacts and calendar entries) without 1334 
authorization presents an activity that should be mitigated by this example solution’s security 1335 
architecture. 1336 

Desired Outcome: The enterprise’s security architecture should identify the presence of the applications 1337 
and the fact that they access contact and calendar entries. The security architecture should block these 1338 
applications from installing, block them from running, or detect their presence and cause another 1339 
appropriate response to occur, such as blocking the mobile device from accessing enterprise resources 1340 
until the applications are removed. 1341 

Alternatively, built-in device mechanisms such as Apple’s managed applications functionality and 1342 
Google’s Android enterprise work profile functionality could be used to separate the contact and 1343 
calendar entries associated with enterprise email accounts, so they can be accessed only by enterprise 1344 
applications (applications authorized and managed by the EMM), not applications manually installed by 1345 
the user. The user should not have the ability to manually provision their enterprise email account. The 1346 
account should be able to be provisioned only by the EMM, enabling enterprise controls on the 1347 
enterprise contact list and calendar data. However, in this practice guide build, we chose to make the 1348 
devices fully managed, not divided into separate enterprise and personal areas. 1349 

Observed Outcome: Appthority identified the presence of applications that have access to sensitive 1350 
data and updated the device labels in MobileIron Core. 1351 

5.2.2 Threat Event 2 —Theft of Credentials Through an SMS or Email Phishing 1352 
Campaign 1353 

Summary: A fictitious phishing event was created where protection against theft of credentials through 1354 
an SMS or email phishing campaign was tested. 1355 

Test Activity: 1356 
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 Establish a web page with a form that impersonates an enterprise login prompt.  1357 

 Send the web page’s URL via SMS or email and attempt to collect and use enterprise login 1358 
credentials. 1359 

Desired Outcome: The enterprise’s security architecture should block the user from browsing to known 1360 
malicious websites. Additionally, the enterprise should use multifactor authentication or phishing-1361 
resistant authentication methods, such as those based on public key cryptography, so that either there 1362 
is no password for a malicious actor to capture, or capturing the password is insufficient to obtain access 1363 
to enterprise resources. 1364 

Observed Outcome: The example solution used Palo Alto Networks’ next-generation firewall. The 1365 
firewall includes PAN-DB, a URL filtering service that automatically blocks known malicious URLs. The 1366 
URL filtering database is updated regularly to help protect users from malicious URLs. The next-1367 
generation firewall blocked the attempt to visit the phishing site. However, if the malicious URL were 1368 
not present in PAN-DB, the user would be allowed to access the website. 1369 

5.2.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or Email 1370 
Messages 1371 

Summary: Unauthorized applications, not present on the official Apple App Store or Google Play Store, 1372 
are installed via URL links in SMS, email messages, or third-party websites. 1373 

Test Activity (Android): 1374 

 Send an email to the user containing a link (https://f-droid.org/Fdroid.apk) to the F-Droid APK 1375 
(Android Application Package) file with a message urging the user to click on the link to install 1376 
the application. 1377 

 On the device, if not already enabled, attempt to enable the Unknown Sources toggle setting in 1378 
the device security settings to allow installing applications from sources other than the Google 1379 
Play Store. 1380 

 On the device, read the received email, click on the link, and attempt to install the F-Droid 1381 
application. 1382 

 Observe whether the F-Droid application could be successfully installed. If so, observe whether 1383 
the enterprise detected and responded to installation of the unauthorized application. 1384 

Test Activity (iOS): 1385 

 Send an email to the user containing a link to an iOS application available for installation from 1386 
the iosninja.io website, along with a message urging the user to click on the link to install the 1387 
application.  1388 

 On the device, read the received email, click on the link, and attempt to install the application. 1389 

https://f-droid.org/Fdroid.apk
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 On the device, attempt to explicitly trust the developer’s signing certificate. Then attempt to run 1390 
the application. 1391 

 Observe whether the application could run. If so, observe whether the enterprise detected and 1392 
responded to installation of the unauthorized application. 1393 

Desired Outcome: The device does not allow the user to install the unauthorized application. If the 1394 
application is somehow installed, its presence should be detected, and an appropriate response should 1395 
occur, such as blocking the device from accessing enterprise resources until the application is removed. 1396 

Observed Outcome: On iOS devices, Lookout detected that an application had been sideloaded, and it 1397 
applied a label to the device. MobileIron then quarantined the device until the threat was resolved. 1398 

On iOS devices, MobileIron has a configuration option that prohibited the user from trusting the 1399 
developer certificate. 1400 

On Android devices, MobileIron has a configuration option that prohibited the user from enabling 1401 
Unknown Sources on the device. 1402 

5.2.4 Threat Event 4 —Confidentiality and Integrity Loss due to Exploitation of 1403 
Known Vulnerability in the OS or Firmware 1404 

Summary: When malware successfully exploits a code execution vulnerability in the mobile OS or device 1405 
drivers, the delivered code generally executes with elevated privileges and issues commands in the 1406 
context of the root user or the OS kernel. 1407 

Test Activity: Attempt to access enterprise resources from a mobile device with known vulnerabilities 1408 
(e.g., running an older, unpatched version of iOS or Android). 1409 

Desired Outcome: The enterprise’s security architecture should identify the presence of devices that are 1410 
running an outdated version of iOS or Android susceptible to known vulnerabilities. It should be 1411 
possible, when warranted by the risks, to block devices from accessing enterprise resources until system 1412 
updates are installed. 1413 

Observed Outcome: Lookout identified that devices were running outdated operating systems. This 1414 
information was communicated to MobileIron, which subsequently automatically quarantined the 1415 
devices until the operating system was updated. 1416 

5.2.5 Threat Event 5 —Violation of Privacy via Misuse of Device Sensors 1417 

Summary: There is collection of location, camera, or microphone data by an application that has no 1418 
need to access this data. 1419 
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Note: Not all applications that have access to location, camera, or microphone data are malicious. 1420 
However, when an application is found to be collecting this information, additional vetting or testing 1421 
may be required to determine the intent of its use and to then determine if the application is malicious.  1422 

Test Activity: Upload the application to Kryptowire; observe the output report. 1423 

Desired Outcome: Output report identifies the use of location, camera, or microphone use by the 1424 
application. 1425 

Observed Outcome: The Kryptowire report identified the use of location sensor, camera, or microphone 1426 
by the application. 1427 

5.2.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network 1428 
Communications via Installation of Malicious EMM/MDM, Network, VPN 1429 
Profiles, or Certificates 1430 

Summary: There is compromise of the integrity of the device or its network communications via 1431 
installation of malicious EMM/MDM, network, VPN profiles, or certificates using a man-in-the-middle 1432 
approach. 1433 

Test Activity: 1434 

 Install mitmproxy (https://mitmproxy.org/) on a computer (we used a Mac) connected to the 1435 
same Wi-Fi network as the mobile devices. 1436 

 Install mitmproxy’s CA certificate (stored at ~/.mitmproxy/mitmproxy-ca-cert.cer on our Mac) 1437 
onto the mobile devices being tested. iOS- and Android-specific instructions are found below. 1438 

 Configure the computer as necessary to run mitmproxy in transparent mode, as described in 1439 
https://docs.mitmproxy.org/stable/howto-transparent/. 1440 

 To illustrate a malicious actor’s ability to manipulate network traffic, we downloaded the 1441 
mitmproxy internet_in_mirror script from 1442 
https://github.com/mitmproxy/mitmproxy/blob/master/examples/simple/internet_in_mirror.p1443 
y. It performs a mirror reflection of the content of all websites. 1444 

 Run mitmproxy in transparent mode and using the internet_in_mirror script: mitmproxy –mode 1445 
transparent –ssl-insecure –showhost -s internet_in_mirror.py 1446 

 Rather than perform an intrusive attack such as address resolution protocol spoofing, we 1447 
manually configured each mobile device’s Wi-Fi network settings to change the default 1448 
gateway’s (sometimes referred to as router in the network settings) IP address to the 1449 
computer’s IP address rather than the router’s IP address. This configuration change forced all 1450 
the network traffic from each device through the computer. 1451 

Test Activity (Android): 1452 

https://mitmproxy.org/
https://docs.mitmproxy.org/stable/howto-transparent/
https://github.com/mitmproxy/mitmproxy/blob/master/examples/simple/internet_in_mirror.py
https://github.com/mitmproxy/mitmproxy/blob/master/examples/simple/internet_in_mirror.py
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 Place mitmproxy’s CA certificate as an attachment within an email message. 1453 

 Open the email message on the Android device and click on the attachment to attempt to install 1454 
the CA certificate. 1455 

 Modify the device’s Wi-Fi network settings to manually change the default gateway’s IP address 1456 
to the address of the computer running mitmproxy. 1457 

 Browse to a hypertext transfer protocol secure (https) website (e.g., 1458 
https://www.nccoe.nist.gov), and observe whether the content has been reversed, illustrating 1459 
that the man-in-the-middle attack on a TLS-protected connection was successful. 1460 

Test Activity (iOS): 1461 

 Use Apple Configurator 2 on a Mac, or another tool, to create an iOS configuration profile 1462 
containing mitmproxy’s CA certificate. The configuration profile used in testing was named 1463 
Enterprise Access. The configuration profile was signed using a key associated with an Apple 1464 
free developer account certificate. The signature was optional (Configuration profiles do not 1465 
have to be signed). 1466 

 Send the configuration profile as an attachment within an email message. 1467 

 Open the email message and attempt to click on the attachment to install the configuration 1468 
profile. Attempt to follow the prompts to complete the profile installation. 1469 

 Attempt to enable the CA certificate in the iOS device’s Certificate Trust Settings. 1470 

Desired Outcome: The enterprise’s security architecture should block installation of unauthorized 1471 
configuration profiles (iOS) or CA certificates (Android). Alternatively, the security architecture may 1472 
detect the presence of unauthorized configuration profiles or CA certificates and perform another 1473 
appropriate action, such as blocking the device from accessing enterprise resources until the 1474 
configuration profile or CA certificate is removed. The architecture should also detect attempted man-1475 
in-the-middle attacks. 1476 

Observed Outcome: Lookout detected a man-in-the-middle attack on both iOS and Android devices. 1477 
Lookout also detected the unknown configuration profile on iOS. 1478 

5.2.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via 1479 
Eavesdropping on Unencrypted Device Communications 1480 

Summary: Malicious actors can readily eavesdrop on communication over unencrypted, wireless 1481 
networks such as public Wi-Fi access points, which are commonly provided by coffee shops and hotels. 1482 
While a device is connected to such a network, a malicious actor would gain unauthorized access to any 1483 
data sent or received by the device for any session not already protected by encryption at either the 1484 
transport or application layers. 1485 

Test Activity: Test if applications will attempt to establish an http or unencrypted connection. 1486 

https://www.nccoe.nist.gov/
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Desired Outcome: Be alerted when applications attempt to make an unencrypted connection or prevent 1487 
the application from being able to do so. 1488 

Appthority can determine if applications will attempt to establish an http or unencrypted connection. 1489 

iOS and Android also can require a secure connection for an application. (When it tries to connect to the 1490 
server if it is unencrypted, it will just drop the connection.) 1491 

Observed Outcome: On both iOS and Android, Appthority detected a “sends data unencrypted” threat 1492 
for an application. Transferring data over unencrypted connections could result in the loss of 1493 
confidentiality of information being transmitted by that application. 1494 

5.2.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or 1495 
Brute-Forced device Unlock Code 1496 

Summary: A malicious actor may be able to obtain a user’s device unlock code by direct observation, 1497 
side-channel attacks, or brute-force attacks. 1498 

Test Activity: 1499 

 Attempt to completely remove the device unlock code. Observe whether the attempt succeeds. 1500 

 Attempt to set the device unlock code to “1234,” a weak four-digit personal identification 1501 
number (PIN). Observe whether the attempt succeeds. 1502 

 Attempt to continuously unlock the device, confirming the device is factory reset after 10 failed 1503 
attempts. 1504 

Desired Outcome: Policies set on the device by the EMM (MobileIron) should require a device unlock 1505 
code to be set, prevent the device unlock code from being removed, require a minimum complexity for 1506 
the device unlock code, and factory reset the device after 10 failed unlock attempts.  1507 

Additionally, Lookout can identify and report devices that have the lock screen disabled. 1508 

Observed Outcome: MobileIron applied a policy to the devices that enforced a mandatory PIN and 1509 
device wipe capability after 10 failed unlock attempts. Further, Lookout reports when the device has the 1510 
lock screen disabled. For both devices, all data was erased after 10 failed unlock attempts. 1511 

The option to remove the unlock PIN/passcode had been disabled. Upon attempting to set the PIN to 1512 
something simple, such as a PIN with repetitious or consecutive characters, an error was displayed, 1513 
informing the user they cannot use the PIN they entered. 1514 
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5.2.9 Threat Event 9—Unauthorized Access to Backend Services via authentication 1515 
or credential Storage Vulnerabilities in Internally Developed Applications 1516 

Summary: If a malicious actor gains unauthorized access to a mobile device, the attacker also has access 1517 
to the data and applications on that mobile device. The mobile device may contain an organization’s in-1518 
house applications and can subsequently gain access to sensitive data or backend services. 1519 

Test Activity: Application was submitted to Appthority for analysis of credential weaknesses. 1520 

Desired Outcome: Discover and report credential weaknesses.  1521 

Observed Outcome: Appthority recognized within an application that it uses hard-coded credentials. 1522 
The application’s use of hard-coded credentials could introduce vulnerabilities if the hard-coded 1523 
credentials were used for access to enterprise resources by unauthorized entities. 1524 

5.2.10  Threat Event 10 —Unauthorized Access of Enterprise Resources from an 1525 
Unmanaged and Potentially Compromised Device 1526 

Summary: An employee that accesses enterprise resources from an unmanaged mobile device may 1527 
expose the enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do 1528 
not benefit from security mechanisms deployed by the organization such as mobile threat defense, 1529 
mobile threat intelligence, application vetting services, and mobile security policies. These unmanaged 1530 
devices limit an organization’s visibility into the state of a mobile device, including if the device is 1531 
compromised by an attacker. 1532 

Test Activity: Attempt to directly access enterprise services, e.g., Exchange email server or corporate 1533 
VPN, on a mobile device that is not enrolled into the EMM system. 1534 

Desired Outcome: Enterprise services should not be accessible from devices that are not enrolled into 1535 
the EMM system. Otherwise, the enterprise is not able to effectively manage devices to prevent threats. 1536 

Observed Outcome: Devices that were not enrolled in MobileIron were unable to access enterprise 1537 
resources as the GlobalProtect VPN gateway prevented the devices from authenticating without proper 1538 
client certificates, only obtainable through enrolling in the EMM. 1539 

5.2.11  Threat Event 11—Loss of Organizational Data due to a Lost or Stolen Device 1540 

Summary: Due to the nature of the small form factor of mobile devices, they are easy to misplace or be 1541 
stolen. A malicious actor who gains physical custody of a device with inadequate security controls may 1542 
be able to gain unauthorized access to sensitive data or resources accessible to the device. 1543 

Test Activity: Attempt to download enterprise data onto a mobile device that is not enrolled into the 1544 
EMM system (may be performed in conjunction with TE-10). Attempt to remove (in conjunction with TE-1545 
8) the device unlock code or demonstrate that the device does not have a device unlock code in place. 1546 
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Attempt to locate and wipe the device through the EMM console (it will fail if the device is not enrolled 1547 
in the EMM). 1548 

Desired Outcome: It should be possible to locate or wipe EMM-enrolled devices in response to a report 1549 
that they have been lost or stolen. As demonstrated by TE-10, only EMM-enrolled devices should be 1550 
able to access enterprise resources. As demonstrated by TE-8, EMM-enrolled devices can be forced to 1551 
have a screen lock with a passcode of appropriate strength, which helps resist exploitation (including 1552 
loss of organizational data) if the device has been lost or stolen. 1553 

Should the device be unreachable by the EMM (e.g., disconnected from all networking), EMM control 1554 
and corporate data will be removed after 10 failed unlock attempts. 1555 

Observed Outcome (Enrolled Devices): Enrolled devices are protected. An enterprise policy requiring a 1556 
personal identification number/lock screen is present, and therefore the enterprise data on the device 1557 
could not be accessed. After 10 attempts to access the device, the device was wiped. Additionally, the 1558 
device was remotely wiped after it was reported as lost to enterprise mobile device service 1559 
management. 1560 

Observed Outcome (Unenrolled Devices): As shown in Threat Event 10, only enrolled devices can access 1561 
enterprise services. When the device attempted to access enterprise data, no connection to the 1562 
enterprise services was available. Because the device cannot access the enterprise, enterprise 1563 
information would not be located on the device. 1564 

5.2.12  Threat Event 12—Loss of Confidentiality of Organizational Data due to Its 1565 
Unauthorized Storage in Non-Organizationally Managed Services 1566 

Summary: If employees violate data management policies by using unmanaged services to store 1567 
sensitive organizational data, this data will be placed outside organizational control, where the 1568 
organization can no longer protect its confidentiality, integrity, or availability. Malicious actors who 1569 
compromise the unauthorized service account or any system hosting that account may gain 1570 
unauthorized access to the data. 1571 

Test Activity: Connect to the enterprise VPN. Open an enterprise website or application. Attempt to 1572 
extract enterprise data by taking a screenshot, or copy/paste and send it via an unmanaged e-mail 1573 
account. 1574 

Desired Outcome: Screenshots and other data-sharing actions will be prohibited by the EMM while 1575 
using managed applications. 1576 

Observed Outcome: Through MobileIron restriction and lockdown policies, an administrator prevented 1577 
the following actions on devices: 1578 

Android 1579 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 52 

 copy/paste 1580 

 screen capture 1581 

 data transfer over near-field communication 1582 

 data transfer over Universal Serial Bus 1583 

 Bluetooth 1584 

iOS 1585 

 screen capture and recording (iOS 9+) 1586 

 AirDrop 1587 

 iCloud Backup 1588 

 iCloud Documents and data access 1589 

 managed applications storing data in iCloud 1590 

 data flow between managed and unmanaged applications 1591 

 hand-off 1592 

These restrictions prohibited the user from executing common data leakage methods. 1593 

5.3 Scenarios and Findings 1594 

One aspect of our security evaluation involved assessing how well the reference design addresses the 1595 
security characteristics it was intended to support. The Cybersecurity Framework Subcategories were 1596 
used to provide structure to the security assessment by consulting the specific sections of each standard 1597 
that are cited in reference to a Subcategory. The cited sections provide validation points that the 1598 
example solution would be expected to exhibit. Using the Cybersecurity Framework Subcategories as a 1599 
basis for organizing our analysis allowed us to systematically consider how well the reference design 1600 
supports the intended security characteristics.  1601 

This section provides the scenarios and findings for the security and privacy characteristics the example 1602 
solution was intended to support. They include: 1603 

 development of the Cybersecurity Framework and NICE Framework mappings 1604 

 threat event scenarios and example solution architecture mitigations  1605 

 data action scenarios and potential mitigations that organizations could employ 1606 
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5.3.1 Cybersecurity Framework and NICE Framework Work Roles Mappings 1607 

While the example solution was being developed, the Cybersecurity Framework Subcategory mappings 1608 
were developed into a table mapping for organizations implementing the example solution’s 1609 
capabilities. 1610 

As the example solution’s products were installed, configured, and used in the example solution 1611 
architecture, the example solution’s functions and their corresponding Cybersecurity Framework 1612 
Subcategories, along with other guidance alignment, were determined and documented. 1613 

This mapping became an important resource to the example solution contained in this practice guide 1614 
because it provides the ability to communicate with the organization’s stakeholders about the security 1615 
controls that the example solution can help mitigate, and the workforce requirements that the example 1616 
solution will require. 1617 

The example solution’s products, security control, and workforce mapping can be found in Table H-1. 1618 

5.3.2 Threat Event Scenarios and Findings 1619 

As part of the findings, the threat events were mitigated in the example solution architecture using the 1620 
concepts and technology shown in Table 5-1. Each threat event was matched with functions that helped 1621 
mitigate the risks posed by the threat event. 1622 

Note: While not demonstrated in the table, TEE provided tamper-resistant processing environment 1623 
capabilities that helped mitigate mobile device runtime and memory threats in the example solution. 1624 

Table 5-1 Threat Event Scenarios and Findings Summary 1625 

Threat Event How the Example Solution  
Architecture Helps Mitigate the 
Threat Event 

The Technology 
Function That 
Helps Mitigate 
the Threat Event 

Threat Event 1: Unauthorized access to 
sensitive information via a malicious or 
privacy-intrusive application 

Ensured administrators have insight 
into what corporate data 
applications can access. 

MTI 

Threat Event 2: Theft of credentials 
through an SMS or email phishing 
campaign 

Utilized PAN-DB to block known 
malicious websites. 

Firewall 
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Threat Event How the Example Solution  
Architecture Helps Mitigate the 
Threat Event 

The Technology 
Function That 
Helps Mitigate 
the Threat Event 

Threat Event 3: Malicious applications 
installed via URLs in SMS or email 
messages 

Disabled installing applications from 
unknown sources. 

EMM 

Threat Event 4: Confidentiality and 
integrity loss due to exploitation of 
known vulnerability in the OS or 
firmware 

Quarantined noncompliant device 
until its operating system was 
updated. 

EMM 

Threat Event 5: Violation of privacy via 
misuse of device sensors 

Application vetting reports indicated 
the sensors to which an application 
requested access. 

MTI 

Threat Event 6: Compromise of the 
integrity of the device or its network 
communications via installation of 
malicious EMM/MDM, network, VPN 
profiles, or certificates 

Detected a man-in-the-middle attack 
by using Lookout. Lookout detected 
the unauthorized configuration 
profile on iOS. 

MTD 

Threat Event 7: Loss of confidentiality of 
sensitive information via eavesdropping 
on unencrypted device communications 

Application vetting reports indicated 
if an application sent data without 
proper encryption. 

Application 
Vetting 

Threat Event 8: Compromise of device 
integrity via observed, inferred, or 
brute-forced device unlock code 

Enforced mandatory device wipe 
capabilities after 10 failed unlock 
attempts. 

EMM 

Threat Event 9: Unauthorized access to 
backend services via authentication or 
credential storage vulnerabilities in 
internally developed applications 

Application vetting reports indicated 
if an application used credentials 
improperly. 

MTI 

Threat Event 10: Unauthorized access of 
enterprise resources from an 
unmanaged and potentially 
compromised device 

Devices not enrolled in the EMM 
system were not able to connect to 
the corporate VPN. 

VPN 
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Threat Event How the Example Solution  
Architecture Helps Mitigate the 
Threat Event 

The Technology 
Function That 
Helps Mitigate 
the Threat Event 

Threat Event 11: Loss of organizational 
data due to a lost or stolen device 

Enterprise data was protected by 
enforced passcode policies and 
device wipe capabilities. 

EMM 

Threat Event 12: Loss of confidentiality 
of organizational data due to its 
unauthorized storage in non-
organizationally managed services 

Policies that enforce data loss 
prevention were pushed to devices. 

EMM 

5.3.3 Data Action Scenarios and Findings 1626 

The results of the PRAM found that three data actions were especially relevant to the build. Potential 1627 
mitigations that could be used by an organization to lessen their impact were identified by the PRAM as 1628 
shown below. Further details on the PRAM’s findings can be found in Appendix F. 1629 

Table 5-2 Data Action Scenarios and Findings Summary 1630 

Data Action Data Action  
Description 

How the Data Action Could Be Mitigated 

Data Action 1: 
Blocking access and 
wiping devices 

Employees are likely to 
use their devices for 
both personal and work-
related purposes. 
Therefore, in a system 
that features the 
capability to wipe a 
device entirely, there 
could be an issue of 
employees losing 
personal data. 

Block the device’s access to enterprise resources 
until it is granted access permission again. 
 
Selectively wipe elements of the device without 
removing all data on the device. Within the 
example solution, this option is available for iOS 
devices. 
 
Advise employees to back up the personal data 
maintained on devices. 
 
Limit staff with the ability to perform wipes or 
block access. 
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Data Action Data Action  
Description 

How the Data Action Could Be Mitigated 

Data Action 2: 
Employee monitoring 

Employer-owned or 
controlled networks 
monitor activities on a 
regular basis. Employees 
may not be aware of the 
monitoring of their 
interactions with the 
system and may not 
want this monitoring to 
occur. 

Limit staff with ability to review data about 
employees and their devices. 
 
Develop organizational policies and techniques to 
limit collection of specific data elements. 
 
Develop organizational policies and techniques 
regarding disposal of PII. 

Data Action 3: Data 
sharing across parties 

Data transmission about 
individuals and their 
devices among a variety 
of different parties 
could be confusing for 
employees who might 
not know who has 
access to different 
information about them. 

Develop organizational policies and techniques for 
de-identification of data. 
 
Use encryption. 
 
Limit or disable access to data. 
 
Develop organizational policies and techniques to 
limit collection of specific data elements. 
 
Use contracts to limit third-party data processing. 

 

6 Conclusion 1631 

This document provides an overview of the Risk Management Framework and the Privacy Risk 1632 
Assessment Methodology, an explanation of mobile device security concepts, and an example solution 1633 
for organizations implementing a COPE deployment. 1634 

Our fictitious Orvilia Development organization started with a mobile device infrastructure that was 1635 
lacking mobile device security architecture concepts. It employed a risk management and privacy 1636 
methodology to understand the current gaps in its architecture and methods to enhance the security of 1637 
its systems. 1638 

After identifying the core threat events from the risk assessment, the appropriate mobile device security 1639 
technologies were applied. These included an on-premises EMM solution integrated with cloud- and 1640 
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agent-based mobile security technologies to help deploy a set of security and privacy capabilities in 1641 
support of a usage scenario. 1642 

The practice guide also includes in Volume C a series of How-To Guides—step-by-step instructions 1643 
covering the initial setup (installation or provisioning) and configuration for each component of the 1644 
architecture—to help security engineers rapidly deploy and evaluate our example solution in their test 1645 
environment. 1646 

The example solution of our reference design uses standards-based, commercially available products. It 1647 
can be used directly by any organization with a COPE usage scenario by implementing a security 1648 
infrastructure that supports an integration of on-premises with cloud-hosted mobile security 1649 
technologies. The practice guide provides a reference design and example solution that an organization 1650 
may use in whole or in parts as the basis for a custom solution that realizes the security and privacy 1651 
characteristics that best support its unique mobile device usage scenario. 1652 

7 Future Build Considerations 1653 

A topic of interest for a future build is a BYOD scenario. This entails protecting corporate data on 1654 
personally owned devices that employees will use for work as well as personal activity. Another area of 1655 
interest is a thin client deployed to mobile devices. The thin client would allow the employee to access a 1656 
virtual device contained within the corporate infrastructure to access enterprise data and resources, 1657 
ensuring that no corporate data ever resides on the physical device.  1658 

Further, examination of emerging 5G technologies as they relate to mobile device security is a new field 1659 
that presents a wide breadth of research opportunities. 1660 
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Appendix A List of Acronyms 1661 

AD Active Directory 
ADCS Active Directory Certificate Services 
ADDS Active Directory Domain Services 
API Application Programming Interface 
ATARC Advanced Technology Academic Research Center 
ATT&CK Adversarial Tactics, Techniques, and Common Knowledge 
BYOD Bring Your Own Device 
CIO Chief Information Officer 
CIS Center for Internet Security 
COMSEC Communications Security 
COPE Corporate-Owned Personally-Enabled 
CSP Credential Service Provider 
CVE Common Vulnerabilities and Exposures 
DHS Department of Homeland Security 
DMZ Demilitarized Zone 
EMM Enterprise Mobility Management 
FedRAMP Federal Risk and Authorization Management Program 

FIPS Federal Information Processing Standards 

GPS Global Positioning System 

HTTP Hypertext Transfer Protocol 

HTTPS Hypertext Transfer Protocol Secure 

IEC International Electrotechnical Commission 
IEEE Institute of Electrical and Electronics Engineers 

IMEI International Mobile Equipment Identity 

IP Internet Protocol 

IPS Intrusion Protection System 

IR Interagency Report 

ISO International Organization for Standardization 
IT Information Technology 

MDM Mobile Device Management 

MTC Mobile Threat Catalogue 
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MTD Mobile Threat Defense 

MTI Mobile Threat Intelligence 

MTP Mobile Threat Protection 
MSCT Mobile Services Category Team 

NCCoE National Cybersecurity Center of Excellence 

NIAP National Information Assurance Partnership 

NICE National Initiative for Cybersecurity Education 

NIST National Institute of Standards and Technology 

NVD National Vulnerability Database 
OS Operating System 

PII Personally Identifiable Information 

PRAM Privacy Risk Assessment Methodology 

RMF Risk Management Framework 

ROM Read-only Memory 

SCEP Simple Certificate Enrollment Protocol 
SIEM Security Information and Event Management 

SMS Short Message Service 

SP Special Publication 

TE Threat Event 

TEE Trusted Execution Environment 

TLS Transport Layer Security 
UPN User Principal Name 

URL Uniform Resource Locator 

VPN Virtual Private Network 

  

1662 
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Appendix B Glossary 1663 

  
Access Management Access Management is the set of practices that enables only those 

permitted the ability to perform an action on a particular resource. 
The three most common Access Management services you 
encounter every day perhaps without realizing it are: Policy 
Administration, Authentication, and Authorization [67]. 

Agent A host-based IPS program that monitors and analyzes activity and 
performs preventive actions; OR a program or plug-in that enables 
an SSL VPN to access non-Web-based applications and services 
[15] 

Application Layer Layer of the TCP/IP protocol stack that sends and receives data for 
particular applications such as DNS, HTTP, and SMTP [15] 

App-Vetting  
Process 

The process of verifying that an app meets an organization’s 
security requirements. An app vetting process comprises app 
testing and app approval/rejection activities [18]. 

Blacklist A list of discrete entities, such as hosts or applications that have 
been previously determined to be associated with malicious 
activity [68] 

Brute-Force Attack In cryptography, an attack that involves trying all possible 
combinations to find a match [69] 

Chief  
Information Officers  
(CIO) Council 

The CIO Council is the principal interagency forum for improving 
agency practices related to the design, acquisition, development, 
modernization, use, sharing, and performance of Federal 
information resources [70]. 

Cryptographic Algorithm A well-defined computational procedure that takes variable 
inputs, including a cryptographic key, and produces an output [68] 

Cryptographic Key A value used to control cryptographic operations, such as 
decryption, encryption, signature generation, or signature 
verification [71] 
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Cryptography The discipline that embodies the principles, means, and methods 
for the transformation of data in order to hide their semantic 
content, prevent their unauthorized use, or prevent their 
undetected modification [68] 

Common Vulnerabilities and 
Exposures 

A dictionary of common names for publicly known information 
system vulnerabilities [72] 

Data Action System operations that process PII [44] 

Demilitarized Zone (DMZ) A network created by connecting two firewalls. Systems that are 
externally accessible but need some protections are usually 
located on DMZ networks [73]. 

Disassociability Enabling the processing of PII or events without association to 
individuals or devices beyond the operational requirements of the 
system [44] 

Encryption The cryptographic transformation of data to produce ciphertext 
[68] 

Enterprise Mobility 
Management  

Enterprise Mobility Management (EMM) systems are a common 
way of managing mobile devices in the enterprise. Although not a 
security technology by itself, EMMs can help to deploy policies to 
an enterprise’s device pool and to monitor device state [6]. 

Identity Verification Confirmation, through the provision of objective evidence, that 
specified requirements have been fulfilled (e.g., an entity’s 
requirements have been correctly defined, or an entity’s attributes 
have been correctly presented; or a procedure or function 
performs as intended and leads to the expected outcome). 
Adapted from Verification [68]. 

Impact The effect on organizational operations, organizational assets, 
individuals, other organizations, or the Nation (including the 
national security interests of the United States) of a loss of 
confidentiality, integrity, or availability of information or an 
information system [13] 
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Key Logger A remote program designed to record which keys are pressed on a 
computer keyboard used to obtain passwords or encryption keys 
and thus bypass other security measures [74] 

Malware Software or firmware intended to perform an unauthorized 
process that will have adverse impact on the confidentiality, 
integrity, or availability of an information system. A virus, worm, 
Trojan horse, or other code-based entity that infects a host. 
Spyware and some forms of adware are also examples of malicious 
code [13]. 

Man-in-the-Middle 
Attack 

An attack in which an attacker is positioned between two 
communicating parties in order to intercept and/or alter data 
traveling between them. In the context of authentication, the 
attacker would be positioned between claimant and verifier, 
between registrant and CSP during enrollment, or between 
subscriber and CSP during authenticator binding [71]. 

Mobile Device 
Management (MDM) 

The administration of mobile devices such as smartphones, 
tablets, computers, laptops, and desktop computers. MDM is 
usually implemented through a third-party product that has 
management features for particular vendors of mobile devices 
[18]. 

Network Layer Layer of the TCP/IP protocol stack that is responsible for routing 
packets across networks [15] 

Phishing An attack in which the subscriber is lured (usually through an 
email) to interact with a counterfeit verifier/RP and tricked into 
revealing information that can be used to masquerade as that 
subscriber to the real verifier/RP [71] 

Predisposing 
Conditions 

A condition that exists within an organization, a mission/business 
process, enterprise architecture, or information system including 
its environment of operation, which contributes to (i.e., increases 
or decreases) the likelihood that one or more threat events, once 
initiated, will result in undesirable consequences or adverse 
impact to organizational operations and assets, individuals, other 
organizations, or the Nation [9] 
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Privacy Risk 
Assessment 
Methodology (PRAM) 

The PRAM is a tool that applies the risk model from NISTIR 8062 
and helps organizations analyze, assess, and prioritize privacy risks 
to determine how to respond and select appropriate solutions. 
The PRAM can help drive collaboration and communication 
between various components of an organization, including privacy, 
cybersecurity, business, and IT personnel [75]. 

Read-Only Memory ROM is a pre-recorded storage medium that can only be read from 
and not written to [76]. 

Red Team Exercise An exercise, reflecting real-world conditions, that is conducted as a 
simulated adversarial attempt to compromise organizational 
missions and/or business processes to provide a comprehensive 
assessment of the security capability of the information system 
and organization [13] 

Replay Resistance Protection against the capture of transmitted authentication or 
access control information and its subsequent retransmission with 
the intent of producing an unauthorized effect or gaining 
unauthorized access [19] 

Risk A measure of the extent to which an entity is threatened by a 
potential circumstance or event, and typically a function of: (i) the 
adverse impacts that would arise if the circumstance or event 
occurs; and (ii) the likelihood of occurrence [9] 

Risk Assessment The process of identifying risks to organizational operations 
(including mission, functions, image, reputation), organizational 
assets, individuals, other organizations, and the Nation, resulting 
from the operation of an information system. Part of risk 
management, incorporates threat and vulnerability analyses, and 
considers mitigations provided by security controls planned or in 
place. Synonymous with risk analysis [13] 

Risk 
Management 
Framework 

The Risk Management Framework (RMF) provides a structured, 
yet flexible approach for managing the portion of risk resulting 
from the incorporation of systems into the mission and business 
processes of the organization [77]. 

Sandbox A restricted, controlled execution environment that prevents 
potentially malicious software, such as mobile code, from 
accessing any system resources except those for which the 
software is authorized (Under Sandboxing) [68]. 
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Security Control A safeguard or countermeasure prescribed for an information 
system or an organization designed to protect the confidentiality, 
integrity, and availability of its information and to meet a set of 
defined security requirements [13] 

Side-Channel Attacks An attack enabled by leakage of information from a physical 
cryptosystem. Characteristics that could be exploited in a side-
channel attack include timing, power consumption, and 
electromagnetic and acoustic emissions [71]. 

Social Engineering The act of deceiving an individual into revealing sensitive 
information, obtaining unauthorized access, or committing fraud 
by associating with the individual to gain confidence and trust [71] 

Threat Any circumstance or event with the potential to adversely impact 
organizational operations (including mission, functions, image, or 
reputation), organizational assets, individuals, other organizations, 
or the Nation through an information system via unauthorized 
access, destruction, disclosure, or modification of information, 
and/or denial of service [9] 

Threat Events An event or situation that has the potential for causing undesirable 
consequences or impact [9] 

Threat 
Intelligence 

Threat information that has been aggregated, transformed, 
analyzed, interpreted, or enriched to provide the necessary 
context for decision-making processes [78] 

Threat Sources The intent and method targeted at the intentional exploitation of a 
vulnerability or a situation and method that may accidentally 
trigger a vulnerability. Synonymous with threat agent [13] 

Transport Layer Layer of the TCP/IP protocol stack that is responsible for reliable 
connection-oriented or connectionless end-to-end 
communications [15] 

Transport Layer 
Security (TLS) 
 

A security protocol providing privacy and data integrity between 
two communicating applications. The protocol is composed of two 
layers: the TLS Record Protocol and the TLS Handshake Protocol 
[68]. 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 65 

 

 

Trusted 
Certificate 

A certificate that is trusted by the Relying Party on the basis of 
secure and authenticated delivery. The public keys included in 
trusted certificates are used to start certification paths. Also 
known as a “trust anchor” [79] 

Unmanaged Device A device inside the assessment boundary that is either 
unauthorized or, if authorized, not assigned to a person to 
administer [80] 

Virtual Private 
Network 

Protected information system link utilizing tunneling, security 
controls, and endpoint address translation giving the impression of 
a dedicated line [68] 

Vulnerability Weakness in an information system, system security procedures, 
internal controls, or implementation that could be exploited by a 
threat source [9] 

Watering Hole Watering hole attacks involve attackers compromising one or 
more legitimate Web sites with malware in an attempt to target 
and infect visitors to those sites [81]. 
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Appendix D Android, Apple, and Samsung Knox Mobile 1667 

Enrollment 1668 

Device enrollment and management capabilities are available when deploying mobile devices in bulk. 1669 
Certain settings can be preloaded, and devices can ship preconfigured for enterprise management. iOS-, 1670 
Android-, and Samsung Knox-based devices integrate directly with Enterprise Mobility Management 1671 
(EMM) solutions, providing enterprise-level management of security controls based on policy. 1672 

D.1 Android Devices 1673 

For Android devices, zero-touch enrollment provides an option different from the manual setup of 1674 
Android devices. Android-based devices offer security controls that an EMM can leverage for enterprise 1675 
deployments. The Android Enterprise program by Google is available on devices with Android 5.0 1676 
(Lollipop) and higher. An EMM deploys a device policy controller as part of its on-device agent that 1677 
controls local device policies and system applications on devices. Android Enterprise supports corporate-1678 
owned personally-enabled and bring your own device deployment scenarios through work-managed 1679 
and work-profile device solutions [82], [83]. 1680 

D.2 iOS Devices 1681 

For iOS devices, Apple Configurator supports Volume Purchase and Device Enrollment Program 1682 
scenarios. Apple Business Manager provides a mobile device management solution to assist 1683 
organizations in deploying iOS devices. iOS devices are managed by configuration profiles. Configuration 1684 
profiles can force security policies such as virtual private network usage, enterprise Kerberos support, 1685 
and access to cloud services. iOS further incorporates a set of additional security controls in what is 1686 
termed supervised mode, which denotes a corporately owned device. Typically, organizations choose to 1687 
use the Device Enrollment Program for large-scale deployments of iOS devices in supervised mode due 1688 
to the reduction of labor involved in manually configuring each device. However, due to the small 1689 
number of devices in our reference design, we have configured supervised mode using the Apple 1690 
Configurator 2 tool. A more detailed description of iOS capabilities can be found in the iOS Security 1691 
Guide [84], [85]. 1692 

D.3 Samsung Knox Devices 1693 

Samsung Knox Mobile Enrollment provides the ability to add Samsung devices to the enterprise without 1694 
manually enrolling each device. Samsung Knox Mobile Enrollment works on Samsung Galaxy devices 1695 
running Android Lollipop or higher. It allows remote provisioning of devices when they connect to Wi-Fi 1696 
or cellular networks. Samsung Knox Mobile Enrollment works with a number of EMM solutions, 1697 
including cloud-based options [86], [87], [88]. 1698 

1699 
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Appendix E Risk Assessment 1700 

E.1 Risk Assessment 1701 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, [9] states that risk is “a measure of 1702 
the extent to which an entity is threatened by a potential circumstance or event, and typically a function 1703 
of: (i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 1704 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 1705 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 1706 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 1707 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 1708 
considers mitigations provided by security controls planned or in place.”  1709 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 1710 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 1711 
Information Systems and Organizations—material that is available to the public. The Risk Management 1712 
Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks, 1713 
from which we developed the project, the security characteristics of the build, and this guide. 1714 

This section details the risk assessment undertaken to improve the mobile security posture of the 1715 
fictional organization Orvilia Development. Typically, a National Institute of Standards and Technology 1716 
(NIST) Special Publication (SP) 800-30 Revision 1-based risk assessment follows a four-step process as 1717 
shown in Figure E-1: Prepare for assessment, conduct assessment, communicate results, and maintain 1718 
assessment. 1719 
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Figure E-1 Risk Assessment Process 1720 

 

To provide the most value in this exercise: 1721 

 We focused on the preparation, which established the context of the risk assessment.  1722 

 We conducted the risk assessment, which produced a list of information security risks that were 1723 
prioritized by risk level and used to inform risk response decisions.  1724 

 We followed the process detailed in Section 3 of NIST SP 800-30 Revision 1 [9] to perform a risk 1725 
assessment of the current mobile infrastructure. 1726 

We recommend that organizations performing a risk assessment communicate results and perform 1727 
maintenance of the risk assessment, but these activities were deemed out of scope for this project. The 1728 
following tasks were used during the assessment process. 1729 

E.1.1 Task 1-1: Risk Assessment Purpose 1730 

Identify the purpose of the risk assessment in terms of the information that the assessment is intended to 1731 
produce and the decisions the assessment is intended to support. 1732 
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The purpose of the risk assessment of Orvilia Development was to identify and document new risks to 1733 
its mission resulting from addition of a mobility program.  1734 

The results of the risk assessment informed decisions to Orvilia’s mobility deployment that included: 1735 

 implementation of new security mechanisms 1736 

 configuration changes to existing infrastructure  1737 

 updates to security and appropriate-use policies relevant to their mobility program 1738 

E.1.2 Task 1-2: Risk Assessment Scope 1739 

Identify the scope of the risk assessment in terms of organizational applicability, time frame supported, 1740 
and architectural/technology considerations. 1741 

Organizational Applicability: 1742 

The scope of this risk assessment was limited to systems impacted by inclusion of a mobility program; it 1743 
did not include existing information technology (IT) infrastructure to which no impact was anticipated. 1744 
With their original architecture, Orvilia deployed corporate-owned personally-enabled (COPE) devices. 1745 
Orvilia employees utilized mobile devices for local and remote work activities and limited personal 1746 
activities (e.g., phone calls, messaging, social applications, and personal emails). 1747 

With Orvilia’s new government contract, this risk assessment also evaluated Orvilia’s mobile 1748 
deployment regarding its ability to access and store government data while meeting applicable 1749 
information security and privacy requirements.  1750 

While not directly associated with risk assessment activities, Orvilia will be required to demonstrate 1751 
compliance with government standards and policies established to improve data security. Therefore, 1752 
Orvilia needed to determine how compliance with government policy and application of its standards 1753 
would best align with its strategy to identify, protect again, detect, respond to, and recover from threats 1754 
related to its mobility program. 1755 

Time Frame Supported: 1756 

Because this was the first risk assessment performed by Orvilia, the process was more time-intensive 1757 
than it will be in future risk management cycles. Orvilia completed the initial risk assessment within six 1758 
months. 1759 

Architectural and Technology Considerations: 1760 

This risk assessment was scoped to Orvilia’s mobile deployment, which constitutes mobile devices used 1761 
to access Orvilia enterprise resources along with any backend IT components used to manage or provide 1762 
services to those mobile devices. 1763 
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The following provide an overview of the mobile deployment components involved in the original 1764 
(current) Orvilia architecture. 1765 

 Mobile Device: A mobile device is a small form factor device with a rich operating system, at 1766 
least one wireless network interface, and the ability to run applications. These features are 1767 
considered essential for Orvilia to have portable and efficient access to enterprise data. 1768 

 Communication Networks and Data Transmission: Mobile devices will establish connections to 1769 
the internet by using their cellular or Wi-Fi adapters. As connections may be made to unsecured 1770 
access points or may traverse untrusted networks, consideration will be given to the risks 1771 
associated with the security of those connections and the data transmitted over them. 1772 
Additionally, the organization will need to consider risks arising from permitting inbound 1773 
connections by mobile devices via the internet.  1774 

 Public Application Stores: With a COPE deployment strategy, employees will have the option to 1775 
download any mobile application available from official platform application stores (e.g., Google 1776 
Play Store). While those platforms analyze applications for malicious behaviors, it is still possible 1777 
for such applications to exceed Orvilia’s needs for user privacy or pose a risk to the devices or 1778 
data. Therefore, risks from such applications should be included in this assessment. 1779 

 Device and Operating System (OS) Vendor Infrastructure: The hardware, firmware, and 1780 
software that compose each model of mobile device can vary, particularly those from different 1781 
manufacturers and vendors, which may incorporate technology that is exclusive to their 1782 
products. It will be important to select devices that demonstrate security mechanisms that align 1783 
with the organization’s risk mitigation strategy. However, risks that are specific to given device 1784 
components (e.g., chipsets or driver versions) will be out of scope for this assessment. 1785 

 Enterprise Systems: If a potentially compromised mobile device can connect to the enterprise, it 1786 
poses direct risks to any systems it can reach or data it can access. Such systems will reasonably 1787 
include on-premises mobile application stores, mobile management technologies, email servers, 1788 
file servers, and intranet web servers. Subsequent compromise of any of these systems may 1789 
cascade to others not directly reachable by the mobile device. Risks to all such systems by a 1790 
mobile device should be included in this assessment. 1791 

E.1.3 Task 1-3: Risk Assessment Assumptions and Constraints 1792 

Identify the specific assumptions and constraints under which the risk assessment is conducted. 1793 

Risk assessment assumptions and constraints were developed using a NIST SP 800-30 Revision 1 Generic 1794 
Risk Model as shown in Figure E-2. 1795 
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Figure E-2 NIST 800-30 Generic Risk Model 1796 

 

E.1.3.1 Risk Assessment Assumptions 1797 

Some of the threats and their resulting risks and impacts span several levels. In cases where these risks 1798 
and impacts have several possible levels, it was assumed that Orvilia would document these using a 1799 
high-water mark methodology. This assumption of greatest risk then provided the basis for risk 1800 
mitigation activities. For example, where the threat risk could pose a moderate, high, or very high 1801 
outcome, the very high outcome was selected, and these very high risks were prioritized for mitigation. 1802 

E.1.3.2 Risk Assessment Constraints 1803 

Information regarding the following were used as input for the constraints for the risk assessment. 1804 

 threat sources 1805 

 threat events 1806 

 vulnerabilities and predisposing conditions 1807 

 likelihood 1808 

 impacts 1809 

 risk assessment and analysis approaches 1810 

 resources available for the assessment 1811 
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 skills and expertise 1812 

Threat Sources 1813 

Orvilia’s executives and managers identified two threat sources as possible concerns. Orvilia’s technical 1814 
staff were provided security control mappings identified within this guide to help them understand the 1815 
additional security that the example solution could provide to Orvilia as they implemented the example 1816 
solution. 1817 

Additionally, due to the cybersecurity-focused scope of the risk assessment, non-adversarial threat 1818 
sources (e.g., unintentional hardware, software, or system design and architecture shortcoming threats) 1819 
were not considered. 1820 

As identified in Section E.1.6, Task 2-1: Identify and Characterize Threat Sources of Concern, the risk 1821 
assessment identified the following threat sources of concern: 1822 

 Orvilia’s competitors 1823 

 nation-state actors 1824 

Threat Events 1825 

 Threat events were described at a high level and in general terms within the risk assessment. 1826 
Similar threat events were combined into a single, broader threat. 1827 

 Only those threat events that have been previously observed by an authoritative source were 1828 
considered (e.g., reported as already having occurred by other organizations), drawing primarily 1829 
from the NIST National Cybersecurity Center of Excellence Mobile Threat Catalogue [6]. 1830 

 Threat events involving exploitation of vulnerabilities within the cellular network, including a 1831 
mobile device’s cellular baseband, reasonably exceeded Orvilia’s ability to directly identify and 1832 
mitigate them and were not further assessed. 1833 

 Threat events involving exploitation of vulnerabilities in low-level hardware, firmware, and 1834 
device controllers reasonably exceeded Orvilia’s ability to directly identify and mitigate them 1835 
and were not further assessed. 1836 

 Threat events involving exploitation of vulnerabilities in the supply chain reasonably exceeded 1837 
Orvilia’s ability to directly identify and mitigate them and were not further assessed. 1838 

Vulnerabilities and Predisposing Conditions 1839 

 Mobile device vulnerabilities considered during this risk assessment included those in mobile 1840 
operating systems and mobile applications, including third-party software libraries. 1841 

 Vulnerabilities in commonly used noncellular network protocols such as Bluetooth and Wi-Fi 1842 
were considered. 1843 
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 Vulnerabilities related to a potential Enterprise Mobility Management (EMM) system were 1844 
considered. 1845 

 Additional information and determinations were made via Appendix F of NIST SP 800-30 1846 
Revision 1. 1847 

Likelihood 1848 

 Likelihood determinations were made via Appendix G of NIST SP 800-30 Revision 1. 1849 

Note: The rating of overall likelihood is derived from the Likelihood of Initiation and Likelihood that 1850 
Threat Events Result from Adverse Impacts using Table G-5 of Appendix G in NIST SP 800-30 Revision 1 1851 
[9]. Ratings of the latter two variables relied heavily on the subjective judgment of Orvilia employees. 1852 

Impacts 1853 

 Impact determinations were made via Appendix H of NIST SP 800-30 Revision 1. 1854 

Note: Ratings of impact relied heavily on the subjective judgment of Orvilia employees. 1855 

Risk Assessment and Analysis Approaches 1856 

 This risk assessment focused on identifying an initial set of threats to Orvilia’s mobile 1857 
deployment.  1858 

 Approaches for describing threats and their impact were informed by the Adversarial Tactics, 1859 
Techniques, and Common Knowledge (ATT&CK) Framework [89]. 1860 

 The rating of Risk was derived from both the overall likelihood and level of impact using Table I-1861 
2 of Appendix I in NIST SP 800-30 Revision 1 [9]. 1862 

 Resources Available for the Assessment 1863 

 Orvilia ensured the appropriate staff with the requisite expertise were available to conduct the 1864 
assessment within the time allotted. 1865 

 Orvilia provided funding for the risk analysis staff.  1866 

 Orvilia staff who conducted the risk assessment had the necessary information systems and 1867 
software. 1868 

Skills and Expertise 1869 

 Risk assessments were conducted by experts leveraging industry best practices and NIST risk 1870 
assessment frameworks. 1871 

E.1.4 Task 1-4: Risk Assessment Threat, Vulnerability, and Impact Sources 1872 

Identify the sources of descriptive threat, vulnerability, and impact information to be used in the risk 1873 
assessment. 1874 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 86 

Orvilia used the following methods to identify mobile infrastructure threats, vulnerabilities, and impacts. 1875 

E.1.4.1 Sources of Threats 1876 

This risk assessment identified NIST’s Mobile Threat Catalogue (MTC) [6], along with its associated NIST 1877 
Interagency Report 8144, Assessing Threats to Mobile Devices & Infrastructure [90], and MITRE’s 1878 
ATT&CK Mobile Profile [91] as credible sources for threat information. Each entry in the MTC contains 1879 
several pieces of information: an identifier, a category, a high-level description, details on its origin, 1880 
exploit examples, Common Vulnerabilities and Exposures [92] examples, possible countermeasures, and 1881 
academic references. 1882 

MITRE’s ATT&CK is a curated knowledge base and model for cyber-adversary behavior. ATT&CK details 1883 
specific techniques that can be used by cyber adversaries. Each technique entry typically includes a 1884 
detailed technical description, mitigations, detection analytics, examples of use by malicious actors, and 1885 
references. The ATT&CK model organizes these techniques into high-level malicious actor tactical 1886 
objectives, referred to as tactics. A primary use case for ATT&CK is use by organizations to assess the 1887 
state of their cybersecurity defenses and prioritize deployment of defensive capabilities. The ATT&CK 1888 
Mobile Profile describes tactics and techniques specific to the mobile environment. 1889 

Due to Orvilia’s current use of cloud services, it identified the outputs of the Federal Risk and 1890 
Authorization Management Program [93] and associated NIST SP 800-53 security controls as being in 1891 
scope for this risk assessment. 1892 

E.1.4.2 Sources of Vulnerabilities 1893 

Vulnerabilities are commonly associated with mobile operating systems, device drivers, mobile 1894 
applications, and third-party libraries. However, vulnerabilities can be present in any level of the mobile 1895 
technology stack. For up-to-date information regarding vulnerabilities, this risk assessment identified 1896 
the National Vulnerability Database (NVD) [94] as a credible source of information. The NVD is the U.S. 1897 
government repository of standards-based vulnerability management data. Use of NVD was 1898 
supplemented by review of individual vendor vulnerability disclosures such as those published in the 1899 
Pixel/Nexus Security Bulletins [95] for Android, Apple security updates [96] for iOS, Managing Devices & 1900 
Corporate Data on iOS [97], and Android Security Updates [98] for Android-based Samsung devices. 1901 

E.1.4.3 Sources of Impacts 1902 

This risk assessment identified the scenario described in Section E.1.2 as the primary source of impact 1903 
determination information. The scenario identified the following systems as being critical to the 1904 
organization’s mission: 1905 

 Microsoft Active Directory domain 1906 

 Microsoft Exchange email server  1907 
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 timekeeping web application 1908 

 travel support web application 1909 

 corporately owned mobile devices 1910 

An example of a successful attack against a mobile device is one that could be used to glean the 1911 
credentials for the travel support web application and use them to penetrate the application server. 1912 
While Orvilia can absorb minimal downtime to the web application, the attacker could use this position 1913 
to gain a foothold in the Orvilia infrastructure to laterally move to more critical systems in the 1914 
environment, such as the email server. Compromise of the email server would have high impact, 1915 
possibly causing serious harm to the organization. 1916 

E.1.5 Task 1-5: Risk Assessment Risk Model and Analytic Approach Identification 1917 

Identify the risk model and analytic approach to be used in the risk assessment. 1918 

In this risk assessment, the analytic approach used qualitative (i.e., subjective) ratings of risk (i.e., very 1919 
low, low, moderate, high, and very high). The approach was primarily threat oriented, as described in 1920 
section E.1.6. 1921 

E.1.6 Task 2-1: Identify and Characterize Threat Sources of Concern 1922 

Identify and characterize threat sources of concern, including capability, intent, and targeting 1923 
characteristics for adversarial threats and range of effects for non-adversarial threats. 1924 

Orvilia examined NIST SP 800-30 Revision 1’s Table D-2: Taxonomy of Threat Sources [9] and identified 1925 
the following threat sources of concern: 1926 

Table E-1 Threat Sources of Concern 1927 

Identifier Threat Source Description Characteristic 

TS-1 Adversarial,  
Organization, 
Competitor 

Orvilia’s competitors seek to exploit 
dependence on cyber resources, specifically the 
data entrusted by its customers to increase 
market share. 

Capability, Intent, 
Targeting 

TS-2 Adversarial,  
Nation-State  

Nation-state actors stealing sensitive 
government data from unsecured devices and 
infrastructure 

Capability, Intent, 
Targeting 

 
Orvilia produced the following table as output of Task 2-1 to provide relevant inputs to the risk tables. It 1928 
identifies the threat sources identified in NIST SP 800-30 Revision 1 with the associated risk rating of 1929 
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capability, intent, and targeting score (using the previously mentioned five-point scale: very low, low, 1930 
moderate, high, and very high). 1931 

Orvilia’s assessment found that all threat events could be initiated by both threat sources 1932 
(Organization/Competitor and Nation-State). 1933 

Capability refers to the level of expertise of the malicious actor. Intent refers to the malicious actor’s 1934 
goal. Targeting refers to the reconnaissance and selection methods performed by the malicious actor. 1935 

Table E-2 Threat Sources Qualitative Scale 1936 

Identifier Threat Events Relevant to 
Threat Sources  

In Scope  Capability Intent Targeting 

TS-1 All threat events  
(Threat Events 1-12) 

Yes High High High 

TS-2 All threat events  
(Threat Events 1-12) 

Yes Very High Very High Very High 

 

E.1.7 Task 2-2: Identify Potential Threat Events 1937 

Identify potential threat events, relevance of the events, and the threat sources that could initiate the 1938 
events. 1939 

The threat events used for the example solution are described below. These threat events describe how 1940 
the mobile devices in Orvilia might be compromised by malicious activities. All of the threat events map 1941 
to both threat sources identified in Section E.1.6. 1942 

Orvilia examined the sample tables in NIST SP 800-30 Revision 1—Tables E-1, E-2, E-3, E-4, and E-5—and 1943 
analyzed the sources of mobile threats identified in Task 1-4. Using this process, Orvilia leadership 1944 
identified the following threat events. 1945 

E.1.7.1 Threat Event 1—Unauthorized Access to sensitive Information via a Malicious or 1946 
Privacy-Intrusive Application 1947 

A mobile application can attempt to collect and exfiltrate any information to which it has been granted 1948 
access. This includes any information generated during use of the application (e.g., user input), user-1949 
granted permissions (e.g., contacts, calendar, call logs, camera roll), and general device data available to 1950 
any application (e.g., International Mobile Equipment Identity, device make and model, serial number). 1951 
Further, if a malicious application exploits a vulnerability in other applications, the OS, or device 1952 
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firmware to achieve privilege escalation, it may gain unauthorized access to any data stored on or 1953 
otherwise accessible through the device. 1954 

E.1.7.2 Threat Event 2—Theft of credentials Through an SMS or Email Phishing Campaign 1955 

Malicious actors may create fraudulent websites that mimic the appearance and behavior of legitimate 1956 
ones and entice users to authenticate to them by distributing phishing messages over short message 1957 
service (SMS) or email. Effective use of social engineering techniques such as impersonating an authority 1958 
figure or creating a sense of urgency may compel users to forgo scrutiny of the message and proceed to 1959 
authenticate to the fraudulent website; it then captures and stores the user’s credentials before 1960 
(usually) forwarding them to the legitimate website to allay suspicion. 1961 

E.1.7.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or Email 1962 
Messages 1963 

Malicious actors may send users SMS or email messages that contain a uniform resource locator (URL) 1964 
where a malicious application is hosted. Generally, such messages are crafted using social engineering 1965 
techniques designed to dissuade recipients from scrutinizing the nature of the message, thereby 1966 
increasing the likelihood they access the URL by using their mobile device. If the URL is accessed, the 1967 
device will attempt to download and install the application. Effective use of social engineering by the 1968 
attacker will further compel an otherwise suspicious user to grant any trust required by the developer 1969 
and all permissions requested by the application. Granting the former facilitates installation of other 1970 
malicious applications by the same developer, and granting the latter increases the potential for the 1971 
application to do direct harm. 1972 

E.1.7.4 Threat Event 4—Confidentiality and Integrity Loss due to Exploitation of Known 1973 
Vulnerability in the OS or Firmware 1974 

When malware successfully exploits a code execution vulnerability in the mobile OS or device drivers, 1975 
the delivered code generally executes with elevated privileges and issues commands in the context of 1976 
the root user or the OS kernel. This may be enough for some to accomplish their goal, but advanced 1977 
malicious actors will usually attempt to install additional malicious tools and to establish a persistent 1978 
presence. If successful, the attacker will be able to launch further attacks against the user, the device, or 1979 
any other systems to which the device connects. As a result, any data stored on, generated by, or 1980 
accessible to the device at that time—or in the future—may be compromised. 1981 

E.1.7.5 Threat Event 5—Violation of Privacy via Misuse of Device Sensors 1982 

Malicious actors with access (authorized or unauthorized) to device sensors (microphone, camera, 1983 
gyroscope, Global Positioning System receiver, and radios) can use them to conduct surveillance. It may 1984 
be directed at the user, as when tracking the device location, or it may be applied more generally, as 1985 
when recording any nearby sounds. Captured sensor data, such as a recording of an executive meeting, 1986 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 90 

may be immediately useful to a malicious actor. Alternatively, the data may be analyzed in isolation or in 1987 
combination with other data to yield sensitive information. For example, audio recordings of on-device 1988 
or proximate activity can be used to probabilistically determine user inputs to touchscreens and 1989 
keyboards—essentially turning the device into a remote keylogger. 1990 

E.1.7.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network 1991 
Communications via Installation of Malicious EMM/MDM, Network, VPN Profiles, 1992 
or Certificates 1993 

Malicious actors who successfully install an EMM/mobile device management (MDM), network, or 1994 
virtual private network (VPN) profile or certificate onto a device will gain a measure of additional control 1995 
over the device or its communications. Presence of an EMM/MDM profile will allow an attacker to 1996 
misuse existing OS application programming interfaces to send the device a wide variety of commands. 1997 
This may allow a malicious actor to obtain device information, install or restrict applications, or remotely 1998 
locate, lock, or wipe the device. Malicious network profiles may allow a malicious actor to automatically 1999 
compel the device to connect to access points under their control to achieve a man-in-the-middle attack 2000 
on all outbound connections. Alternatively, VPN profiles assist in the undetected exfiltration of sensitive 2001 
data by encrypting it, thus hiding it from network scanning tools. Additionally, malicious certificates may 2002 
allow the malicious actor to compel the device to automatically trust connections to malicious web 2003 
servers, wireless access points, or installation of applications under their control. 2004 

E.1.7.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via Eavesdropping 2005 
on Unencrypted Device Communications 2006 

Malicious actors can readily eavesdrop on communication over unencrypted, wireless networks such as 2007 
public Wi-Fi access points, which are commonly provided by coffee shops and hotels. While a device is 2008 
connected to such a network, an attacker would gain unauthorized access to any data sent or received 2009 
by the device for any session not already protected by encryption at either the transport or application 2010 
layers. Even if the transmitted data were encrypted, an attacker would be privy to the domains, internet 2011 
protocol addresses, and services (as indicated by port numbers) to which the device connects; such 2012 
information could be used in future watering hole attacks or man-in-the-middle attacks against the 2013 
device user. Additionally, visibility into network layer traffic enables a malicious actor to conduct side-2014 
channel attacks against its encrypted messages, which can still result in a loss of confidentiality. Further, 2015 
eavesdropping on unencrypted messages during a handshake to establish an encrypted session with 2016 
another host or endpoint may facilitate attacks that ultimately compromise the security of the session. 2017 

E.1.7.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or Brute-2018 
Forced Device Unlock Code 2019 

A malicious actor may be able to obtain a user’s device unlock code by direct observation, side-channel 2020 
attacks, or brute-force attacks. Both the first and second can be attempted with at least proximity to the 2021 
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device; only the third technique requires physical access. However, side-channel attacks that infer the 2022 
unlock code by detecting taps and swipes to the screen can be attempted by applications with access to 2023 
any peripherals that detect sound or motion (e.g., microphone, gyroscope, or accelerometer). Once the 2024 
device unlock code has been obtained, a malicious actor with physical access to the device will gain 2025 
immediate access to any data or functionality not already protected by additional access control 2026 
mechanisms. Additionally, if the user employs the device unlock code as a credential to any other 2027 
systems, the malicious actor may further gain unauthorized access to those systems. 2028 

E.1.7.9 Threat Event 9—Unauthorized Access to Backend Services via Authentication or 2029 
Credential Storage Vulnerabilities in Internally Developed Applications 2030 

If a malicious actor gains unauthorized access to a mobile device, the malicious actor also has access to 2031 
the data and applications on that mobile device. The mobile device may contain an organization’s in-2032 
house applications and can subsequently gain access to sensitive data or backend services. This could 2033 
result from weaknesses or vulnerabilities present in the authentication or credential storage 2034 
mechanisms implemented within an in-house application. 2035 

E.1.7.10 Threat Event 10—Unauthorized Access of Enterprise Resources from an 2036 
Unmanaged and Potentially Compromised Device 2037 

An employee who accesses enterprise resources from an unmanaged mobile device may expose the 2038 
enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do not benefit 2039 
from security mechanisms deployed by the organization such as mobile threat defense, mobile threat 2040 
intelligence, application vetting services, and mobile security policies. These unmanaged devices limit an 2041 
organization’s visibility into the state of a mobile device, including if the device is compromised by a 2042 
malicious actor. Therefore, users who violate security policies to gain unauthorized access to enterprise 2043 
resources from such devices risk providing malicious actors with access to sensitive organizational data, 2044 
services, and systems. 2045 

E.1.7.11  Threat Event 11—Loss of Organizational Data due to a Lost or Stolen Device 2046 

Due to the nature of the small form factor of mobile devices, they are easy to misplace or be stolen. A 2047 
malicious actor who gains physical custody of a device with inadequate security controls may be able to 2048 
gain unauthorized access to sensitive data or resources accessible to the device. 2049 

E.1.7.12  Threat Event 12—Loss of Confidentiality of Organizational Data due to Its 2050 
Unauthorized Storage to Non-Organizationally Managed Services 2051 

If employees violate data management policies by using unmanaged services to store sensitive 2052 
organizational data, the data will be placed outside organizational control, where the organization can 2053 
no longer protect its confidentiality, integrity, or availability. Malicious actors who compromise the 2054 
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unauthorized service account or any system hosting that account may gain unauthorized access to the 2055 
data. 2056 

Further, storage of sensitive data in an unmanaged service may subject the user or the organization to 2057 
prosecution for violation of any applicable laws (e.g., exportation of encryption) and may complicate 2058 
efforts by the organization to achieve remediation or recovery from any future losses, such as those 2059 
resulting from the public disclosure of trade secrets. 2060 

E.1.8 Task 2-3: Identify Vulnerabilities and Predisposing Conditions 2061 

Identify vulnerabilities and predisposing conditions that affect the likelihood that threat events of 2062 
concern result in adverse impacts. 2063 

Drawing on the scenario described in Section 3.2.1 of NIST SP 800-30 Revision 1, there existed 2064 
vulnerabilities and predisposing conditions that increased the likelihood that identified threat events 2065 
would result in adverse impacts for Orvilia. Each vulnerability or predisposing condition is listed in the 2066 
table below along with the corresponding threat events. 2067 

The methodology used to rate the level of pervasiveness was qualitative (i.e., subjective) and used a 2068 
five-point scale. 2069 

 Very High 2070 

 High 2071 

 Moderate 2072 

 Low 2073 

 Very Low 2074 

Table E-3 Identify Vulnerabilities and Predisposing Conditions 2075 

Vulnerability 
ID 

Vulnerability or Predisposing Condition Resulting 
Threat Events 

Pervasiveness 

VULN-1 Email and other enterprise resources can be 
accessed from anywhere, and only 
username/password authentication is 
required. 

TE-2, TE-10, TE-
11 

Very High 

VULN-2 Public Wi-Fi networks are regularly used by 
employees for remote connectivity from 
their corporate mobile devices. 

TE-7 Very High 
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Vulnerability 
ID 

Vulnerability or Predisposing Condition Resulting 
Threat Events 

Pervasiveness 

VULN-3 No EMM/MDM deployment exists to enforce 
and monitor compliance with security-
relevant policies on corporate mobile 
devices. 

TE-1, TE-3, TE-4, 
TE-5, TE-6, TE-7, 
TE-8, TE-9, TE-
11, TE-12 

Very High 

 
Note 1: Ratings of the level of pervasiveness were based on the qualitative scale found in Table F-5 of 2076 
Appendix F in NIST SP 800-30 Revision 1 [9]. 2077 

Note 2: Ratings of pervasiveness indicate that the vulnerabilities apply few (i.e., very low), some (i.e., 2078 
low), many (i.e., moderate), most (i.e., high), or all (i.e., very high) organizational missions/business 2079 
functions and processes, or information systems. 2080 

E.1.9 Task 2-4: Determine Likelihood of a Threat and the Likelihood of the Threat 2081 
Having Adverse Impacts 2082 

Determine the likelihood that threat events of concern result in adverse impacts, considering (i) the 2083 
characteristics of the threat sources that could initiate the events; (ii) the vulnerabilities/predisposing 2084 
conditions identified; and (iii) the organizational susceptibility reflecting the 2085 
safeguards/countermeasures planned or implemented to impede such events. 2086 

In the interest of brevity, the threat events of concern identified in Task 2-2 were limited to those 2087 
presumed to have a foreseeably high likelihood of occurrence. 2088 

The methodology used to identify the likelihood of threats of concern was qualitative (i.e., subjective) 2089 
and used the following five-point scale. 2090 

 Very High 2091 

 High 2092 

 Moderate 2093 

 Low 2094 

 Very Low 2095 
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Table E-4 Likelihood of Threat Events of Concern 2096 

Threat ID Likelihood of Threat 
Event Initiation 

Likelihood of Threat Event Resulting 
in Adverse Impacts 

Overall Likelihood 

TE-1 High Very High Very High 

TE-2 Very High High Very High 

TE-3 High High High 

TE-4 Moderate Very High High 

TE-5 High Very High Very High 

TE-6 Moderate High Moderate 

TE-7 High High High 

TE-8 Moderate High High 

TE-9 Moderate High Very High 

TE-10 High Very High Very High 

TE-11 Very High Very High Very High 

TE-12 High High High 

 
Note 1: For the Likelihood of Threat Event Initiation, the ratings translate as follows: Moderate = 2097 
malicious actor is somewhat likely to initiate; High = malicious actor is highly likely to initiate; Very high = 2098 
malicious actor is almost certain to initiate. 2099 

Note 2: For the Likelihood of Threat Event Resulting in Adverse Impacts, the ratings translate as follows: 2100 
Moderate = if the threat is initiated, it is somewhat likely to have adverse impacts; High = if the threat is 2101 
initiated, it is highly likely to have adverse impacts; Very high = if the threat is initiated, it is almost 2102 
certain to have adverse impacts. 2103 

Note 3: Overall likelihood was calculated based on the qualitative scale found in Table G-3 of Appendix 2104 
G in NIST SP 800-30 Revision 1 [9]. It is derived from both the Likelihood of Threat Event Initiation and 2105 
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Likelihood of Threat Event Resulting in Adverse Impacts. Because these scales are not true interval 2106 
scales, the combined overall ratings do not always reflect a strict mathematical average of the two 2107 
ratings. 2108 

E.1.10  Task 2-5: Determine the Extent of Adverse Impacts 2109 

Determine the adverse impacts from threat events of concern considering (i) the characteristics of the 2110 
threat sources that could initiate the events; (ii) the vulnerabilities/predisposing conditions identified; 2111 
and (iii) the susceptibility reflecting the safeguards/countermeasures planned or implemented to impede 2112 
such events. 2113 

Threat events with a high potential for adverse impacts were then identified in our specific scenario. 2114 

The methodology used to determine the extent of adverse impacts was qualitative (i.e., subjective) and 2115 
used the following five-point scale. 2116 

 Very High 2117 

 High 2118 

 Moderate 2119 

 Low 2120 

 Very Low 2121 

Table E-5 Potential Adverse Impacts 2122 

Threat 
ID 

Type of Impact Impact Affected Asset Maximum 
Impact 

TE-1 Harm to 
Operations, 
Assets, 
Individuals 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 

High 

TE-2 Harm to 
Operations, 
Other 
Organizations 

Inability, or limited ability, to perform 
missions/business functions in the future 

High 

TE-3 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 

High 
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Threat 
ID 

Type of Impact Impact Affected Asset Maximum 
Impact 

Damage to or loss of information systems or networks 

TE-4 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 

High 

TE-5 Harm to 
Operations, 
Assets, 
Individuals 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 
 
Loss of personally identifiable information 

High 

TE-6 Harm to 
Operations, 
Assets, Other 
Organizations 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 
 
Damage to reputation (and hence future or potential 
trust relationships) 

Very High 

TE-7 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 

High 

TE-8 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 

High 

TE-9 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 

High 
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Threat 
ID 

Type of Impact Impact Affected Asset Maximum 
Impact 

Damage to or loss of information systems or networks 

TE-10 Harm to 
Operations, 
Assets 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 

High 

TE-11 Harm to 
Operations, 
Assets, 
Individuals 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 
 
Damage to reputation (and hence future or potential 
trust relationships) 
 
Loss of personally identifiable information 

High 

TE-12 Harm to 
Operations, 
Assets, Other 
Organizations, 
Individuals 

Inability, or limited ability, to perform 
missions/business functions in the future 
 
Damage to or loss of information systems or networks 
 
Loss of personally identifiable information 
 
Damage to reputation (and hence future or potential 
trust relationships) 

High 

 
Note 1: Ratings of maximum impact were based on the qualitative scale found in Appendix H, Table H-3 2123 
in NIST SP 800-30 Revision 1 [9]. 2124 

Note 2: Ratings of maximum impact indicate the threat event could be expected to have negligible (i.e., 2125 
very low risk), limited (i.e., low), serious (i.e., moderate), severe or catastrophic (i.e., high), or multiple 2126 
severe or catastrophic effects (i.e., very high). 2127 

Note 3: For specific examples of types of impact, see Appendix H of NIST SP 800-30, Revision 1 [9]. 2128 
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E.1.11  Task 2-6: Determine Risk to Organization 2129 

Determine the risk to the organization from threat events of concern considering (i) the impact that 2130 
would result from the events; and (ii) the likelihood of the events occurring. 2131 

In the interest of brevity, the threat events of concern identified in Task 2-2 were limited to those 2132 
presumed to have a foreseeably high likelihood of occurrence and high potential for adverse impact in 2133 
Orvilia’s specific scenario.  2134 

Threat Source Characteristics 2135 

This table summarizes the risk assessment findings. 2136 

The methodology used to identify risk to organization was qualitative (i.e., subjective) and used the 2137 
following five-point scale. 2138 

 Very High 2139 

 High 2140 

 Moderate 2141 

 Low 2142 

 Very Low 2143 

Table E-6 Summary of Risk Assessment Findings 2144 

Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall 
Likelihood 

Level of 
Impact 

Risk 

TE-1: Unauthorized access to sensitive 
information via a malicious or privacy-
intrusive application 

VULN-3 Very High High High 

TE-2: Theft of credentials through an 
SMS or email phishing campaign 

VULN-1 Very High High High 

TE-3: Malicious applications installed 
via URLs in SMS or email messages 

VULN-3 High High High 

TE-4: Confidentiality and integrity loss 
due to exploitation of known 
vulnerability in the OS or firmware 

VULN-3 High High High 
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Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall 
Likelihood 

Level of 
Impact 

Risk 

TE-5: Violation of privacy via misuse of 
device sensors 

VULN-3 Very High High High 

TE-6: Compromise of the integrity of 
the device or its network 
communications via installation of 
malicious EMM/MDM, network, VPN 
profiles, or certificates 

VULN-3 Moderate Very High High 

TE-7: Loss of confidentiality of sensitive 
information via eavesdropping on 
unencrypted device communications 

VULN-2 High High High 

TE-8: Compromise of device integrity 
via observed, inferred, or brute-forced 
device unlock code 

VULN-3 High 
 

High High 

TE-9: Unauthorized access to backend 
services via authentication or 
credential storage vulnerabilities in 
internally developed applications 

VULN-3 Very High High High 

TE-10: Unauthorized access of 
enterprise resources from an 
unmanaged and potentially 
compromised device 

VULN-1 Very High High High 

TE-11: Loss of organizational data due 
to a lost or stolen device 

VULN-3 Very High High High 

TE-12: Loss of confidentiality of 
organizational data due to its 
unauthorized storage in non-
organizationally managed services 

VULN-3 High High High 

Note 1: Risk is stated in qualitative terms based on the scale in Table I-2 of Appendix I in NIST SP 800-30 2145 
Revision 1 [9].  2146 
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Note 2: The risk rating itself is derived from both the overall likelihood and level of impact using Table I-2147 
2 of Appendix I in NIST SP 800-30 Revision 1 [9]. Because these scales are not true interval scales, the 2148 
combined overall risk ratings from Table I-2 do not always reflect a strict mathematical average of these 2149 
two variables. This is demonstrated in the table above in which levels of Moderate weigh more heavily 2150 
than other ratings. 2151 

Note 3: Ratings of risk relate to the probability and level of adverse effect on organizational operations, 2152 
organizational assets, individuals, other organizations, or the nation. Per NIST SP 800-30 Revision 1, 2153 
adverse effects (and the associated risks) range from negligible (i.e., very low risk), limited (i.e., low), 2154 
serious (i.e., moderate), severe or catastrophic (i.e., high), to multiple severe or catastrophic effects (i.e., 2155 
very high).  2156 
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Appendix F Privacy Risk Assessment 2157 

This section describes the privacy risk assessment conducted on Orvilia’s enterprise security 2158 
architecture. To perform the privacy risk assessment, the National Institute of Standards and Technology 2159 
(NIST) Privacy Risk Assessment Methodology (PRAM) was used, a tool for analyzing, assessing, and 2160 
prioritizing privacy risks to help organizations determine how to respond and select appropriate 2161 
solutions. The PRAM can also serve as a useful communication tool to convey privacy risks within an 2162 
organization. A blank version of the PRAM is available for download on NIST’s website [43]. 2163 

The PRAM uses the privacy risk model and privacy engineering objectives described in NIST Internal 2164 
Report 8062, An Introduction to Privacy Engineering and Risk Management in Federal Systems [44], to 2165 
analyze potential problematic data actions. Data actions are any system operations that process 2166 
personally identifiable information (PII). Processing can include collection, retention, logging, analysis, 2167 
generation, transformation or merging, disclosure, transfer, and disposal of PII. A problematic data 2168 
action is one that could cause an adverse effect for individuals. 2169 

The PRAM begins with framing the business objectives for the system, including the organizational 2170 
needs served, and framing organizational privacy governance, including identification of privacy-related 2171 
legal obligations and commitments to principles or other organizational policies. Next, create a data 2172 
map to illustrate the data actions performed by the system and the PII processed by the data actions. 2173 
These data actions, the PII being processed, and the contextual factors that describe the circumstances 2174 
surrounding the system’s processing of PII serve as inputs to the risk analysis. Then, assess the 2175 
probability that a data action will become problematic for individuals, assess the secondary costs 2176 
absorbed by the organization from a data action creating a problem for individuals, and use likelihood 2177 
and impact calculations to determine the total estimated risk per data action. Finally, list potential 2178 
mitigating technical and policy controls for the identified risks. The output from the PRAM activities 2179 
resulted in the information contained in Figure F-1.2180 
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Figure F-1 PRAM Data Map for Orvilia’s Enterprise Security Architecture 2181 
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As an output of the Orvilia PRAM, we identified three broad data actions with the potential to create 2182 
problems for individuals and relevant mitigations. Some mitigations listed under a particular data action 2183 
may provide privacy benefits to individuals beyond the scope of that data action. We also identified 2184 
overarching training and support controls that can help mitigate risks associated with all three of these 2185 
data actions. 2186 

While a security information and event management (SIEM) capability was not used in the reference 2187 
implementation, SIEMs, as discussed here, can be extremely beneficial in understanding the privacy 2188 
implications of the mobile device security data being logged, aggregated, and stored. 2189 

F.1 Data Action 1: Blocking Access and Wiping Devices 2190 

Devices that might pose a risk to the organization’s security posture can be blocked from accessing 2191 
enterprise resources or wiped and reset to factory setting defaults. Options are outlined in the following 2192 
sections for how this might be accomplished. 2193 

F.1.1 Potential Problem for Individuals 2194 

In a corporate-owned personally-enabled or bring your own device environment, employees are likely to 2195 
use their devices for both personal and work-related purposes. Therefore, in a system that features the 2196 
capability to wipe a device entirely, there could be an issue of employees losing personal data—and 2197 
employees may not even expect this possibility. A hypothetical example would be that an Orvilia 2198 
employee stores pictures of their newborn child on their mobile device, but these photos are lost when 2199 
their device is wiped after anomalous activity is detected. 2200 

F.1.2 Mitigations 2201 

Block access instead of wiping devices. 2202 

As an alternative to wiping data entirely, devices can be blocked from accessing enterprise resources, 2203 
for example, until an unapproved application is removed. This temporary blocking of access helps 2204 
ensure an individual will not lose personal data through a full wipe of a device. Taking this approach may 2205 
help bring the system’s capabilities into alignment with employees’ expectations about what can 2206 
happen to their devices, especially if they are unaware that devices can be wiped by administrators—2207 
providing for greater predictability in the system. 2208 

 Related mitigation: If this approach is taken, remediation processes should also be established 2209 
and communicated to employees. It is important to have a clear remediation process in place to 2210 
help employees regain access to resources on their devices at the appropriate time. It is equally 2211 
important to clearly convey this remediation process to employees. A remediation process 2212 
provides greater manageability in the system supporting employees’ ability to access resources. 2213 
If well communicated to employees, this also provides greater predictability, as employees will 2214 
know the steps involved in regaining access. 2215 
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Enable only selective wiping. 2216 

An alternative mitigation option for wiping is to specify the information to be wiped. Performing a 2217 
selective wipe is an option that only removes enterprise data from the device instead of being a full 2218 
factory reset. When configured this way, a wipe preserves employees’ personal configurations, 2219 
applications, and data while removing only the corporate configurations, applications, and data. Within 2220 
the example solution, this option is available for iOS devices. 2221 

Advise employees to back up the personal data maintained on devices. 2222 

If device wiping remains an option for administrators, encourage employees to perform regular backups 2223 
of their personal data to ensure it remains accessible in case of a wipe. 2224 

Limit staff with the ability to perform wipes or block access. 2225 

Limit staff with the ability to perform a wipe to only those with that responsibility by using role-based 2226 
access controls. This can help decrease the chances of accidentally removing employee data or blocking 2227 
access to resources. 2228 

F.2 Data Action 2: Employee Monitoring 2229 

The assessed infrastructure offers Orvilia a number of security capabilities, including reliance on 2230 
comprehensive monitoring capabilities, as noted in Section 4, Architecture. A significant amount of data 2231 
relating to employees, their devices, and their activities is collected and analyzed by multiple parties. 2232 

F.2.1 Potential Problem for Individuals 2233 

Employees may not be aware that their interactions with the system are being monitored and may not 2234 
want this monitoring to occur. Collection and analysis of information might enable Orvilia or other 2235 
parties to craft a narrative about an employee based on their interactions with the system, which could 2236 
lead to a power imbalance between Orvilia and the employee and loss of trust in the employer if the 2237 
employee discovers unanticipated monitoring. 2238 

F.2.2 Mitigations 2239 

Limit staff with ability to review data about employees and their devices. 2240 

This may be achieved using role-based access controls and by developing organizational policies to limit 2241 
how employee data can be used by staff with access to that data. Access can be limited to any 2242 
dashboard in the system containing data about employees and their devices but is most sensitive within 2243 
the mobile management dashboard, which is the hub for data about employees, their devices, and 2244 
threats. Minimizing access to sensitive information can enhance disassociability for employees using the 2245 
system. 2246 
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Limit or disable collection of specific data elements. 2247 

Conduct a system-specific privacy risk assessment to determine what elements can be limited. Consider 2248 
the configuration options for intrusive device features, such as location services, application inventory 2249 
collection, and location-based wake-ups. When collecting application inventory data, ensure that 2250 
information is gathered only from applications installed from the organization’s corporate application 2251 
store. While these administrative configurations may help provide for disassociability in the system, 2252 
there are also some opportunities for employees to limit the data collected. 2253 

Organizations may allow their employees to manage certain aspects and configurations of their device. 2254 
For example, employees may be able to disable location services in their device OS to prevent collection 2255 
of location data. Each of these controls contributes to reducing the number of attributes collected 2256 
regarding employees and their mobile devices. This reduction of collected data limits administrators’ 2257 
ability to associate information with specific individuals. 2258 

Dispose of PII. 2259 

Disposal of PII after an appropriate retention period can help reduce the risk of entities building profiles 2260 
of individuals. Disposal can also help bring the system’s data processing into alignment with employees’ 2261 
expectations and reduce the security risk associated with storing a large volume of PII. Disposal may be 2262 
particularly important for certain parties in the system that collect a larger volume of data or more 2263 
sensitive data. Disposal may be achieved using a combination of policy and technical controls. Parties in 2264 
the system may identify what happens to data, when, and how frequently. 2265 

F.3 Data Action 3: Data Sharing Across Parties 2266 

The infrastructure involves several parties that serve different purposes supporting Orvilia’s security 2267 
objectives. As a result, there is a significant flow of data about individuals and their devices occurring 2268 
across various parties. This includes sharing device and application data publicly and with third-party 2269 
analytics services, and includes sharing device status and usage with third-party analytics. 2270 

F.3.1 Potential Problems for Individuals 2271 

Data transmission about individuals and their devices among a variety of different parties could be 2272 
confusing for employees who might not know who has access to different information about them. If 2273 
administrators and co-workers know what colleague is conducting activity on his or her device that 2274 
triggers security alerts, it could cause employee embarrassment or emotional distress. This information 2275 
being revealed and associated with specific employees could also lead to stigmatization and even impact 2276 
Orvilia upper management in their decision-making regarding the employee. Further, clear text 2277 
transmissions could leave information vulnerable to attackers and the unanticipated release of 2278 
employee information. 2279 
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F.3.2 Mitigations 2280 

Use de-identification techniques. 2281 

De-identification of data helps decrease the chances that a third party is aggregating information 2282 
pertaining to one specific individual. While de-identification can help reduce privacy risk, there are 2283 
residual risks of reidentification. De-identification techniques may be applied to aggregated data before 2284 
sharing it with third-party analytics and publicly.  2285 

Use encryption. 2286 

Encryption decreases the chances of insecurity of information transmitted between parties. 2287 
Organizations should keep this in mind when considering how their enterprise data is transmitted and 2288 
stored. Mobile security systems share mobile device and application data with one another to optimize 2289 
efficiency and leverage data to perform security functions. This data may include application inventory 2290 
and employee name, email address, and phone number. Some systems offer multiple encryption 2291 
options that allow an organization to choose the encryption level necessary for the type of data that is 2292 
stored or transmitted.  2293 

Limit or disable access to data. 2294 

Conduct a system-specific privacy risk assessment to determine how access to data can be limited. Using 2295 
access controls to limit staff access to compliance information, especially when associated with 2296 
individuals, is important in preventing association of specific events with particular employees, which 2297 
could cause embarrassment. Some mobile security systems offer options for restricting the amount of 2298 
employee information that an administrator can access. These options may include hiding an 2299 
employee’s username and email address from the administrator console. Mobile application 2300 
information may also include employee information. Organizations should consider how their mobile 2301 
security systems hide application names, application binary analysis details, network names service set 2302 
identifier, and network analysis details from administrators. 2303 

Limit or disable collection of specific data elements. 2304 

Conduct a system-specific privacy risk assessment to determine what elements can be limited. 2305 
Identifying the employee information collected and determining what data elements are stored assist in 2306 
assessing the privacy risk of mobile security systems. Organizations should consider the mobile security 2307 
system’s ability to limit or reduce collection and storage of employee information, such as username, 2308 
email address, Global Positioning System location, and application data.  2309 

Use contracts to limit third-party data processing. 2310 

Establish contractual policies to limit data processing by third parties to only the processing that 2311 
facilitates delivery of security services, and no data processing beyond those explicit purposes. 2312 
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F.4 Mitigations Applicable Across Various Data Actions 2313 

Several mitigations provide benefits to employees pertaining to all three data actions identified in the 2314 
privacy risk assessment. These training and support mitigations can help Orvilia appropriately inform 2315 
employees about the system and its data processing. 2316 

Mitigations: 2317 

Provide training to employees about the system, parties involved, data processing, and administrative 2318 
actions that can be taken.  2319 

Training sessions can also highlight any privacy-preserving techniques used, such as for disclosures to 2320 
third parties. Training should include confirmation from employees that they understand the actions 2321 
that can be taken on their devices and the consequences—whether this involves blocking access or 2322 
wiping data. Employees may also be informed of data retention periods and when their data will be 2323 
disposed of. This can be more effective than simply sharing a privacy notice, which research has shown 2324 
that individuals are unlikely to read.  2325 

Provide ongoing notifications or reminders about system activity.  2326 

This can be achieved using push notifications, similar to those pictured in screenshots in Appendix G, 2327 
Threat Event 6, to help directly link administrative actions on devices to relevant threats and help 2328 
employees understand why an action is being taken. Notifications of changes to policies can help 2329 
increase system predictability by setting employee expectations appropriately with the way the system 2330 
processes data and the resulting actions.  2331 

Provide a support point of contact.  2332 

By providing employees with a point of contact in the organization who can respond to inquiries and 2333 
concerns regarding the system, employees can gain a better understanding of the system’s processing of 2334 
their data, which enhances predictability.  2335 
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Appendix G Threat Event Test Information 2336 

Detailed information and screenshots for some of this practice guide’s threat events and their testing 2337 
results are provided below. 2338 

G.1 Threat Event 1—Unauthorized Access to Sensitive Information via a 2339 

Malicious or Privacy-Intrusive Application 2340 

A part of Threat Event 1’s testing conclusions is shown in the following screen capture, where the 2341 
calendar access permission is being set to a risk score of 10. This allows MobileIron to automatically 2342 
apply the mobile threat protection high-risk label to the device and quarantine the device until the 2343 
privacy-intrusive application is removed. 2344 

Figure G-1 Setting a Custom Risk Level in Appthority 2345 

 

G.2 Threat Event 2—Theft of Credentials Through a Short Message Service 2346 

(SMS) or Email Phishing Campaign 2347 

Threat Event 2’s outcome is shown in the following screen capture, where PAN-DB is blocking a website 2348 
manually added to the malicious uniform resource locator (URL) database. 2349 
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Figure G-2 PAN-DB Blocked Website 2350 

 

G.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or 2351 

Email Messages 2352 

The following screenshots demonstrate enabling the Unknown Sources toggle and installing an 2353 
application through a link in an email message. 2354 
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Figure G-3 Lock Screen and Security 

 

Figure G-4 Phishing Email on Android 

 

    

Figure G-5 depicts the iOS test activity of receiving an email containing a link to an application from a 2355 
non-Apple App Store source. 2356 
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Figure G-5 Phishing Email on iOS 

 

Figure G-6 Untrusted Developer Warning 

 
 
After the application is installed, an untrusted developer notice appears as shown in Figure G-6 when 2357 
the user attempts to launch the application. 2358 

Figure G-7 shows Lookoutʼs ability to detect application signing certificates that have been trusted on a 2359 
device by the user to execute applications from sources other than Appleʼs App Store. 2360 
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Figure G-7 Application Signing Certificates 2361 

 

The following screenshots depict an attempt to install and run the unauthorized demo application on an 2362 
iOS device with the allowEnterpriseAppTrust policy restriction set to false by an Enterprise Mobility 2363 
Management (EMM) system. The user is not able to trust the developer when the policy restriction is 2364 
active, and hence the application will not run. 2365 
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Figure G-8 Restriction Setting Modification Screen 2366 

 

Figure G-9 Unable to Trust Developer 2367 

 

Android Device Testing 2368 

On Android devices, applications cannot be installed from sources other than the Google Play Store 2369 
unless the Unknown Sources setting is enabled in the deviceʼs security settings. Lookout can identify 2370 
when the Unknown Sources setting has been enabled and can communicate this information to 2371 
MobileIron to enable automated response actions, such as blocking device access to enterprise 2372 
resources until the situation is resolved. However, even if Unknown Sources is disabled, it is possible 2373 
that the setting was previously enabled and that unauthorized applications were installed at that time. 2374 

Figure G-10 shows Lookoutʼs ability to detect Android devices with Unknown Sources enabled. 2375 
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Figure G-10 Unknown Sources Detection 2376 

 

G.4 Threat Event 4—Confidentiality and Integrity Loss due to Exploitation 2377 

of Known Vulnerability in the Operating System or Firmware 2378 

Figure G-11 demonstrates Lookoutʼs ability to identify known vulnerabilities to which unpatched iOS and 2379 
Android devices are susceptible. Figure G-12 shows the patch level of the device. 2380 
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Figure G-11 Vulnerability Identification 2381 

 

Figure G-12 Patch Level Display 2382 

 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 116 

G.5 Threat Event 5—Violation of Privacy via Misuse of Device Sensors 2383 

The following screenshot depicts a Kryptowire application analysis report and the reported permissions 2384 
that this application was requesting. 2385 

Figure G-13 Kryptowire Analysis Report 2386 

 

G.6 Threat Event 6—Compromise of the Integrity of the Device or Its 2387 

Network Communications via Installation of Malicious EMM/Mobile 2388 

Device Management, Network, Virtual Private Network (VPN) Profiles, 2389 

or Certificates 2390 

The configuration profile used for configuring and testing Threat Event 6 is shown in Figure G-14. 2391 
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Figure G-14 Configuration Profile Example 2392 

 

Figure G-15 shows the email containing a malicious device configuration profile, and Figure G-16 shows 2393 
the warning displayed to the user when attempting to mark the malicious certificate as a trusted root. 2394 



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 118 

Figure G-15 Configuration Profile Phishing Email 

 

Figure G-16 Root Certificate Authority 
Enablement Warning 
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Figure G-17 Reversed Web Page 2395 

 

Browse to a hypertext transfer protocol secure (https) website from the mobile device and observe 2396 
whether the content has been reversed. Figure G-17 illustrates that the man-in-the-middle attack on a 2397 
Transport Layer Security-protected connection was successful. 2398 

The following screenshots demonstrate a man-in-the-middle attack on Android. 2399 
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Figure G-18 Certificate Phishing Email 

 

Figure G-19 Reversed Web Page 

 

Man-in-the-middle attack is detected by Lookout as shown in Figure G-20. 2400 
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Figure G-20 Network Attack Detected 2401 

 

G.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via 2402 

Eavesdropping on Unencrypted Device Communications 2403 

The following screenshot shows Appthority detecting an application sending data unencrypted. 2404 
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Figure G-21 Unencrypted Data Transfer 2405 

 

G.8 Threat Event 8—Compromise of Device Integrity via Observed, 2406 

Inferred, or Brute-Forced Device Unlock Code 2407 

MobileIron applies a policy to the devices to enforce a mandatory personal identification number and 2408 
device-wipe capability. Lookout reports devices that have the lock screen disabled. 2409 
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Figure G-22 Lock Screen Disabled Detection Notice 2410 

 

G.9 Threat Event 9—Unauthorized Access to Backend Services via 2411 

Authentication or Credential Storage Vulnerabilities in Internally 2412 

Developed Applications 2413 

As shown in Figure G-23, Appthority recognized that an application used hard-coded credentials. The 2414 
application’s use of hard-coded credentials could introduce vulnerabilities if the hard-coded credentials 2415 
were used for access to enterprise resources by unauthorized entities or for unauthorized actions. 2416 
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Figure G-23 Hard-Coded Credentials 2417 

 

G.10 Threat Event 10—Unauthorized Access of Enterprise Resources from 2418 

an Unmanaged and Potentially Compromised Device 2419 

The following two screenshots depict the inability to connect to the GlobalProtect VPN without the 2420 
proper client certificates, obtainable only through enrolling the device in MobileIron. 2421 
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Figure G-24 No Certificates Found on Android 

 

Figure G-25 No Certificates Found on iOS 

 

G.11Threat Event 11—Loss of Organizational Data due to a Lost or Stolen 2422 

Device 2423 

This screenshot depicts the final warning before Android factory-resets the device. In the event the 2424 
device was stolen, all corporate data would be removed from the device after one more failed unlock 2425 
attempt, thwarting the malicious actor’s goal. 2426 
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Figure G-26 Android Device Wipe Warning 2427 

 

G.12 Threat Event 12—Loss of Confidentiality of Organizational Data due 2428 

to Its Unauthorized Storage in Non-Organizationally Managed Services 2429 

The following screenshot shows one of the data loss prevention configuration options in MobileIron for 2430 
iOS. 2431 

Figure G-27 Disallowing Screenshots and Screen Recording 2432 

 2433 
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Appendix H Example Security Control Map 2434 

Table H-1 lists the technologies used in this project and provides a mapping among the generic 2435 
application term, the specific product used, the security control(s) the product provides, and a mapping 2436 
to the relevant National Institute of Standards and Technology (NIST) Special Publication (SP) 800-181, 2437 
National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce Framework Work Roles. 2438 
From left to right, the columns in the table describe: 2439 

 Specific product used: vendor product used by the example solution 2440 

 How the component functions in the build: capability the component provides in the example 2441 
solution. This is mapped to the general mobile technology component term. 2442 

 Applicable Cybersecurity Framework Subcategories: applicable Cybersecurity Framework 2443 
Subcategory(s) that the component is providing in the example solution 2444 

 Applicable NIST controls: the NIST SP 800-53 Revision 4 controls that the component provided 2445 
in the example solution 2446 

 ISO/IEC 27001:2013: International Organization for Standardization (ISO), International 2447 
Electrotechnical Commission (IEC) 27001:2013 mapping that the component provides in the 2448 
example solution 2449 

 CIS 6: Center for Internet Security (CIS) version 6 controls mapping that the component provides 2450 
in the example solution 2451 

 NIST SP 800-181, NICE Framework Work Roles: NICE Framework work role(s) that could be used 2452 
to manage this component’s use in the example solution. This mapping provides information on 2453 
the workforce members who would be engaged in this part of the example solution’s support. 2454 
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Table H-1 Example Solutionʼs Cybersecurity Standards and Best Practices Mapping 2455 

Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Mobile Threat Defense  

Appthority 
Cloud 
Service 

Mobile Threat 
Intelligence  

ID.RA-1—Asset 
vulnerabilities are 
identified and 
documented. 

Security 
Assessment and 
Authorization CA-
2, CA-7, CA-8 
Risk Assessment 
RA-3, RA-5  
System and 
Services 
Acquisition SA-5, 
SA-11  
System and 
Information 
Integrity SI-2, SI-
4, SI-5  

A.12.6.1 Control 
of Technical 
vulnerabilities 
A.18.2.3 
Technical 
Compliance 
Review 
  
  

CSC 4 
Continuous 
Vulnerability 
Assessment and 
Remediation 

SP-RSK-002 
Security Control 
Assessor 
 
SP-ARC-002 
Security Architect 
 
OM-ANA-001 
Systems Security 
Analyst 
 
PR-VAM-001 
Vulnerability 
Assessment Analyst 
 
PR-CDA-001 Cyber 
Defense Analyst 
 
OV-MGT-001 
Information Systems 
Security Manager 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

ID.RA-3 - Threats, 
both internal and 
external, are 
identified and 
documented. 

Risk Assessment 
RA-3 
System and  
Information  
Integrity SI-5 
Insider Threat  
Program PM-12, 
PM-16  

Clause 6.1.2 
Information 
Risk 
Assessment 
Process 

CSC 4 
Continuous 
Vulnerability 
Assessment and 
Remediation 

SP-RSK-002  
Security Control 
Assessor 
 
PR-CDA-001 
Cyber Defense 
Analyst  
 
OV-SPP-001  
Cyber Workforce 
Developer and 
Manager 
 
OV-TEA-001  
Cyber Instructional 
Curriculum 
Developer 
 
AN-TWA-001  
Threat/Warning 
Analyst  
 
PR-VAM-001  
Vulnerability 
Assessment Analyst  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

OV-MGT-001  
Information Systems 
Security Manager  

DE.CM-4—  
Malicious code is 
detected. 

System and  
Information  
Integrity SI-3, SI-8  

A.12.2.1 
Controls 
Against 
Malware 

CSC 4  
Continuous  
Vulnerability  
Assessment and 
Remediation 
CSC 7 Email and 
Web Browser 
Protections 
CSC 8 Malware 
Defenses 
CSC 12 Boundary 
Defense 

PR-VAM-001  
Vulnerability 
Assessment Analyst  
 
PR-CIR-001  
Cyber Defense 
Incident Responder  
 
PR-CDA-001  
Cyber Defense 
Analyst 
 
OM-NET-001  
Network Operations 
Specialist 

DE.CM-5—  
Unauthorized mobile 
code is detected. 

Mobile Code SC-
18, SC-44  
System and 
Information 
Integrity SI-4 

A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.12.6.2 
Restrictions on 

CSC 7 Email and 
Web Browser 
Protections 
CSC 8 Malware 
Defenses 

PR-CDA-001  
Cyber Defense 
Analyst  
 
OM-NET-001  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Software 
Installation 

Network Operations 
Specialist 

Kryptowire 
Cloud  
Service 

Application 
Vetting 

ID.RA-1—Asset 
vulnerabilities are 
identified and 
documented. 

Security 
Assessment and 
Authorization CA-
2, CA-7, CA-8 
Risk Assessment 
RA-3, RA-5  
System and 
Services 
Acquisition SA-5, 
SA-11  
System and 
Information 
Integrity SI-2, SI-
4, SI-5 

A.12.6.1 Control 
of Technical 
vulnerabilities 
A.18.2.3 
Technical 
Compliance 
Review 
  
  

CSC 4  
Continuous  
Vulnerability  
Assessment and 
Remediation 

SP-RSK-002  
Security Control 
Assessor 
 
SP-ARC-002  
Security Architect 
 
OM-ANA-001  
Systems Security 
Analyst 
 
PR-VAM-001  
Vulnerability 
Assessment Analyst  
 
PR-CDA-001  
Cyber Defense 
Analyst  
 
OV-MGT-001  
Information Systems 
Security Manager 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

 

ID.RA-3— Threats, 
both internal and 
external, are 
identified and 
documented. 

Risk Assessment 
RA-3 
System and  
Information  
Integrity SI-5 
Insider Threat  
Program PM-12, 
PM-16  

Clause 6.1.2  
Information 
Risk  
Assessment  
Process 

CSC 4  
Continuous  
Vulnerability  
Assessment and 
Remediation 

SP-RSK-002  
Security Control 
Assessor 
 
OM-ANA-001  
Systems Security 
Analyst  
 
OV-SPP-001  
Cyber Workforce 
Developer and 
Manager 
 
OV-TEA-001  
Cyber Instructional 
Curriculum 
Developer  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

AN-TWA-001  
Threat/Warning 
Analyst 
 
PR-VAM-001  
Vulnerability 
Assessment Analyst  
 
PR-CDA-001  
Cyber Defense 
Analyst  
 
OV-MGT-001  
Information Systems 
Security Manager 

DE.CM-4—Malicious 
code is detected. 

System and 
Information 
Integrity SI-3, SI-8  

A.12.2.1 
Controls 
Against 
Malware 

CSC 4 
Continuous 
Vulnerability 
Assessment and 
Remediation 
CSC 7 Email and 
Web Browser 
Protections 
CSC 8 Malware 
Defenses 
CSC 12 Boundary 
Defense 

PR-CIR-001  
Cyber Defense 
Incident Responder  
 
PR-CDA-001  
Cyber Defense 
Analyst 
 
PR-VAM-001  
Vulnerability 
Assessment Analyst 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

 
OM-NET-001  
Network Operations 
Specialist 

DE.CM-5—
Unauthorized mobile 
code is detected. 

Mobile Code SC-
18, SC-44  
System and 
Information 
Integrity SI-4 

A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.12.6.2 
Restrictions on 
Software 
Installation 

CSC 7 Email and 
Web Browser 
Protections 
CSC 8 Malware 
Defenses  

PR-CDA-001  
Cyber Defense 
Analyst 
 
OM-NET-001  
Network Operations 
Specialist 

Lookout 
Cloud  
Service/ 
Lookout 
Agent  
Version 
5.10.0.142 
(iOS), 
5.9.0.420 
(Android) 

Mobile Threat 
Defense/Endpoint 
Security 

PR.AC-5—Network 
integrity is protected 
(e.g., network 
segregation, network 
segmentation). 

Access Control 
AC-4, AC-10 
System and 
Communications 
Protection SC-7  
  
  
  

A.13.1.1 
Network 
Controls 
A.13.1.3 
Segregation in 
Networks 
A.13.2.1 
Information 
Transfer 
Policies and 
Procedures 
A.14.1.2 
Securing 

CSC 9 Imitation 
and Control of 
Network Ports, 
Protocols, and 
Services 
CSC 14 
Controlled 
Access Based on 
the Need to 
Know 
CSC 15 Wireless 
Access Control 

OM-ADM-001  
System 
Administrator  
 
OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
PR-CDA-001  
Cyber Defense 
Analyst 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Application 
Services on 
Public Networks 
A.14.1.3 
Protecting 
Application 
Services 
Transactions 

CSC 18 
Application 
Software 
Security 
  

OM-NET-001  
Network Operations 
Specialist 
 

PR.PT-4—
Communications and 
control networks are 
protected. 

Access Control 
AC-4, AC-17, AC-
18 
Contingency 
Planning Policy 
and Procedures 
CP-8  
System and 
Communications 
Protection SC-7, 
SC-19, SC-20, SC-
21, SC-22, SC-23, 
SC-24, SC-25, SC-
29, SC-32, SC-36, 
SC-37, SC-38, SC-
39, SC-40, SC-41, 
SC-43  

A.13.1.1 
Network 
Controls 
A.13.1.3 
Segregation in 
Networks 
A.14.1.3 
Protecting 
Application 
Services 
Transactions 
  

CSC 8 Malware 
Defenses  
CSC 12 Boundary 
Defense 
CSC 15 Wireless 
Access Control 
  

OM-ADM-001  
System 
Administrator  
 
OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002  
Communications 
Security (COMSEC) 
Manager  
 
SP-ARC-0001 
Enterprise Architect  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

  PR-CDA-001  
Cyber Defense 
Analyst  
 
SP-ARC-002  
Security Architect 
 
OM-NET-001  
Network Operations 
Specialist 

DE.CM-5—
Unauthorized mobile 
code is detected. 

Mobile Code SC-
18, SC-44  
System and 
Information 
Integrity SI-4 

A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.12.6.2 
Restrictions on 
Software 
Installation  

CSC 7 Email and 
Web Browser 
Protections 
CSC 8 Malware 
Defenses  

PR-CDA-001  
Cyber Defense 
Analyst 
 
OM-NET-001  
Network Operations 
Specialist 
 

Enterprise Mobility Management  

MobileIron 
Core  
Version 
9.7.0.1 

Enterprise 
Mobility  
Management 

ID.AM-1— Physical 
devices and systems 
within the 
organization are 
inventoried. 

Information 
System 
Component 
Inventory CM-8 

A.8.1.1 
Inventory of 
Assets 

CSC 1 Inventory 
of Authorized 
and 
Unauthorized 
Devices 

OM-STS-001  
Technical Support 
Specialist 
 
OM-ADM-001  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Information 
System Inventory 
PM-5  

A.8.1.2 
Ownership of 
Assets 

System 
Administrator 

PR.AC-1—Identities 
and credentials are 
issued, managed, 
verified, revoked, 
and audited for 
authorized devices, 
users, and processes. 

Access Control 
AC-1, AC-2  
Identification and 
Authentication 
IA-1, IA-2, IA-3, 
IA-4, IA-5, IA-6, 
IA-7, IA-8, IA-9, 
IA-10, IA-11 

A.9.2.1 User 
Registration 
and De-
Registration 
A.9.2.2 User 
Access 
Provisioning 
A.9.2.3 
Management of 
Privileged 
Access Rights 
A.9.2.4 
Management of 
Secret 
Authentication 
Information of 
Users 
A.9.2.6 Removal 
or Adjustment 
of Access Rights 
A.9.3.1 Use of 
Secret 
Authentication 
Information 

CSC 1 Inventory 
of Authorized 
and 
Unauthorized 
Devices 
CSC 5 Controlled 
Use of 
Administrative 
Privileges 
CSC 15 Wireless 
Access Control 
CSC 16 Account 
Monitoring and 
Control 
  

OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
OM-ADM-001  
System 
Administrator  
 
OV-MGT-002  
Communications 
Security (COMSEC) 
Manager 
 
OM-STS-001  
Technical Support 
Specialist  
 
OM-ANA-001  
Systems Security 
Analyst  
 
PR-CDA-001  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

A.9.4.2 Secure 
Log-On 
Procedures 
A.9.4.3 
Password 
Management 
System 

Cyber Defense 
Analyst  
 

PR.AC-6—Identities 
are proofed and 
bound to credentials 
and asserted in 
interactions. 

Access Control 
AC-1, AC-2, AC-3, 
AC-16, AC-19, AC-
24 
Identification and 
Authentication 
IA-1, IA-2, IA-4, 
IA-5, IA-8 
Physical and 
Environmental 
Protection PE-2  

A.7.1.1 
Screening 
A.9.2.1 User 
Registration 
and De-
Registration 

CSC 16 Account 
Monitoring and 
Control 

OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002  
Communications 
Security (COMSEC) 
Manager 
 
OM-ADM-001  
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Personnel 
Security PS-3  

System 
Administrator 

PR.IP-1—A baseline 
configuration of 
information 
technology/industrial 
control systems is 
created and 
maintained, 
incorporating 
security principles 
(e.g., concept of 
least functionality). 

Information 
System 
Component 
Inventory CM-2, 
CM-3, CM-4, CM-
5, CM-6, CM-7, 
CM-9 
System and 
Services 
Acquisition SA-10 

A.12.1.2 Change 
Management 
A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.12.6.2 
Restrictions on 
Software 
Installation 
A.14.2.2 System 
Change Control 
Procedures 
A.14.2.3 
Technical 
Review of 
Applications 
After Operating 

CSC 3 Secure 
Configurations 
for Hardware 
and Software on 
Mobile Devices, 
Laptops, 
Workstations, 
and Servers 
CSC 9 Limitation 
and Control of 
Network Ports, 
Protocols, and 
Services 
CSC 11 Secure 
Configurations 
for Network 
Devices Such as 
Firewalls, 
Routers, and 
Switches 

SP-ARC-002  
Security Architect  
 
OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
SP-SYS-001  
Information Systems 
Security Developer  
 
OM-ADM-001  
System 
Administrator  
 
PR-VAM-001  
Vulnerability 
Assessment Analyst 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Platform 
Changes 
A.14.2.4 
Restrictions on 
Changes to 
Software 
Packages 

 
OM-NET-001  
Network Operations 
Specialist 
 
OV-MGT-001  
Information Systems 
Security Manager  
 
OM-STS-001  
Technical Support 
Specialist 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

MobileIron 
Agent  
Version 
11.0.1A 
(iOS), 
10.2.1.1.3R 
(Android)  

EMM/Endpoint 
Agent 

PR.DS-6—Integrity-
checking 
mechanisms are 
used to verify 
software, firmware, 
and information 
integrity. 

System and 
Communications 
Protection SC-1 
System and 
Information 
Integrity SI-7  
  
  
  

A.12.2.1 
Controls 
Against 
Malware 
A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.14.1.2 
Securing 
Application 
Services on 
Public Networks 
A.14.1.3 
Protecting 
Application 
Services 
Transactions 
A.14.2.4 
Restrictions on 
Changes to 
Software 
Packages 

CSC 2 Inventory 
of Authorized 
and 
Unauthorized 
Software 
CSC 3 Secure 
Configurations 
for Hardware 
and Software on 
Mobile Devices, 
Laptops, 
Workstations, 
and Servers 

 
OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
SP-ARC-0001  
Enterprise Architect 
 
OV-MGT-001  
Information Systems 
Security Manager 
 
OM-ADM-001  
System 
Administrator 
 
OM-STS-001  
Technical Support 
Specialist 

Trusted Execution Environment  



DRAFT 

 
NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 142 

Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

Qualcomm 
(Version is 
mobile  
device  
dependent) 

Trusted  
Execution  
Environment 

PR.DS-1— Data at 
rest is protected. 

Media 
Downgrading MP-
8 
System and 
Communications 
Protection SC-12, 
SC-28  

A.8.2.3 
Handling of 
Assets 

CSC 13 Data 
Protection 
CSC 14 
Controlled 
Access Based on 
the Need to 
Know 

OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
PR-INF-001  
Cyber Defense 
Infrastructure 
Support Specialist  
 
OV-LGA-002  
Privacy 
Officer/Privacy 
Compliance 
Manager  
 
OV-MGT-002 
COMSEC Manager 
 
OM-NET-001  
Network Operations 
Specialist 
 
OM-ANA-001  
Systems Security 
Analyst 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

PR.DS-6—Integrity-
checking 
mechanisms are 
used to verify 
software, firmware, 
and information 
integrity. 

System and 
Communications 
Protection SC-16 
System and 
Information 
Integrity SI-7 

A.12.2.1 
Controls 
Against 
Malware 
A.12.5.1 
Installation of 
Software on 
Operational 
Systems 
A.14.1.2 
Securing 
Application 
Services on 
Public Networks 
A.14.1.3 
Protecting 
Application 
Services 
Transactions 
A.14.2.4 
Restrictions on 
Changes to 
Software 
Packages 

CSC 2 Inventory 
of Authorized 
and 
Unauthorized 
Software 
CSC 3 Secure 
Configurations 
for Hardware 
and Software on 
Mobile 

OV-SPP-002  
Cyber Policy and 
Strategy Planner  
 
PR-CDA-001  
Cyber Defense 
Analyst  
 
SP-ARC-0001  
Enterprise Architect 
 
OV-MGT-001  
Information Systems 
Security Manager 
 
OM-STS-001  
Technical Support 
Specialist  
 
OM-ADM-001  
System 
Administrator 
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4  

Controls 

ISO/IEC 
27001:2013 CIS 6 

 
NIST SP 800-181 NICE 

Framework Work 
Roles 

PR.DS-8—Integrity-
checking 
mechanisms are 
used to verify 
hardware integrity. 

Developer 
Configuration 
Management SA-
10 
System and 
Information 
Integrity SI-7  

A.11.2.4 
Equipment 
Maintenance 

Not applicable 

OM-ADM-001  
System 
Administrator  
 
SP-ARC-0001  
Enterprise Architect 

DE.CM-4—Malicious 
code is detected. 

System and 
Information 
Integrity SI-3, SI-8  

A.12.2.1 
Controls 
Against 
Malware 

CSC 5 Controlled 
Use of 
Administrative 
Privileges 
CSC 7 Email and 
Web Browser 
Protections 
CSC 14 
Controlled 
Access Based on 
the Need to 
Know 
CSC 16 Account 
Monitoring and 
Control 

PR-CDA-001  
Cyber Defense 
Analyst  
 
PR-INF-001  
Cyber Defense 
Infrastructure 
Support Specialist 
 
PR-VAM-001  
Vulnerability 
Assessment Analyst  
 
OM-NET-001  
Network Operations 
Specialist  
 
PR-CDA-001  
Cyber Defense 
Analyst 
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Specific 
product 

used 

How the 
component 

functions in the 
build 

Applicable 
Cybersecurity 

Framework 
Version 1.1 

Subcategories 

Applicable NIST SP 
800-53 Revision 4

Controls

ISO/IEC 
27001:2013 CIS 6 

NIST SP 800-181 NICE 
Framework Work 

Roles 

Virtual Private Network 

Virtual Private 
Network 

PR.AC-3—Remote 
access is managed. 

Access Control 
AC-1, AC-17, AC-
19, AC-20 
System and 
Communications 
Protection SC-15 

A.6.2.1 Mobile
Device Policy
A.6.2.2
Teleworking
A.11.2.6
Security of 
Equipment and 
Assets Off-
Premises 
A.13.1.1
Network 
Controls 
A.13.2.1
Information
Transfer
Policies and
Procedures

CSC 12 Boundary 
Defense 

OV-SPP-002  
Cyber Policy and 
Strategy Planner 

OV-MGT-002  
Communications 
Security (COMSEC) 
Manager 

OM-NET-001  
Network Operations 
Specialist 

Palo Alto,
PA-220
Version
8.1.1
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Specific 
product 

used 

How the 
 component  

functions in the 
build 

Applicable  
Cybersecurity  

Framework  
Version 1.1 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 

and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 

academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 

public-private partnership enables the creation of practical cybersecurity solutions for specific 5 

industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 

Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 

Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 

NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 

solutions using commercially available technology. The NCCoE documents these example solutions in 10 

the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 

and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 

established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 

Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov. To learn more about NIST, visit 15 

https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 

challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 

adoption of standards-based approaches to cybersecurity. They show members of the information 20 

security community how to implement example solutions that help them align more easily with relevant 21 

standards and best practices, and provide users with the materials lists, configuration files, and other 22 

information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 

businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 

or mandatory practices, nor do they carry statutory authority. 26 

ABSTRACT 27 

Mobile devices provide access to workplace data and resources that are vital for organizations to 28 

accomplish their mission while providing employees the flexibility to perform their daily activities. 29 

Securing these devices is essential to the continuity of business operations.  30 

While mobile devices can increase organizations’ efficiency and employee productivity, they can also 31 

leave sensitive data vulnerable. Addressing such vulnerabilities requires mobile device management 32 

tools to help secure access to the network and resources. These tools are different from those required 33 

to secure the typical computer workstation.  34 
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To address the challenge of securing mobile devices while managing risks, the NCCoE at NIST built a 35 

reference architecture to show how various mobile security technologies can be integrated within an 36 

enterprise’s network.  37 

This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-based, 38 

commercially available products to help meet their mobile device security and privacy needs. 39 

KEYWORDS 40 

Bring your own device; BYOD; corporate-owned personally-enabled; COPE; mobile device management; 41 

mobile device security, on-premise. 42 
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1 Introduction 292 

The following volumes of this guide show information technology (IT) professionals and security 293 

engineers how we implemented this example solution. We cover all of the mobile device security 294 

products employed in this reference design. We do not re-create the product manufacturers’ 295 

documentation, which is presumed to be widely available. Rather, these volumes show how we 296 

incorporated the products together in our environment. 297 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 298 

for these products that are out of scope for this reference design. 299 

1.1 Practice Guide Structure 300 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 301 

standards-based reference design and provides users with the information they need to replicate 302 

addressing mobile device security (MDS) implementation challenges. This reference design is modular 303 

and can be deployed in whole or in part. 304 

This guide contains three volumes: 305 

▪ NIST SP 1800-21A: Executive Summary 306 

▪ NIST SP 1800-21B: Approach, Architecture, and Security Characteristics – what we built and why 307 

▪ NIST SP 1800-21C: How-To Guides – instructions for building the example solution (you are 308 
here) 309 

Depending on your role in your organization, you might use this guide in different ways: 310 

Business decision makers, including chief security and technology officers, will be interested in the 311 

Executive Summary, NIST SP 1800-21A, which describes the following topics: 312 

▪ challenges that enterprises face in securely deploying mobile devices within their organization 313 

▪ example solution built at the National Cybersecurity Center of Excellence (NCCoE) 314 

▪ benefits of adopting the example solution 315 

Technology or security program managers who are concerned with how to identify, understand, assess, 316 

and mitigate risk will be interested in NIST SP 1800-21B, which describes what we did and why. The 317 

following sections will be of particular interest: 318 

▪ Section 3.4, Risk Assessment, describes the risk analysis we performed. 319 

▪ Section 4.3, Security Control Map, discusses the security mappings of this example solution to 320 
cybersecurity standards and best practices. 321 
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You might share the Executive Summary, NIST SP 1800-21A, with your leadership team members to help 322 

them understand the importance of adopting standards-based solutions when addressing MDS 323 

implementation challenges. 324 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 325 

You can use this How-To portion of the guide, NIST SP 1800-21C, to replicate all or parts of the build 326 

created in our lab. This How-To portion of the guide provides specific product installation, configuration, 327 

and integration instructions for implementing the example solution. We do not recreate the product 328 

manufacturers’ documentation, which is generally widely available. Rather, we show how we 329 

incorporated the products together in our environment to create an example solution. 330 

This guide assumes that IT professionals have experience implementing security products within the 331 

enterprise. While we have used a suite of commercial products to address this challenge, this guide does 332 

not endorse these particular products. Your organization can adopt this solution or one that adheres to 333 

these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 334 

parts of this guide’s example solution for on-premises mobile device security management. Your 335 

organization’s security experts should identify the products that will best integrate with your existing 336 

tools and IT system infrastructure. We hope that you will seek products that are congruent with 337 

applicable standards and best practices. Section 3.6, Technologies, lists the products that we used and 338 

maps them to the cybersecurity controls provided by this reference solution. 339 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 340 

draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 341 

success stories will improve subsequent versions of this guide. Please contribute your thoughts to 342 

mobile-nccoe@nist.gov. 343 

1.2 Build Overview 344 

When a business is on the go, mobile devices can serve as a temporary workstation replacement. They 345 

provide convenience of use, portability, and functionality. However, in many ways, mobile devices are 346 

different from the common computer workstation, and alternative management tools are required to 347 

secure their interactions with the enterprise. To address this security challenge, the NCCoE worked with 348 

its Community of Interest and build team partners and developed a real-world scenario for mobile 349 

deployment within an enterprise. The scenario presents a range of security challenges that an enterprise 350 

may experience when deploying mobile devices. 351 

The lab environment used in developing this solution includes the architectural components, 352 

functionality, and standard best practices, which are described in Volume B. The build team partners 353 

provided the security technologies used to deploy the architecture components and functionality. The 354 

standard best practices are applied to the security technologies to ensure the appropriate security 355 

controls are put in place to meet the challenges presented in the devised scenario. 356 
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This section of the guide documents the build process and discusses the specific configurations used to 357 

develop a secure mobile deployment. 358 

Note: Android for Work has been re-branded as Android Enterprise. At the time of writing this 359 

document, it was named Android for Work. 360 

1.3 Typographic Conventions 361 

The following table presents typographic conventions used in this volume. 362 

Table 1-1 Typographic Conventions 363 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.4 Logical Architecture Summary 364 

The following graphic illustrates the main components of this example implementation and provides a 365 

simplified view of how they interact. 366 

https://www.nccoe.nist.gov/
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Figure 1-1 Logical Architecture Summary 367 

 

2 Product Installation Guides 368 

This section of the practice guide contains detailed instructions for installing and configuring key 369 

products used for the architecture illustrated below. 370 

In our lab environment, the example solution was logically separated by a virtual local area network 371 

(VLAN) wherein each VLAN represented a separate mock enterprise environment. The network 372 

perimeter for this example implementation was enforced by a Palo Alto Networks virtual private 373 

network (VPN)/firewall appliance. It maintains three zones: one each for the internet/wide area network 374 

(WAN), a demilitarized zone (DMZ), and the organizational local area network (LAN). 375 

2.1 Appthority Mobile Threat Detection 376 

Appthority contributed a test instance of its Mobile Threat Detection service. Contact Appthority 377 

(Symantec) (https://www.symantec.com/) to establish an instance for your organization. 378 

https://www.symantec.com/
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2.2 Kryptowire EMM+S 379 

Kryptowire contributed a test instance of its EMM+S application-vetting service. Contact Kryptowire 380 

(https://www.kryptowire.com/mobile-app-security/) to establish an instance for your organization. 381 

2.3 Lookout Mobile Endpoint Security 382 

Lookout contributed a test instance of its Mobile Endpoint Security (MES) service. Contact Lookout 383 

(https://www.lookout.com/products/mobile-endpoint-security) to establish an instance for your 384 

organization. 385 

2.4 MobileIron Core 386 

MobileIron Core is the central product in the MobileIron suite. The following sections describe the steps 387 
for installation, configuration, and integration with Active Directory (AD).  388 

2.4.1 Installation of MobileIron Core and Stand-Alone Sentry 389 

Follow the steps below to install MobileIron Core: 390 

1. Obtain a copy of the On-Premise Installation Guide for MobileIron Core, Sentry, and 391 

Enterprise Connector from the MobileIron support portal. 392 

2. Follow the MobileIron Core predeployment and installation steps in Chapter 1 of the On-393 

Premise Installation Guide for MobileIron Core, Sentry, and Enterprise Connector for the 394 

version of MobileIron being deployed in your environment. In our lab implementation, we 395 

deployed MobileIron Core 9.5.0.0 as a Virtual Core running on VMware 6.0. Post-396 

installation, we performed an upgrade to MobileIron Core 9.7.0.1 following guidance 397 

provided in CoreConnectorReleaseNotes9701_Rev12Apr2018. Direct installations to 398 

MobileIron Core 9.7.0.1 will experience slightly different results, as some added features in 399 

this version are not used with earlier versions of configuration files. 400 

2.4.2 General MobileIron Core Setup 401 

The following steps are necessary for mobile device administrators or users to register devices with 402 

MobileIron. 403 

1. Obtain a copy of MobileIron Core Device Management Guide for iOS Devices from the 404 

MobileIron support portal. 405 

2. Complete all instructions provided in Chapter 1, Setup Tasks. 406 

https://www.kryptowire.com/mobile-app-security/
https://www.lookout.com/products/mobile-endpoint-security
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2.4.3 Upgrade MobileIron Core 407 

The following steps were used to upgrade our instance of MobileIron Core from 9.5.0.0 to 9.7.0.1. Note 408 

there was no direct upgrade path between these two versions; our selected upgrade path was 9.5.0.0 > 409 

9.5.0.1 > 9.7.0.1. 410 

1. Obtain upgrade credentials from MobileIron Support. 411 

2. In MobileIron Core System Manager, navigate to Maintenance > Software Updates. 412 

3. In the Software repository configuration section: 413 

a. In the User Name field, enter the username provided by MobileIron Support. 414 

b. In the Password field, enter the password provided by MobileIron Support. 415 

c. In the Confirm Password field, reenter the password provided by MobileIron Support. 416 

d. Select Apply. 417 

Figure 2-1 MobileIron Repository Configuration 418 

 

4. In the Software Updates section: 419 

a. Select Check Updates; after a few seconds, the available upgrade path options will 420 

appear. 421 

b. Select the Core 9.5.0.1 status: Not Downloaded option. 422 
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c. Select Download Now. After a delay, the Software Download dialogue will appear. 423 

Figure 2-2 MobileIron Core Version 424 

 

5. In the Download Software dialogue, select OK. 425 
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Figure 2-3 MobileIron Download Status 426 

 

6. In the Software updates section: 427 

a. Select the Core 9.5.0.1 status: Downloaded option. 428 

b. Select the Validate Database Structure and Data option. 429 

c. Select Validate. 430 

Figure 2-4 Validating Database Data 431 

 

7. In the Confirm dialogue, select Yes to validate database structure and data. 432 
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Figure 2-5 Validating Database Data Confirmation 433 

 

8. In the Validate Update dialogue, select OK. 434 

Figure 2-6 Database Data Validation Initiation Confirmation 435 

 

9. In the Software updates section, select Stage for Install; the Download Updates dialogue 436 

will appear. 437 
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Figure 2-7 Database Data Validation Status 438 

 

10. In the Download Updates dialogue, select Reboot Now; a series of dialogues will appear. 439 

Figure 2-8 Software Updates Reboot Prompt 440 

 

11. In the Confirm dialogues: 441 

a. Select Yes to confirm reboot of the appliance. 442 
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Figure 2-9 Software Update Reboot Confirmation 443 

 

b. Select Yes to confirm saving the current configuration. 444 

Figure 2-10 Reboot Configuration Save Prompt 445 

 

12. The Upgrade Status website hosted by Core will automatically open. 446 

Figure 2-11 Upgrade Status 447 

 

13. Once the upgrade is complete, System Manager > Maintenance > Software Updates > 448 

Software Updates now shows the capability to upgrade to 9.7.0.1. 449 
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Figure 2-12 Ability to Upgrade to 9.7.0.1 450 

 

14. Repeat Steps 4b through 11 above, replacing 9.5.0.1 with 9.7.0.1 during Steps 4b and 6; 451 

this will complete the upgrade path from MobileIron Core 9.5.0.0 to 9.7.0.1. 452 

2.4.4 Integration with Microsoft Active Directory 453 

In our implementation, we chose to integrate MobileIron Core with Active Directory using lightweight 454 

directory access protocol (LDAP). This is optional. General instructions for this process are covered in the 455 

Configuring LDAP Servers section in Chapter 2 of On-Premise Installation Guide for MobileIron Core, 456 

Sentry, and Enterprise Connector. The configuration details used during our completion of selected steps 457 

(retaining the original numbering) from that guide are given below: 458 

1. From Step 4 in the MobileIron guide, in the New LDAP Server dialogue: 459 

a. Directory Connection: 460 
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Figure 2-13 LDAP Settings 461 

 

b. Directory Configuration—OUs: 462 

Figure 2-14 LDAP OUs 463 

 

c. Directory Configuration—Users:  464 
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Figure 2-15 LDAP User Configuration 465 

 

d. Directory Configuration—Groups:  466 

Figure 2-16 LDAP Group Configuration 467 
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e. LDAP Groups:  468 

i. As a preparatory step, we used Active Directory Users and Computers to create 469 

a new security group for mobile-authorized users on the Domain Controller for 470 

the govt.mds.local domain. In our example, this group is named Mobile Users. 471 

ii. In the search bar, enter the name of the LDAP group for mobile-authorized 472 

users. 473 

iii. Select the magnifying glass button; the group name should be added to the 474 

Available list. 475 

iv. In the Available list box: 476 

1) Select the Mobile Users list item. 477 

2) Select the right-arrow button; the Mobile Users list item should move to 478 

the Selected list box. 479 

v. In the Selected list: 480 

1) Select the default Users group list item. 481 

2) Select the left-arrow button; the Users list item should move to the 482 

Available list box. 483 

Figure 2-17 Selected LDAP Group 484 

 

f. Custom Settings: Custom settings were not specified. 485 

g. Advanced Options: Advanced options were configured as shown in Figure 2-18. 486 
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Figure 2-18 LDAP Advanced Options 487 

 

Note: In our lab environment, we did not enable stronger Quality of Protection or enable the Use of 488 

Client Transport Layer Security Certificate or Request Mutual Authentication features. However, we 489 

recommend that implementers consider using those additional mechanisms to secure communication 490 

with the LDAP server. 491 

2. From Steps 19 through 21 from the MobileIron guide, we tested that MobileIron can 492 

successfully query LDAP for Derived Personal Identity Verification Credential (DPC) Users. 493 

a. In the New LDAP Setting dialogue, click the Test button to open the LDAP Test dialogue. 494 

b. In the LDAP Test dialogue, enter a User ID for a member of the DPC Users group, then 495 

click the Submit button. A member of the Mobile Users group in our environment is 496 

gema.  497 
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Figure 2-19 Testing LDAP Configuration 498 

 

c. The LDAP Test dialogue indicates the query was successful:  499 

Figure 2-20 LDAP Test Result 500 
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2.4.5 Create a Mobile Users Label 501 

MobileIron uses labels to link policies and device configurations with users and mobile devices. Creating 502 

a unique label for each category of authorized mobile user allows mobile device administrators to apply 503 

a consistent set of controls applicable to users with a common mobile use case. Our limited usage 504 

scenario only required a single MobileIron label to be created. 505 

1. In the MobileIron Core Admin Portal, navigate to Devices & Users > Labels.  506 

2. Select Add Label. 507 

Figure 2-21 MobileIron Device Labels 508 

 

3. In the Name field, enter a unique name for this label (Mobile Users in this example). 509 

4. In the Description field, enter a meaningful description to help others identify its purpose. 510 

5. Under the Criteria section: 511 

a. In the blank rule: 512 

i. In the Field drop-down menu, select User > LDAP > Groups > Name. 513 

ii. In the Value drop-down menu, select the Active Directory group created to 514 

support mobile user policies (named Mobile User in this example). 515 

b. Select the plus sign icon to add a blank rule. 516 

c. In the newly created blank rule:  517 

i. In the Field drop-down menu, select Common > Platform. 518 

ii. In the Value drop-down menu, select Android. 519 
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Figure 2-22 Adding a Device Label 520 

 

d. The list of matching devices will appear below the specified criteria. 521 

e. Select Save. 522 

Figure 2-23 Device Label Matches 523 

 

6. Navigate to Devices & Users > Labels to confirm the label was successfully created. 524 
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Figure 2-24 MobileIron Label List 525 

 

2.5 Integration of Palo Alto Networks GlobalProtect with MobileIron 526 

The following steps detail how to integrate MobileIron Core, Microsoft Certificate Authority (CA), and 527 

Palo Alto Networks GlobalProtect to allow mobile users to authenticate to the GlobalProtect gateway  528 

using user-aware device certificates issued to mobile devices by Microsoft CA during enrollment with 529 

MobileIron Core. 530 

2.5.1 MobileIron Configuration 531 

The following steps create the MobileIron Core configurations necessary to support integration with 532 

Palo Alto GlobalProtect and Microsoft CA. 533 

2.5.1.1 Create Simple Certificate Enrollment Protocol (SCEP) Configuration 534 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Configurations. 535 

2. Select Add New > Certificate Enrollment > SCEP; the New SCEP Configuration Enrollment 536 

Setting dialogue will open. 537 

3. In the New SCEP Certificate Enrollment Setting dialogue: 538 

a. For the Name field, enter a unique name to identify this configuration. 539 

b. Enable the Device Certificate option. 540 

c. In the URL field, enter the URL where SCEP is hosted within your environment. 541 

d. In the CA-Identifier (ID) field, enter the subject name of the Microsoft CA that will issue 542 

the device certificates. 543 

e. In the Subject drop-down menu, select $DEVICE_IMEI$. 544 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 21 

Figure 2-25 MobileIron SCEP Configuration 545 

 

f. In the Fingerprint field, enter the fingerprint of the Microsoft CA that will issue the 546 

device certificates. 547 

g. For the Challenge Type drop-down menu, select Microsoft SCEP. 548 

h. Below the Subject Alternative Names list box, select Add; a new list item will appear. 549 

i. For the new list item: 550 

i. For the Type drop-down menu, select NT Principal Name. 551 

ii. For the Value drop-down menu, select $USER_UPN$. 552 

j. Select Issue Test Certificate; the Certificate dialogue should indicate success. 553 

k. In the Certificate dialogue, select OK. 554 
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Figure 2-26 Test SCEP Certificate 555 

 

4. Select Save. 556 
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Figure 2-27 Test SCEP Certificate Configuration 557 

 

2.5.1.2 Create Palo Alto Networks GlobalProtect Configuration 558 

The GlobalProtect configuration instructs the mobile client to connect to use the provisioned device 559 

certificate and to automatically connect to the correct VPN URL; mobile users will not need to manually 560 

configure the application. The following steps will create the GlobalProtect configuration. 561 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Configurations. 562 

2. Select Add New > VPN; the Add VPN Setting dialogue will appear. 563 

3. In the Add VPN Setting dialogue: 564 

a. In the Name field, enter a unique name to identify this VPN setting. 565 

b. In the Connection Type drop-down menu, select Palo Alto Networks GlobalProtect. 566 

c. In the Server field, enter the fully qualified domain name (FQDN) of your Palo Alto 567 

Networks appliance; our sample implementation uses vpn.govt.mdse.nccoe.org. 568 
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d. For the User Authentication drop-down menu, select certificate. 569 

e. For the Identity Certificate drop-down menu, select the SCEP enrollment profile created 570 

in the previous section. 571 

f. Select Save. 572 

Figure 2-28 MobileIron VPN Configuration 573 

 

2.5.2 Basic Palo Alto Networks Configuration 574 

During basic configuration, internet protocol (IP) addresses are assigned to the management interface, 575 
domain name system (DNS), and network time protocol (NTP). The management interface allows the 576 
administrator to configure and implement security rules through this interface. 577 
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2.5.2.1 Configure Management Interface 578 

The following steps will configure the Palo Alto Networks appliance management interface. 579 

1. In the Palo Alto Networks portal, navigate to Device > Setup > Interfaces. 580 

2. On the Interfaces tab, enable the Management option; the Management Interface Setting 581 

page will open. 582 

Figure 2-29 Palo Alto Networks Management Interface Enabled 583 

 

3. On the Management Interface Setting screen: 584 

a. In the IP Address field, enter the IP address for the Palo Alto Networks appliance. 585 

b. In the Netmask field, enter the netmask for the network. 586 

c. In the Default Gateway field, enter the IP address of the router that provides the 587 

appliance with access to the internet. 588 

d. Under Administrative Management Services: Enable the Hypertext Transfer Protocol 589 

(HTTP), Hypertext Transfer Protocol Secure (HTTPS), Secure Shell (SSH), and Ping 590 

options. 591 

e. Click OK. 592 
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Figure 2-30 Management Interface Configuration 593 

 

4. To verify the configuration, navigate to Palo Alto Networks Portal > Dashboard; the 594 

General Information section should reflect the applianceʼs network configuration. 595 
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Figure 2-31 Palo Alto Networks Firewall General Information 596 

 

2.5.2.2 Configure DNS and NTP 597 

1. In the Palo Alto Networks Portal, navigate to Device > Setup > Services. 598 

2. In the Services tab, select the settings icon. 599 
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Figure 2-32 Palo Alto Networks Services Configuration 600 

 

3. On the Services > Services tab: 601 

a. For the Primary DNS Server field, enter the primary DNS server IP address. 602 

b. For the Secondary DNS Server field, enter the secondary DNS server IP address, if 603 

applicable. 604 

4. Select the NTP tab. 605 
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Figure 2-33 DNS Configuration 606 

 

5. On the NTP tab: 607 

a. For the Primary NTP Server > NTP Server Address field, enter the IP address of the 608 

primary NTP server to use. 609 

b. For the Secondary NTP Server > NTP Server Address field, enter the IP address of the 610 

backup NTP server to use, if applicable. 611 

6. Select OK. 612 
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Figure 2-34 NTP Configuration 613 

 

2.5.3 Palo Alto Networks Interfaces and Zones Configuration 614 

Palo Alto Networks firewall model PA-220 has eight interfaces that can be configured as trusted (inside) 615 

or untrusted (outside) interfaces. This section describes creating a zone and assigning an interface to it. 616 

2.5.3.1 Create Ethernet Interfaces and Addresses 617 

Our example implementation uses three interfaces: 618 

▪ LAN: Orviliaʼs LAN, which hosts intranet web and mail services 619 

▪ DMZ: Orviliaʼs DMZ network subnet, which hosts MobileIron Core and MobileIron Sentry 620 

▪ WAN: provides access to the internet and is the inbound interface for secure sockets layer (SSL) 621 
VPN connections 622 

To create and configure Ethernet interfaces: 623 

1. Navigate to Palo Alto Networks Portal > Network > Ethernet > Interfaces > Ethernet. 624 

Figure 2-35 Ethernet Interfaces 625 
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2. In the Ethernet tab, select the name of the interface to configure; the Ethernet Interface 626 

dialogue will appear. 627 

3. In the Ethernet Interface dialogue: 628 

a. In the Comment field, enter a description for this interface. 629 

b. For the Interface Type drop-down menu, select Layer3. 630 

Figure 2-36 Ethernet Interface Configuration 631 

 

c. Select the IPv4 tab. 632 

d. On the IPv4 tab:  633 

i. In the IP list box, select Add; a blank list item will appear. 634 

ii. In the blank list item, select New Address; the Address dialogue will appear. 635 
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Figure 2-37 WAN Interface IPv4 Configuration 636 

 

iii. In the Address dialogue: 637 

1) For the Name field, enter a unique name to identify this address. 638 

2) For the Description field, enter a meaningful description of the purpose of 639 

this address. 640 

3) In the unnamed field following the Type drop-down menu, enter the IPv4 641 

address that this interface will use in Classless Inter-Domain Routing 642 

notation. This example uses 10.6.1.2/24 for the WAN interface in our lab 643 

environment. 644 

4) Select OK. 645 
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Figure 2-38 WAN Interface IP Address Configuration 646 

 

e. The address should now appear as an item in the IP list box; select OK; the Address 647 

dialogue will close. 648 

Figure 2-39 Completed WAN Interface Configuration 649 

 

4. Select OK. 650 

5. Repeat Steps 2 and 3 for each of the additional Ethernet/Layer3 interfaces. 651 
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2.5.3.2 Create Security Zones 652 

The PA Security Zone is a collection of single or multiple interfaces that have the same security rules. For 653 

this setup, four different zones have been configured: 654 

▪ Mobile_Lab_GOVT: inside (trusted) interface connecting to the government (GOVT) segment  655 

▪ Mobile_Lab_DMZ: inside (trusted) interface connecting to the DMZ segment 656 

▪ Mobile_Lab_WAN: outside (untrusted) interface to permit trusted inbound connections (e.g., 657 
Lookout cloud service) from the untrusted internet and allow internet access to on-premises 658 
devices 659 

▪ Mobile_Lab_SSLVPN: outside (untrusted) interface for VPN connections by trusted mobile 660 
devices originating from untrusted networks (e.g., public Wi-Fi) 661 

To configure each zone: 662 

1. Navigate to Palo Alto Networks Portal > Network > Zones. 663 

Figure 2-40 Security Zone List 664 

 665 

2. In the Zones pane, select Add; the Zones page will open. 666 

3. On the Zones page: 667 

a. For the Name field, provide a unique name for the zone. 668 

b. For the Type drop-down menu, select Layer 3. 669 

c. Under Interfaces, select Add; a blank drop-down menu will appear. 670 

d. In the drop-down menu, select the interface to assign to this zone; this example shows 671 

selection of ethernet 1/3, which is associated with the LAN interface. 672 
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e. Select OK. 673 

Figure 2-41 LAN Security Zone Configuration 674 

 

f. Repeat Step b for each zone. 675 

2.5.4 Configure Router 676 

Palo Alto Networks uses a virtual router to emulate physical connectivity between interfaces in different 677 

zones. To permit systems to reach systems in other zones, the following steps will create a virtual router 678 

and add interfaces to it. The router also sets which of these interfaces will act as the local gateway to 679 

the internet. 680 

1. In the Palo Alto Networks Portal, navigate to Network > Virtual Routers. 681 

2. Below the details pane, select Add; the Virtual Router form will open. 682 
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3. In the Virtual Router form, on the Router Settings tab: 683 

a. For the Name field, enter a unique name to identify this router. 684 

b. On the Router Settings > General tab: 685 

i. Under the Interfaces list box, select Add; a new list item will appear. 686 

ii. In the new list item drop-down menu, select an existing interface. 687 

iii. Repeat Steps 3a and 3b to add all existing interfaces to this router. 688 

4. Select the Static Routes tab. 689 

5. On the Static Routes > IPv4 tab: 690 

a. Below the list box, select Add; the Virtual Router - Static Route - IPv4 form will open. 691 

b. In the Virtual Router—Static Route—IPv4 form: 692 

i. For the Name field, enter a unique name to identify this route. 693 

ii. For the Destination field, enter 0.0.0.0/0. 694 

iii. For the Interface drop-down menu, select the interface that provides access to 695 

the internet. 696 

iv. For the Next Hop drop-down menu, select IP Address. 697 

v. In the field below Next Hop, enter the IP address of the gateway that provides 698 

access to the internet. 699 

vi. Select OK. 700 
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Figure 2-42 Virtual Router Configuration 701 

 

6. Select OK. 702 
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Figure 2-43 Virtual Router General Settings 703 

 

2.5.5 Configure Tunnel Interface 704 

The SSL VPN uses a tunnel interface to secure traffic from the external zone to the internal zone where 705 

organizational resources available to mobile users are maintained. To configure the tunnel interface: 706 

1. Navigate to Palo Alto Networks Portal > Network > Ethernet > Interfaces > Tunnel. 707 

2. Below the details pane, select Add; the Tunnel Interface form will open. 708 

3. In the Tunnel Interface form on the Config tab: 709 

a. In the Assign Interface To section: 710 

i. For the Virtual Router drop-down menu, select the virtual router created in the 711 

previous section. 712 

ii. For the Security Zone drop-down menu, select the security zone created for the 713 

SSL VPN. 714 

b. Select OK. 715 
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Figure 2-44 SSL VPN Tunnel Interface 716 

 

2.5.6 Configure Applications and Security Policies 717 

Security policies work similarly to firewall rules; they block or allow traffic between defined zones 718 

identified by a source, destination, and application(s) (contextually, Palo Alto Networks’ objects define 719 

network protocols and ports). Palo Alto Networks has built-in applications for a large number of 720 

standard and well-known protocols and ports (e.g., LDAP and Secure Shell), but we defined custom 721 

applications for MobileIron-specific traffic. 722 

2.5.6.1 Configure Applications 723 

The following steps will create an application: 724 

1. In the Palo Alto Networks Portal, navigate to Objects > Applications. 725 
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Figure 2-45 Application Categories 726 

 727 

2. On the Applications screen: 728 

3. Select Add; the Application form will open. 729 

4. On the Application > Configuration screen: 730 

a. In the General > Name field, provide a unique name to identify this application. 731 

b. In the General > Description field, enter a meaningful description of its purpose. 732 

c. For the Properties > Category drop-down menu, select a category appropriate to your 733 

environment; our sample implementation uses networking. 734 

d. For the Properties > Subcategory drop-down menu, select a subcategory appropriate to 735 

your environment; our sample implementation uses infrastructure. 736 

e. For the Properties > Technology drop-down menu, select a technology appropriate to 737 

your environment; our sample implementation uses client-server. 738 

5. Select the Advanced tab. 739 
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Figure 2-46 MobileIron Core Palo Alto Networks Application Configuration 740 

 741 

6. On the Application > Advanced screen: 742 

a. Select Defaults > Port. 743 

b. Under the Ports list box, select Add; a blank list item will appear. 744 

c. In the blank list item, enter the port number used by the application; this example uses 745 

9997. 746 

7. Select OK. 747 
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Figure 2-47 MobileIron Application Port Configuration 748 

 

8. Repeat Steps 2 through 7 with the following modifications to create an application for 749 

MobileIron Core system administration console: 750 

a. Configuration > General > Name is MobileIron8443. 751 

b. Configuration > Default > Category is business-systems. 752 

c. Configuration > Default > Subcategory is management. 753 

d. Advanced > Defaults > Ports > entry_1 is 8443. 754 

2.5.6.2 Configure Security Policies 755 

Security policies allow or explicitly deny communication within, between, or (externally) to or from Palo 756 

Alto Networks zones. For this sample implementation, several security policies were created to support 757 

communication by other components of the architecture. The first subsection covers the steps to create 758 

a given security policy. The second subsection provides a table illustrating the security policies we used; 759 

these policies would need to be adapted to host names and IP addresses specific to your network 760 

infrastructure. 761 
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2.5.6.2.1 Create Security Policies 762 
To create a security policy: 763 

1. In the Palo Alto Networks Portal, navigate to Policies > Security. 764 

2. Select Add; the Security Policy Rule form will open. 765 

3. In the Security Policy Rule form: 766 

a. In the Name field, enter a unique name for this security rule. 767 

b. For the Rule Type drop-down menu, select the scope of the rule. 768 

Figure 2-48 DMZ Access to MobileIron Firewall Rule Configuration 769 

 

4. Select the Source tab. 770 

5. On the Source tab: 771 

a. If the security rule applies to a specific source zone: 772 

i. Under the Source Zone list box, select Add; a new entry will appear in the list box. 773 

ii. For the new list item, select the source zone for this rule. 774 

b. If the rule applies to only specific source IP addresses: 775 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 44 

i. Under the Source Address list box, select Add; a new list item will appear. 776 

ii. For the new list item, select the source address for this rule. 777 

Figure 2-49 DMZ Access to MobileIron Security Rule Source Zone Configuration 778 

 

6. Select the Destination tab. 779 

7. On the Destination tab: 780 

a. If the security rule applies to a specific destination zone: 781 

i. Under the Destination Zone list box, select Add; a new destination list item will 782 

appear. 783 

ii. For the new Source Zone list item, select the destination zone for this rule. 784 

b. If the rule applies to only specific destination IP addresses:  785 

i. Under the Destination Address list box, select Add; a new list item will appear. 786 

ii. For the new list item, select the destination address for this rule. 787 
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Figure 2-50 DMZ Access to MobileIron Security Rule Destination Address Configuration 788 

 

8. Select the Application tab. 789 

9. On the Application tab: 790 

a. Under the Applications list box, select Add; a new list item will appear. 791 

b. For the new Applications list item, select the application representing the protocol and 792 

port combination of the traffic to control. 793 

c. Repeat Steps 9a and 9b for each application involving the same source and destination 794 

that would also have its traffic allowed or explicitly blocked (if otherwise allowed by a 795 

more permissive security rule). 796 
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Figure 2-51 DMZ Access to MobileIron Security Rule Application Protocol Configuration 797 

 

10. Select the Actions tab. 798 

11. On the Actions tab: Unless explicitly blocking traffic permitted by a more permissive 799 

security rule, ensure that the Action Setting > Action drop-down menu is set to Allow. 800 
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Figure 2-52 DMZ Access to MobileIron Security Rule Action Configuration 801 

 

12. Select OK. 802 

2.5.6.2.2 Implemented Security Policies 803 
The implemented security policies are provided in Table 2-1, Table 2-2, and Table 2-3. Configuration 804 

options that aren’t shown were left as their default values. 805 

Table 2-1 Implemented Security Policies 806 

Name Tags Type Source Zone Source Address 

DMZAccessVirtualIPCore none universal Mobile_lab_WAN any 

CoretoAppleSrvs none universal Mobile_Lab_DMZ MI_Core 

AdminAccessToMI none interzone Mobile_Lab_GOVT MDS.govt.admin 

AppthorityConnectorAccessToMI-
Core 

none interzone Mobile_Lab_GOVT govt.appthority 

MICoreObtainDeviceCERT none interzone Mobile_Lab_DMZ MI_Core 

MICoreAccessDNS none interzone Mobile_Lab_DMZ MI_Core 

MICoreRelaySMSNotifications none interzone Mobile_Lab_DMZ MI_Core 

MICoreSyncLDAP none interzone Mobile_Lab_DMZ MI_Core 
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Table 2-2 Implemented Security Policies 807 

Name 

Source 
User 

Source Host  
Information 
Protocol  
Profile 

Destination Zone Destination  
Address 

DMZAccessVirtualIPCore any any any 10.6.1.120 

CoretoAppleSrvs any any any 17.0.0.0/8 

AdminAccessToMI any any Mobile_Lab_DMZ MI_Core;MI_Sentry 
AppthorityConnectorAccessToMI-
Core 

any any Mobile_Lab_DMZ MI_Core 

MICoreObtainDeviceCERT any any Mobile_Lab_GOVT SCEP_server 

MICoreAccessDNS any any Mobile_Lab_GOVT DNS_Server 
MICoreRelaySMSNotifications any any Mobile_Lab_GOVT SMTP_Relay 

MICoreSyncLDAP any any Mobile_Lab_GOVT LDAP_Server 

 
Table 2-3 Implemented Security Policies 808 

Name Application Service Action Profile Options 

DMZAccessVirtualIPCore 
dns;ping;ssl;web
-browsing 

any allow none none 

CoretoAppleSrvs any any allow none none 

AdminAccessToMI 
AdminAccessMI;
ssh;ssl 

any allow none none 

AppthorityConnectorAccessToMI-
Core 

AdminAccessMI;
ssl;web-
browsing 

any allow none none 

MICoreObtainDeviceCERT 
scep;web-
browsing 

application-
default 

allow none none 

MICoreAccessDNS 
dns application-

default 
allow none none 

MICoreRelaySMSNotifications 
smtp application-

default 
allow none none 

MICoreSyncLDAP 
ldap application-

default 
allow none none 

 

2.5.7 Network Address Translation (NAT) 809 

To allow communication with external networks over the internet, the appliance also needs to be 810 

configured with NAT rules. To configure NAT: 811 
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1. In the Palo Alto Networks Portal, navigate to Policies > NAT. 812 

2. Below the details pane, select Add; the NAT Policy Rule form will open. 813 

3. In the NAT Policy Rule form, on the General tab: 814 

a. In the Name field, provide a unique name for this NAT policy rule. 815 

b. Ensure the NAT Type drop-down menu is set to ipv4. 816 

Figure 2-53 Outbound NAT Rule 817 

 

4. Select the Original Packet tab. 818 

5. On the Original Packet tab: 819 

a. Under the Source Zone list box, select Add; a new Source Zone list item will appear. 820 

b. For the new Source Zone list item, select the zone that represents your LAN subnet; in 821 

this sample implementation, that is Mobile_Lab_GOVT. 822 

c. Repeat Steps 5a and 5b to add the zone that represents your DMZ; in this sample 823 

implementation, that is Mobile_Lab_DMZ. 824 

d. Repeat Steps 5a and 5b to add the zone that represents your SSL VPN; in this sample 825 

implementation, that is Mobile_Lab_SSLVPN. 826 

e. For the Destination Zone drop-down menu, select the zone that represents the 827 

internet; in this sample implementation, that is Mobile_lab_WAN. 828 

f. For the Destination Interface, select the adapter that is physically connected to the 829 

same subnet as your internet gateway; in this sample implementation, that is 830 

ethernet1/1. 831 
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g. Under the Source Address list box, select Add; a new Source Address list item will 832 

appear. 833 

h. For the new Source Address list item, select the address that represents the subnet (IP 834 

address range) for the LAN. 835 

i. Repeat Steps 5f and 5g to add the address representing the DMZ subnet. 836 

j. Repeat Steps 5f and 5g to add the address representing the SSL VPN subnet. 837 

Figure 2-54 Outbound NAT Original Packet Configuration 838 

 839 

6. Select the Translated Packet tab. 840 

7. On the Translated Packet tab, under Source Address Translation: 841 

a. For the Translation Type drop-down menu, select Dynamic IP and Port. 842 

b. For the Address Type drop-down menu, select Interface Address. 843 

c. For the Interface drop-down menu, select the same interface selected in Step 5e. 844 

d. For the IP Address drop-down menu, select the IPv4 address on the same subnet as 845 

your internet gateway. 846 
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Figure 2-55 Outbound NAT Translated Packet Configuration 847 

 848 

8. Select OK. 849 

2.5.8 Configure SSL VPN 850 

The SSL VPN enables remote mobile device users to create an encrypted connection to the enterprise 851 

from unencrypted networks (e.g., public Wi-Fi hot spots). 852 

2.5.8.1 Configure End-User Authentication 853 

The following steps establish the integrations and configurations related to mobile user identification 854 

and authentication. 855 

2.5.8.1.1 Configured Server Profile 856 
The following steps integrate this appliance with Microsoft Active Directory Domain Services to manage 857 

mobile user permissions via AD groups and roles. 858 

1. In the Palo Alto Networks Portal, navigate to Devices > Server Profiles > LDAP. 859 

2. Below the details pane, select Add; the LDAP Server Profile form will open. 860 

3. In the LDAP Server Profile form: 861 

a. In the Profile Name field, enter a unique name to identify this profile. 862 

b. Under the Service List box, select Add; a new Server List item will appear. 863 

c. In the new Service List item: 864 

i. In the Name column, enter a name to identify the server. 865 

ii. In the LDAP Server column, enter the IP address of the LDAP server. 866 
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iii. The value in the Port column defaults to 389; change this if your LDAP server 867 

communicates over a different port number. 868 

iv. Repeat Steps 3ci through 3ciii for each LDAP server that you intend to use. 869 

d. Under Server Settings: 870 

i. In the Type drop-down menu, select active-directory. 871 

ii. In the Base DN drop-down menu, select the DN for your Active Directory domain 872 

users who will use the SSL VPN. 873 

iii. In the Bind DN field, enter the Active Directory domain user account that will 874 

authenticate to LDAP to perform queries. 875 

iv. In the Password field, enter the password for the Active Directory user account 876 

specified in the previous step. 877 

v. In the Confirm Password field, reenter the password entered in the previous step. 878 

4. Select OK. 879 

Figure 2-56 LDAP Profile 880 
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2.5.8.2 Configure Authentication Profile 881 

1. In the Palo Alto Networks Portal, navigate to Device > Authentication Profile.  882 

2. Under the details pane, select Add; the Authentication Profile form will open. 883 

3. In the Authentication Profile form: 884 

a. In the Name field, provide a unique name to identify this authentication profile. 885 

b. On the Authentication tab: 886 

i. For the Type drop-down menu, select LDAP. 887 

ii. For the Server Profile drop-down menu, select the name of the LDAP Server 888 

Profile created in the previous section. 889 

iii. For the Login Attribute field, enter userPrincipalName. 890 

iv. For the User Domain, enter the name of your enterprise domain; our sample 891 

implementation uses govt. 892 
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Figure 2-57 Authentication Profile 893 

 

c. Select the Advanced tab. 894 

d. On the Advanced tab: 895 

i. Under the Allow List box, select Add; this will create a new list item. 896 

ii. In the new list item, select the Active Directory group for your mobile users. 897 

iii. Repeat Steps 3di and 3dii for any additional groups that should authenticate to 898 

the SSL VPN. 899 

e. Select OK. 900 
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Figure 2-58 Advanced Authentication Profile Settings 901 

 

2.5.8.3 Configure User Identification 902 

1. In the Palo Alto Networks Portal, navigate to Device & User Identification. 903 

2. In the details pane, select the Group Mapping Settings tab. 904 

3. Below the details pane, select Add the Group Mapping form will open. 905 

4. In the Group Mapping form: 906 

a. In the Name field, enter a unique name to identify this group mapping. 907 

b. In the Server Profile tab: 908 
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i. For the Server Profile drop-down menu, select the LDAP Server Profile created 909 

previously. 910 

ii. For Domain Setting > User Domain, enter the name of your Active Directory 911 

domain; this sample implementation uses govt. 912 

Figure 2-59 LDAP Group Mapping 913 

 
c. Select the Group Includes List tab. 914 

d. On the Group Includes List tab: 915 

i. In the Available Groups list box, expand the Active Directory domain to reveal 916 

configured user groups. 917 

ii. For each Active Directory group to be included in this User Identification 918 

configuration: 919 

1) Select the Active Directory group. 920 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 57 

2) Select the plus icon to transfer the group to the Included Groups list box. 921 

Figure 2-60 LDAP Group Include List 922 

 
5. Select OK. 923 

2.5.8.4 Configure Authentication Policy Rule 924 

1. Navigate to Policies > Authentication. 925 

2. Click Add. 926 

3. Give the policy a name. In this implementation, Mobile_Lab_Auth_Rule was used. 927 

4. Click Source. 928 

5. Under Source Zone, click Add. Select the SSL VPN zone. 929 

6. Under Source Zone, click Add. Select the WAN zone. 930 
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Figure 2-61 Authentication Policy Source Zones 931 

 932 

7. Click Destination. 933 

8. Under Destination Zone, click Add. 934 

9. Select the LAN zone. 935 
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Figure 2-62 Authentication Policy Destination Zones 936 

 

10. Click Service/URL Category. 937 

11. Under service, click Add. 938 

12. Select service-http. 939 

13. Under service, click Add. 940 

14. Select service-https. 941 

15. Click Actions. 942 

16. Next to Authentication Enforcement, select default-web-form. 943 

17. Leave Timeout and Log Settings as their default values. 944 
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Figure 2-63 Authentication Profile Actions 945 

 

18. Click OK and commit the changes. 946 

2.5.9 Import Certificates 947 

Certificates need to be imported into the appliance to configure certificate profiles that will affect how 948 

they are used in supporting communication with other systems. In particular, device certificates issued 949 

to mobile devices will be used to identify and authenticate mobile users. 950 

Note: The certificate private keys must be password-protected to import them into the firewall. 951 

1. In the Palo Alto Networks Portal, navigate to Device > Certificate Management > 952 
Certificates. 953 

2. Under the details pane, select Import; the Import Certificate form will open. 954 

3. In the Import Certificate form: 955 

a. For the Certificate Type, select Local. 956 

b. For the Certificate Name field, enter a unique name to identify this certificate. 957 

c. Next to the Certificate File field, Select Browse... to specify the full path to the file 958 

containing the certificate. 959 

d. For the File Format drop-down menu, select the certificate encoding appropriate to the 960 

certificate file; this example assumes the certificate and private key are in separate files, 961 

and select PEM. Note: The certificate’s private key must be password-protected to 962 

import it into Palo Alto Networks appliances. 963 
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e. If the certificate identifies the Palo Alto Networks appliance: 964 

i. Enable the Import private key checkbox. 965 

ii. Next to Key File, select Browse... to specify the full path to the file containing the 966 

private key for the uploaded certificate. 967 

iii. For the Passphrase field, enter the pass phrase protecting the private key. 968 

iv. For the Confirm Passphrase field, re-enter the pass phrase protecting the private 969 

key. 970 

Figure 2-64 Import MobileIron Certificate 971 

 
f. Select OK. 972 

4. Repeat Step 3 for each certificate to import into the Palo Alto Networks appliance. This will 973 

include all certificates that the appliance will use to identify itself or authenticate to remote 974 

systems, all certificates in the chain of trust for each such certificate, and any chain-of-trust 975 

certificates supporting identity verification for remote systems to which this appliance will 976 
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require certificate-based identification and authentication. This sample implementation 977 

uses certificates for the following systems: 978 

▪ server certificate for this appliance issued by DigiCert 979 

▪ DigiCert root CA certificate 980 

▪ DigiCert subordinate CA certificate 981 

▪ Microsoft CA enterprise root certificate 982 

▪ Microsoft CA enterprise subordinate CA certificate 983 

2.5.10 Configure Certificate Profile 984 

1. In the Palo Alto Networks Portal, navigate to Device > Certificate Management > 985 

Certificate Profile. 986 

2. Under the details pane, select Add; the Certificate Profile form will open. 987 

3. In the Certificate Profile form: 988 

a. In the Name field, enter a unique name to identify this certificate profile. 989 

b. In the Username Field drop-down menu, select Subject Alt. 990 

c. Select the Principal Name option. 991 

d. In the User Domain field, enter the Active Directory domain name for your enterprise; 992 

this sample implementation uses govt. 993 

e. Under the CA Certificate list box, select Add; a secondary Certificate Profile form will 994 

appear. 995 

f. In the secondary Certificate Profile form, in the CA Certificate drop-down menu, select 996 

the Microsoft Active Directory Certificate Services root certificate uploaded in Section 997 

2.5.6. 998 

g. Select OK. 999 

h. Repeat Step 3f for each intermediary certificate in the trust chain between the root 1000 

certificate and the subordinate CA certificate that issues certificates to mobile devices. 1001 

i. Select OK. 1002 
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Figure 2-65 Internal Root Certificate Profile 1003 

 
4. Select OK. 1004 

Figure 2-66 Certificate Profile 1005 

 

2.5.11 Configure SSL/TLS Service Profile 1006 

The following steps will configure the SSL/TLS profile, which determines what certificates to trust when 1007 

mobile devices are connecting to the VPN and what certificate to use when establishing outbound 1008 

SSL/TLS connections. 1009 

1. In the Palo Alto Networks Portal, navigate to Device > Certificate Management > SSL/TLS 1010 

Service Profile. 1011 
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2. Below the details pane, select Add; the SSL/TLS Service Profile form will open. 1012 

3. In the SSL/TLS Service Profile form: 1013 

a. In the Name field, enter a unique name to identify this service profile. 1014 

b. For the Certificate drop-down menu, select the certificate to use for this SSL/TLS service 1015 

profile; our sample implementation uses a client certificate obtained from a Microsoft 1016 

enterprise CA via SCEP. 1017 

c. For the Min Version drop-down menu, select TLSv1.2. 1018 

d. Select OK. 1019 

Figure 2-67 SSL/TLS Service Profile 1020 

 
4. Repeat Step 3 to add an identical SSL/TLS service profile for this applianceʼs server 1021 

certificate issued through DigiCert. 1022 

2.5.12 URL Filtering Configuration 1023 

1. Navigate to Objects > Custom Objects > URL Category. 1024 

2. Click Add. 1025 

3. Give the category a name and description. 1026 

4. Add sites to be blocked. For this example, *.example.com was used. 1027 
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Figure 2-68 Custom URL Category 1028 

 

5. Click OK. 1029 

6. Navigate to Objects > Security Profiles > URL Filtering. 1030 

7. Check the box next to default and click Clone. 1031 

8. Select default from the window that appears. 1032 

9. Click OK. 1033 

10. Click the newly created profile, default-1. 1034 

11. Give the policy a meaningful name and description. 1035 

12. Scroll to the bottom of the list. The name of the created category will be last on the list. 1036 

13. Click the option below Site Access and next to your created URL category. 1037 

14. Set the Site Access option to block. 1038 
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Figure 2-69 URL Filtering Profile 1039 

 

15. Click OK. 1040 

16. Navigate to Policies > Security. 1041 

17. Click the default outbound policy for the internal network (not VPN). 1042 

18. Click Actions. 1043 

19. Next to Profile Type, select Profiles. 1044 

20. Next to URL Filtering, select the newly created profile. 1045 

21. Click OK. 1046 

22. Repeat Steps 18 through 21 for the SSL VPN outbound traffic. 1047 
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Figure 2-70 URL Filtering Security Policy 1048 

 

23. Commit the changes. 1049 

2.5.13  GlobalProtect Gateway and Portal Configuration 1050 

The SSL VPN configuration requires creation of both a GlobalProtect gateway and a GlobalProtect portal, 1051 

the latter of which could be used to manage VPN connections across multiple gateways. In this sample 1052 

implementation, only a single gateway and portal are configured. 1053 

2.5.13.1 Configure GlobalProtect Gateway 1054 

The GlobalProtect gateway provides remote users with secure access to internal resources based on 1055 

their Microsoft AD group. To configure the GlobalProtect gateway:  1056 

1. In the Palo Alto Networks Portal, navigate to Network > GlobalProtect > Gateways. 1057 

2. Below the details pane, select Add; the GlobalProtect Gateway Configuration form will 1058 

open. 1059 
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3. In the GlobalProtect Gateway Configuration form, on the General tab: 1060 

a. In the Name field, enter a unique name to identify this GlobalProtect Gateway. 1061 

b. Under Network Settings: 1062 

i. In the Interface drop-down menu, select the physical interface connected to the 1063 

subnet on which the internet gateway device is located. 1064 

ii. In the IPv4 Address drop-down menu, select the IP address associated with the 1065 

physical interface specified in the previous step. 1066 

Figure 2-71 General GlobalProtect Gateway Configuration 1067 

 
c. Select the Authentication tab. 1068 

d. In the Authentication tab: 1069 

i. For the Server Authentication > SSL/TLS Service Profile drop-down menu, select 1070 

the TLS/SSL profile associated with the publicly trusted server certificate for this 1071 

appliance. 1072 

ii. For the Client Authentication > Certificate Profile drop-down menu, select the 1073 

client TLS/SSL profile associated with the internally trusted client certificates 1074 

issued to mobile devices. 1075 
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Figure 2-72 GlobalProtect Authentication Configuration 1076 

 
e. Select the Agent tab. 1077 

f. On the Agent > Tunnel Settings tab: 1078 

i. Select the Tunnel Mode checkbox. 1079 

ii. Select the Enable IPSec checkbox to disable IPSec. 1080 

Figure 2-73 GlobalProtect Tunnel Configuration 1081 

 
g. Select the Agent > Client IP Pool tab. 1082 

h. On the Agent > Client IP Pool tab:  1083 

i. Below the IP Pool list box, select Add; a new list item will appear. 1084 

ii. For the new IP Pool list item, enter the network address for the IP address pool 1085 

from which connected devices will be allocated an IP address. 1086 
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Figure 2-74 VPN Client IP Pool 1087 

 
i. Select the Agent > Client Settings tab. 1088 

j. On the Agent > Client Settings tab: 1089 

i. Under the Client Settings list box, select Add; the Configs form will open. 1090 

Figure 2-75 VPN Client Settings 1091 

 
ii. In the Configs form on the Authorization Override tab, enter a unique name to 1092 

identify this client configuration. 1093 
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Figure 2-76 VPN Authentication Override Configuration 1094 

 
iii. Select the User/User Group tab. 1095 

iv. On the User/User Group tab: 1096 

1) Below the Source User list box, select Add; a new list item will appear. 1097 

2) In the Source User list item, select the Microsoft AD user group to grant 1098 

access to internal resources through this GlobalProtect gateway. 1099 

Figure 2-77 VPN User Group Configuration 1100 
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v. Select the Split Tunnel tab. 1101 

vi. On the Split Tunnel tab, on the Access Route tab: 1102 

1) Under the Include list box, select Add; a new list item will appear. 1103 

2) In the new Include list item, enter 0.0.0.0/0. This enforces full tunneling. 1104 

Figure 2-78 VPN Split Tunnel Configuration 1105 

 
vii. Select OK. 1106 

k. Select OK. 1107 

2.5.13.2 Configure GlobalProtect Portal 1108 

1. In the Palo Alto Networks Portal, navigate to Network > GlobalProtect > Portal. 1109 

2. Below the details pane, select Add; the GlobalProtect Portal Configuration form will open. 1110 

3. In the GlobalProtect Portal Configuration form, on the General tab: 1111 

a. In the Name field, enter a unique name to identify this GlobalProtect portal. 1112 
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b. In the Interface drop-down menu, select the physical interface connected to the subnet 1113 

on which the internet gateway device is located.  1114 

c. In the IP Address Type drop-down menu, select IPv4 Only. 1115 

Figure 2-79 GlobalProtect Portal Configuration 1116 

 
4. Select the Authentication tab. 1117 

5. In the Authentication tab: 1118 

a. For the Server Authentication > SSL/TLS Service Profile drop-down menu, select the 1119 

SSL/TLS service profile based on your third-party server certificate. 1120 

b. For the Certificate Profile drop-down menu, select the client TLS/SSL profile associated 1121 

with the internally trusted client certificates issued to mobile devices. 1122 

c. Click Add. 1123 

d. Enter a profile name. In this example implementation, Client Authentication was used. 1124 

e. For the Authentication Profile drop-down menu, select the previously created 1125 

authentication profile. 1126 

f. Click OK. 1127 
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Figure 2-80 GlobalProtect Portal SSL/TLS Configuration 1128 

 
6. Select the Agent tab. 1129 

7. On the Agent tab: 1130 

a. Below the Agent list box, select Add; the Configs form will open. 1131 

b. In the Configs form: 1132 

i. In the Authentication tab, below Components that Require Dynamic Passwords, 1133 

check the box next to Portal. 1134 

ii. In the External tab, under the External Gateways list box select Add; the External 1135 

Gateway form will open. 1136 

iii. In the External Gateway form: 1137 

1) In the Name field, enter a unique name to identify this external gateway. 1138 

2) For the Address option, enter the FQDN for this appliance; in this sample 1139 

implementation, the FQDN is vpn.govt.mdse.nccoe.org. 1140 

3) Below the Source Region list box, select Add; a new list item will appear. 1141 
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4) In the new Source Region list item, select Any. 1142 

5) Select the Manual checkbox. 1143 

6) Select OK. 1144 

Figure 2-81 GlobalProtect External Gateway Configuration 1145 

  
iv. Below the Trusted Root CA list box, select Add; a new list item will appear. 1146 

v. In the new Trusted Root CA list item, select your internal CA root certificate. 1147 

vi. Repeat Steps 7biii and 7biv to add each certificate in your internal or third-party 1148 

certificate trust chains used when mobile devices contact the GlobalProtect 1149 

portal. 1150 

c. Click App. Ensure that Connect Method is set to User-logon (Always On). 1151 
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Figure 2-82 GlobalProtect Portal Agent Configuration 1152 

 
d. Select OK. 1153 

2.5.14 Configure Automatic Threat and Application Updates 1154 

1. In the PAN-OS portal, navigate to Device > Dynamic Updates. 1155 

2. Click Check Now at the bottom of the page. 1156 

3. Under Applications and Threats, click Download next to the last item in the list, with the 1157 

latest Release Date. It will take a minute to download the updates. 1158 

4. When the download completes, click Done. 1159 

5. Click Install next to the downloaded update. 1160 

6. Click Continue Installation. 1161 

7. When installation completes, click Close. 1162 

8. Next to Schedule, click the link with the date and time. 1163 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 77 

Figure 2-83 Schedule Link 1164 

 

9. Select the desired recurrence. For this implementation, Weekly was used. 1165 

10. Select the desired day and time. For this implementation, Saturday at 23:45 was used. 1166 

11. Next to Action, select download-and-install. 1167 

Figure 2-84 Threat Update Schedule 1168 

 1169 

12. Click OK. 1170 

13. Commit the changes. 1171 

2.6 Integration of Kryptowire EMM+S with MobileIron 1172 

Kryptowireʼs application vetting service uses the MobileIron application programming interface (API) to 1173 

regularly pull current device application inventory information from MobileIron Core. Updated analysis 1174 

results are displayed in the Kryptowire portal. 1175 
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2.6.1 Add MobileIron API Account for Kryptowire 1176 

The following steps will create an administrative account that will grant Kryptowire the specific 1177 

permissions it requires within MobileIron. 1178 

1. In the MobileIron Admin Portal, navigate to Devices & Users > Users. 1179 

2. On the Users page: 1180 

a. Select Add > Add Local User; the Add New User dialogue will open. 1181 

Figure 2-85 MobileIron Users 1182 

 

b. In the Add New User dialogue: 1183 

i. In the User ID field, enter the user identity that the Kryptowire cloud will 1184 

authenticate under; our implementation uses a value of kryptowire. 1185 

ii. In the First Name field, enter a generic first name for Kryptowire. 1186 

iii. In the Last Name field, enter a generic last name for Kryptowire. 1187 

iv. In the Display Name field, optionally enter a displayed name for this user 1188 

account. 1189 

v. In the Password field, provide the password that the Kryptowire identity will use 1190 

to authenticate to MobileIron. 1191 

vi. In the Confirm Password field, enter the same password as in the preceding step. 1192 

vii. In the Email field, provide an email account for the Kryptowire identity; this could 1193 

be used in configuring automatic notifications and should be an account under 1194 

the control of your organization.  1195 

viii. Select Save 1196 
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Figure 2-86 Kryptowire API User Configuration 1197 

 

3. In the MobileIron Admin Portal, navigate to Admin > Admins. 1198 

4. On the Admins page: 1199 

a. Enable the account you created for Kryptowire during Step 2. 1200 

b. Select Actions > Assign to Space; this will open the Assign to Space dialogue for the 1201 

Kryptowire account. 1202 
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Figure 2-87 MobileIron User List 1203 

 1204 

c. In the Assign to Space dialogue: 1205 

i. In the Select Space drop-down menu, select Global. 1206 

Figure 2-88 Kryptowire API User Space Assignment 1207 

 

ii. Enable each of the following settings: 1208 

Admin Roles > Device Management > View device page, device details 

Admin Roles > Device Management > View dashboard 
Admin Roles > Privacy Control > View apps and ibooks in device details  

Admin Roles > Privacy Control > View device IP and MAC address 

Admin Roles > App Management > View app 

Admin Roles > App Management > View app inventory 

Other Roles > Common Services Provider (CSP) 

Other Roles > API 

iii. Select Save. 1209 
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2.6.2 Contact Kryptowire to Create Inbound Connection 1210 

Once the MobileIron API account has been created, contact Kryptowire customer support to integrate 1211 

your instance of MobileIron Core. Note that this will require creation of firewall rules that permit 1212 

inbound connections from IP addresses designated by Kryptowire to MobileIron Core on port 443. Once 1213 

the connection has been established, the Kryptowire portal will populate with information on devices 1214 

registered with MobileIron. The EMM (Enterprise Mobility Management) ID presented by Kryptowire 1215 

will be the same as the Universally Unique ID assigned to a device by MobileIron Core. 1216 

Figure 2-89 Kryptowire Device List 1217 

 

2.7 Integration of Lookout Mobile Endpoint Security with MobileIron 1218 

Lookoutʼs Mobile Endpoint Security cloud service uses the MobileIron API to pull mobile device details 1219 

and app inventory from MobileIron Core. Following analysis, Lookout uses the API to apply specific 1220 

labels to devices to categorize them by the severity of any issues detected. MobileIron can be 1221 

configured to automatically respond to the application of specific labels per built-in compliance actions. 1222 

2.7.1 Add MobileIron API Account for Lookout 1223 

The following steps will create an administrative account that will grant to Lookout the specific 1224 

permissions it requires within MobileIron. 1225 

1. In the MobileIron Admin Portal, navigate to Devices & Users > Users. 1226 

2. On the Users page: 1227 

a. Select Add > Add Local User; the Add New User dialogue will open. 1228 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 82 

Figure 2-90 MobileIron User List 1229 

 

b. In the Add New User dialogue: 1230 

i. In the User ID field, enter the user identity the Lookout cloud will authenticate 1231 

under. Our implementation uses a value of lookout. 1232 

ii. In the First Name field, enter a generic first name for Lookout. 1233 

iii. In the Last Name field, enter a generic last name for Lookout. 1234 

iv. In the Display Name field, optionally enter a displayed name for this user 1235 

account. 1236 

v. In the Password field, provide the password the Lookout identity will use to 1237 

authenticate to MobileIron. 1238 

vi. In the Confirm Password field, enter the same password as in the preceding step. 1239 

vii. In the Email field, provide an email account for the Lookout identity; since this 1240 

may be used for alerts, it should be an account under the control of your 1241 

organization.  1242 

viii. Select Save. 1243 
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Figure 2-91 MobileIron Lookout User Configuration 1244 

 

3. In the MobileIron Admin Portal, navigate to Admin. 1245 

4. On the Admin page: 1246 

a. Enable the account you created for Lookout during Step 2. 1247 

b. Select Actions > Assign to Space; this will open the Assign to Space dialogue for the 1248 

Lookout account. 1249 
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Figure 2-92 Lookout MobileIron Admin Account 1250 

 

c. In the Assign to Space dialogue: 1251 

i. In the Select Space drop-down menu, select Global. 1252 

Figure 2-93 Lookout Account Space Assignment 1253 

 

ii. Enable each of the following settings: 1254 

Admin Roles > Device Management > View device page, device details 
Admin Roles > Device Management > View dashboard 

Admin Roles > Label Management > View Label 

Admin Roles > Label Management > Manage Label 
Admin Roles > Privacy Control > View apps and ibooks in device details  

Admin Roles > Privacy Control > View device IP and MAC address 

Admin Roles > App Management > Distribute app 

Admin Roles > Logs and Event Management > View Audit logs 
Admin Roles > Logs and Event Management > View events 

Other Roles > CSP 

Other Roles > Connector 
Other Roles > API 

iii. Select Save. 1255 
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2.7.2 Add MobileIron Labels for Lookout 1256 

Lookout will dynamically apply MobileIron labels to protected devices to communicate information 1257 

about their current state. The following steps will create a group of Lookout-specific labels. 1258 

1. In the MobileIron Admin Portal, navigate to Devices & Users > Labels. 1259 

2. On the Labels page: 1260 

a. Select Add Label; the Add Label dialogue will appear. 1261 

Figure 2-94 MobileIron Label List 1262 

 
b. In the Add Label dialogue: 1263 

i. In the Name field, enter the name of the label. Note: future steps will use the 1264 

Label Names presented here but use of these names is optional. 1265 

ii. In the Description field, enter a brief description for this label. 1266 

iii. For the Type option, select Manual; this will hide all other form inputs. 1267 

iv. Select Save. 1268 
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Figure 2-95 MTP Low Risk Label Configuration 1269 

 

c. Complete Step 3 for each label in the following table:  

 

Label Name Purpose 

Lookout for Work Device enrollment 

MTP - Pending Lifecycle management: devices with 
Lookout not yet activated 

MTP - Secured Lifecycle management: devices with 
Lookout activated 

MTP - Threats Present Lifecycle management: devices with 
threats detected by Lookout 
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MTP - Deactivated Lifecycle management: devices with 
Lookout deactivated 

MTP - Low Risk Risk posture: devices with a low risk score 
in Lookout 

MTP - Moderate Risk Risk posture: devices with a moderate 
risk score in Lookout 

MTP - High Risk Risk posture: devices with a high risk 
score in Lookout 

 

Note: Administrators can choose to alter the label names to something more appropriate for their 1270 

environment. 1271 

2.7.3 Add Lookout for Work for Android to MobileIron App Catalog 1272 

The following steps will add the Lookout for Work app for Android to MobileIron. 1273 

1. In the MobileIron Admin Portal, navigate to Apps > App Catalog. 1274 

2. On the App Catalog page, select Add; this will start the workflow to add a new app to the 1275 

app catalog. 1276 

Figure 2-96 MobileIron App Catalog 1277 

 

3. On the App Catalog > Choose page: 1278 

a. Select Google Play; additional controls will be displayed. 1279 

b. In the Application Name field, enter Lookout for Work. 1280 

c. Select Search; search results will be displayed in the lower pane. 1281 
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d. In the list of search results, select the Lookout for Work app. 1282 

e. Select Next. 1283 

Figure 2-97 Adding Lookout for Work to the MobileIron App Catalog 1284 

 

4. On the App Catalog > Describe page: 1285 

a. In Category drop-down menu, optionally assign the app to a category as appropriate to 1286 

your MobileIron deployment strategy. 1287 

b. Select Next. 1288 
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Figure 2-98 Lookout for Work Application Configuration 1289 

 

5. On the App Catalog > App Configuration page: 1290 

a. In the Apps@Work Catalog section, Enable Feature this App in the Apps@Work 1291 

catalog. 1292 

Figure 2-99 Lookout for Work Application Configuration 1293 

 1294 

b. In the Android Enterprise (Android for Work [AFW]) section: 1295 
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i. Enable Install this app for Android enterprise; additional controls will be made 1296 

visible. 1297 

ii. Enable Auto Update this App. 1298 

iii. Ensure Silently Install is enabled. 1299 

c. Select Finish. 1300 

Figure 2-100 Lookout for Work AFW Configuration 1301 

 

6. The Lookout for Work app should now appear in the App Catalog with the AFW indicator. 1302 

2.7.4 Apply Labels to Lookout for Work for Android 1303 

1. On the App Catalog page: 1304 

a. Enable Lookout for Work. 1305 

b. Select Actions > Apply To Labels; the Apply To Labels dialogue will appear. 1306 
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Figure 2-101 Apply Lookout for Work to Android Devices 1307 

 

c. In the Apply To Labels dialogue: 1308 

i. Enable the Lookout for Work and Android labels, plus any other labels 1309 

appropriate to your organization's mobile security policies. 1310 

ii. Select Apply. 1311 
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Figure 2-102 Apply To Labels Dialogue 1312 

 

d. The Lookout for Work app should now appear with the Lookout for Work and Android 1313 

labels applied. 1314 
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Figure 2-103 Lookout for Work with Applied Labels 1315 

 

2.7.5 Add Lookout for Work app for iOS to MobileIron App Catalog 1316 

The following steps will add the Lookout for Work app for iOS to MobileIron, apply appropriate 1317 

MobileIron labels, and create and upload a configuration file for one-touch activation of the app. 1318 

2.7.5.1 Import Lookout for Work App 1319 

1. In the MobileIron Admin Portal, navigate to Apps > App Catalog. 1320 

2. On the App Catalog page, select Add; this will start the workflow to add a new app to the 1321 

app catalog. 1322 

Figure 2-104 MobileIron App Catalog 1323 

 

3. On the App Catalog > Choose page: 1324 
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a. Select iTunes; additional controls will be displayed. 1325 

b. In the Application Name field, enter Lookout for Work. 1326 

c. Select Search; search results will be displayed in the lower pane. 1327 

d. In the list of search results, select the Lookout for Work app. 1328 

e. Select Next.  1329 

Figure 2-105 Lookout for Work Selected From iTunes 1330 

 

4. On the App Catalog > Describe page: 1331 

a. In Category drop-down menu, optionally assign the app to a category as appropriate to 1332 

your MobileIron deployment strategy. 1333 

b. Select Next. 1334 
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Figure 2-106 Lookout for Work App Configuration 1335 

 

5. On the App Catalog > App Store page: 1336 

a. In the Apps@Work Catalog section: 1337 

i. Enable Allow conversion of app from unmanaged to managed (iOS 9 or later). 1338 

ii. Enable Feature this App in the Apps@Work catalog. 1339 

iii. Select Next. 1340 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 96 

Figure 2-107 Lookout for Work App Configuration 1341 

 

b. In the App Catalog > App Configuration section: 1342 

i. Enable Send installation request or send convert unmanaged to managed app 1343 

request (iOS 9 and later) on device registration or sign-in. 1344 

ii. Enable Advanced Settings > Automatically update app when new version is 1345 

available. 1346 

c. Select Finish. 1347 
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Figure 2-108 Lookout for Work Managed App Settings 1348 

 

6. The Lookout for Work app should now appear in the App Catalog with AFW indicator. 1349 

Figure 2-109 App Catalog With Lookout for Work 1350 

 

2.7.5.2 Apply MobileIron Labels to Lookout for Work App 1351 

1. On the App Catalog page: 1352 

a. Enable Lookout for Work. 1353 
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b. Select Actions > Apply To Labels; the Apply To Labels dialogue will appear. 1354 

Figure 2-110 Lookout for Work Selected 1355 

 

c. In the Apply To Labels dialogue: 1356 

i. Enable the Lookout for Work and iOS labels, plus any other labels appropriate to 1357 

your organization's mobile security policies. 1358 

ii. Select Apply. 1359 
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Figure 2-111 Apply To Labels Dialogue 1360 

 1361 

d. The Lookout for Work app should now appear with the Lookout for Work and iOS labels 1362 

applied. 1363 

Figure 2-112 App Catalog With Lookout for Work 1364 
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2.7.5.3 Create Managed App Configuration File for Lookout for Work 1365 

MobileIron can push a configuration file down to managed iOS devices to allow users easy activation of 1366 

Lookout for Work. The following steps will create and upload the necessary file.  1367 

1. Using a plain text editor, create the following text file by replacing the asterisks on line 13 1368 

with your organization's Global Enrollment Code. 1369 

 
<?xml version="1.0" encoding="UTF-8"?> 1370 
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" 1371 
"https://www.apple.com/DTDs/PropertyList-1.0.dtd"> 1372 
<plist version="1.0"> 1373 
  <dict> 1374 
    <key>MDM</key> 1375 
    <string>MOBILEIRON</string> 1376 
    <key>DEVICE_UDID</key> 1377 
    <string>$DEVICE_UDID$</string> 1378 
    <key>EMAIL</key> 1379 
    <string>$EMAIL$</string> 1380 
    <key>GLOBAL_ENROLLMENT_CODE</key> 1381 
    <string>*******</string> 1382 
  </dict> 1383 
</plist> 1384 

2. In the MobileIron Admin Portal, navigate to Policies & Configs > Configurations. 1385 

3. On the Configurations Page: 1386 

a. Select Add New > iOS and OS X > iOS Only > Managed App Config; the New Managed 1387 

App Config Setting dialogue will open. 1388 
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Figure 2-113 Importing Managed Application Configuration 1389 

 

b. In the Managed App Config Setting dialogue: 1390 

i. In the Name field, provide a name for this configuration; our implementation 1391 

used Activate Lookout. 1392 

ii. In the Description field, provide the purpose for this configuration. 1393 

iii. In the BundleId field, enter the bundle ID for Lookout at Work, which for our 1394 

version was com.lookout.work. 1395 

iv. Select Choose File... to upload the plist file created during Step 1. 1396 

v. Select Save. 1397 
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Figure 2-114 plist Import Configuration 1398 

 

2.7.5.4 Apply Labels to Managed App Configuration for Lookout for Work 1399 

The following steps will apply the managed app configuration created in the previous section to labels. 1400 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Configurations. 1401 

2. On the Configurations page: 1402 

a. Enable the Lookout Activation managed app configuration created in the previous 1403 

section. 1404 

b. Select Actions > Apply To Label; the Apply To Label dialogue will open. 1405 

Figure 2-115 Lookout Configuration Selected 1406 

 

c. In the Apply To Label dialogue: 1407 
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i. Enable the iOS and Lookout for Work labels. 1408 

ii. Select Apply. 1409 

Figure 2-116 Apply To Label Dialogue 1410 

 

d. The system should now reflect the Lookout for iOS and iOS labels have been applied to 1411 

the Activate Lookout configuration. 1412 
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Figure 2-117 Lookout Configuration With Labels 1413 

 

2.7.6 Add MDM Connector for MobileIron to Lookout MES 1414 

The following instructions will connect Lookout with your MobileIron instance and associate Lookout 1415 

device states with the MobileIron labels created previously. 1416 

1. Using the most-recent version of MDM Service IP Whitelisting available from the Lookout 1417 

support portal, configure your organization's firewalls to permit inbound connections from 1418 

the IP addresses provided on port 443 to your instance of MobileIron Core.  1419 

2. In the Lookout MES portal, navigate to Lookout > System > Connectors. 1420 

3. On the Connectors page: 1421 

a. Select Add Connector > MobileIron; this will open a new form. 1422 

Figure 2-118 Add Lookout Connector Display 1423 
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b. In the Connector Settings section of the form: 1424 

i. For the MobileIron URL field, enter the FQDN for your instance of MobileIron. In 1425 

our example implementation, the URL was mi-core.govt.mdse.nccoe.org.  1426 

ii. For the Username field, enter the User ID of the MobileIron admin account 1427 

created in 2.7.1. In our example implementation, the User ID is lookout. 1428 

iii. For the Password field, enter the password associated with that MobileIron 1429 

admin account. 1430 

iv. Select Create Connector; this will enable additional sections of the form. 1431 

Figure 2-119 Connector Settings 1432 

 

c. In the Enrollment Management section of the form:  1433 

i. Toggle Device Enrollment > Automatically drive Lookout for Work enrollment on 1434 

MobileIron managed devices to On.  1435 

ii. For the Device Enrollment > Use the following label to identify devices that 1436 

should have the Lookout for Work app activated drop-down menu, select the 1437 

Lookout for Work label. 1438 

iii. Toggle Device Enrollment > Automatically send activation emails to MobileIron 1439 

managed devices to On. 1440 
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iv. Select Save Changes. 1441 

Figure 2-120 Connector Enrollment Settings 1442 

 

d. In the State Sync section of the form:  1443 

i. Toggle State Sync > Synchronize Device Status to MobileIron to On. 1444 

ii. For each entry in the table below:  1445 

1) Toggle the control to On. 1446 

2) From the drop-down menu, select the MobileIron Label with the 1447 

associated Purpose from the table in Section 2.6.2 Add MobileIron Labels 1448 

for Lookout. We provide the Label Name we used for each Purpose in our 1449 

example implementation. 1450 

State Purpose Label Name 

Devices that have 
not activated 
Lookout yet 

Lifecycle management: 
devices with Lookout 
not yet activated 

MTP - Pending 
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Devices with 
Lookout activated 

Lifecycle management: 
devices with Lookout 
activated 

MTP - Secured 

Devices on which 
Lookout is 
deactivated 

Lifecycle management: 
devices with Lookout 
deactivated 

MTP - Deactivated 

Devices with any 
issues present 

Lifecycle management: 
devices with threats 
detected by Lookout 

MTP - Threats 
Detected 

Devices with Low 
Risk issues present 

Risk posture: devices 
with a low risk score in 
Lookout 

MTP - Low Risk 

Devices with 
Medium Risk issues 
present 

Risk posture: devices 
with a moderate risk 
score in Lookout 

MTP - Moderate 
Risk 

Devices with High 
Risk issues present 

Risk posture: devices 
with a high risk score in 
Lookout 

MTP - High Risk 

 
Note: Administrators can choose to alter the label names to something more appropriate for their 1451 

environment. 1452 

iii. Select Save Changes.  1453 
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Figure 2-121 Connector Sync Settings 1454 

 

2.7.7 Configure MobileIron Risk Response 1455 

The following steps will allow MobileIron to generate responses to various device states as assigned to 1456 

devices by Lookout (e.g. MTP - High Risk).  1457 

2.7.7.1 Add MobileIron App Control Rule 1458 

1. In the MobileIron Admin Portal, navigate to Apps > App Control. 1459 

2. Select Add; the Add App Control Rule dialogue will appear. 1460 

3. In the Add App Control Rule dialogue: 1461 

a. In the Name field, enter Threats Present Trigger. 1462 
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b. Of the Type options, select Required. 1463 

c. In the App Identifier/Name field enter app does not exist. 1464 

d. In the Device Platform drop-down menu, select All. 1465 

e. In the Comment field, optionally enter Forces non-compliant state. 1466 

f. Select Save. 1467 

Figure 2-122 MobileIron App Control Rule 1468 

 
4. The new app control rule should now appear on the Apps > App Control page. 1469 
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Figure 2-123 MobileIron App Control Rule 1470 

 

2.7.7.2 Add MobileIron Compliance Actions 1471 

A Compliance Action defines what actions MobileIron will take when an App Control policy, like the one 1472 

created in the previous section, is violated by a managed mobile device. The following steps will create 1473 

and configure an example Compliance Action in response to the MTP - High Risk App Control rule. Note 1474 

that a single Compliance Action can be associated with multiple App Control rules if the same response 1475 

would be configured for each. Otherwise, a new Compliance Action should be created.  1476 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Compliance Actions. 1477 

2. Select Add; the Add Compliance Action dialogue will open. 1478 

3. In the Add Compliance Action dialogue: 1479 

a. In the Name field, add a description of the compliance action; we recommend indicating 1480 

the kind of action taken. This example illustrates creating a compliance action that will 1481 

be associated with the MTP - High Risk label. 1482 

b. Select the Enforce Compliance Actions Locally on Devices check box. 1483 

c. Select the Send a compliance notification or alert to the user check box. 1484 

d. Select the Block email access and AppConnect apps check box. 1485 

e. Select the Quarantine the device check box. 1486 

f. Deselect the Remove All Configurations check box. 1487 

g. Select Save. 1488 
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Figure 2-124 MTP High Risk Compliance Action 1489 

 1490 

2.7.7.3 Create MobileIron Security Policy for Lookout MES 1491 

In addition to potentially defining other controls, such as password requirements, a Security Policy can 1492 

map a Compliance Action to an App Control rule, enabling MobileIron to execute the configured actions 1493 

whenever a device that applies the policy violates the App Control rule. The following steps will create a 1494 
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new Security Policy for Lookout MES High Risk devices using an existing policy as a baseline from which 1495 

to apply more stringent controls. 1496 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Policies. 1497 

2. On the Policies page: 1498 

a. Select the security policy to use as a baseline. 1499 

b. Select More Actions > Save As; this will open the New Security Policy dialogue. 1500 

Figure 2-125 Baseline Policy Selection 1501 

 1502 
 

c. In the New Security Policy dialogue: 1503 

i. In the Name field, rename the policy to MTP - High Risk. 1504 

ii. In the Priority drop-down menu, select the security policy this policy will be 1505 

prioritized in relation to; in this example, it is higher than the MTP Medium Risk 1506 

policy. Note: for ease of setting priority, it is recommended to add new security 1507 

policies in ascending order (lowest to highest priority). 1508 

Figure 2-126 MTP High Risk Policy 1509 

 1510 
 

iii. Under Access Control > For All Platforms section: 1511 
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1. For the when a device violates the following app control rules drop-down 1512 
menu, select the MTP - High Risk compliance action. 1513 

2. In the Available list of app control rules, highlight MTP High Risk Trigger. 1514 
3. Select the right arrow to move MTP High Risk Trigger item into the Enabled 1515 

List. 1516 
iv. Select Save. 1517 

Figure 2-127 Security Policy Trigger 1518 

 1519 

2.7.7.4 Apply Lookout MES Label to MobileIron Security Policy 1520 

The following steps will apply the MTP - High Risk label to the security policy created in the previous 1521 

section. As a result, once the Lookout cloud service applies the label to any device with a detected high-1522 

risk threat and such a device checks in with MobileIron, the security policy will automatically be applied 1523 

to it (provided it is of higher priority than the policy currently applied). In turn that will cause the MTP 1524 

High Risk Trigger App Control policy to be violated and the MTP - High Risk Compliance Action to be 1525 

taken. Once Lookout detects that the threat has been resolved, the Lookout service will remove the 1526 

MTP - High Risk label and on device check-in, MobileIron will then apply the next-lower-priority security 1527 

policy. 1528 

1. In the MobileIron Admin Portal, navigate to Policies & Configs > Policies. 1529 

2. On the Policies page: 1530 

a. Select the check box in the MTP High Risk security policy item. 1531 

b. Select More Actions > Apply to Label; the Apply to Label dialogue will open. 1532 
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Figure 2-128 Policy List 1533 

 1534 

c. In the Apply to Label dialogue: 1535 

i. Select the check box for the MTP - High Risk item. 1536 

ii. Select Apply. 1537 
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Figure 2-129 Apply To Label Dialogue 1538 

 1539 

2.8 Integration of Appthority Mobile Threat Detection with MobileIron 1540 

Appthority provides an on-premises connector for MobileIron that runs as a Docker container on RedHat 1541 

Linux. The connector uses the MobileIron API to obtain information on managed devices and their 1542 

installed apps, which is then synchronized with the cloud service instance to obtain app and device risk 1543 

scores, which are assigned to devices using custom attributes. The following sections provide the steps 1544 

to create a MobileIron API account and deploy and configure the Appthority connector. 1545 

2.8.1 Create MobileIron API Account for Appthority Connector 1546 

The following steps will create an administrative account that will grant Appthority the specific 1547 

permissions it requires within MobileIron. 1548 
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1. In the MobileIron Admin Portal, navigate to Devices & Users > Users. 1549 

2. On the Users page: 1550 

a. Select Add > Add Local User; the Add New User dialogue will open. 1551 

b. In the Add New User dialogue: 1552 

i. In the User ID field, enter the user identity the Appthority connector will 1553 

authenticate under. Our implementation uses a value of Appthority. 1554 

ii. In the First Name field, enter a generic first name for Appthority. 1555 

iii. In the Last Name field, enter a generic last name for Appthority. 1556 

iv. In the Display Name field, optionally enter a displayed name for this user 1557 

account. 1558 

v. In the Password field, provide the password the Appthority identity will use to 1559 

authenticate to MobileIron. 1560 

vi. In the Confirm Password field, enter the same password as in the preceding step. 1561 

vii. In the Email field, provide an email account for the Appthority identity; this 1562 

should be an account under the control of your organization.  1563 

viii. Select Save. 1564 
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Figure 2-130 Appthority User Settings 1565 

 1566 

1. In the MobileIron Admin Portal, navigate to Admin. 1567 

2. On the Admin page: 1568 

a. Enable the account you created for Appthority during Step 2. 1569 

b. Select Actions > Assign to Space; this will open the Assign to Space dialogue for the 1570 

Appthority account. 1571 



DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 118 

Figure 2-131 Appthority Connector User 1572 

 1573 

c. In the Assign to Space dialogue: 1574 

i. In the Select Space drop-down menu, select Global. 1575 

Figure 2-132 Appthority Connector Space Assignment 1576 

 1577 

ii. Enable each of the following settings: 1578 

Device Management > View device page, device details 

Privacy Control > View apps and ibooks in device details  

App Management > Apply and remove application label 

Other Roles > API 

iii. Select Save. 1579 

2.8.2 Deploy Appthority Connector Open Virtualization Appliance  1580 

One deployment option for the Appthority connector is a pre-built RedHat virtual machine distributed as 1581 

an Open Virtualization Appliance (OVA). We imported the OVA into our virtual lab environment 1582 

following guidance provided in Connector On-Premises: Virtual Machine Setup available from the 1583 

Appthority support portal: https://support.appthority.com/. 1584 

https://support.appthority.com/


DRAFT 

 
NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 119 

2.8.3 Run the Enterprise Mobility Management Connector Deployment Script 1585 

Once the Appthority docker container is running, the setup script will configure it to use the MobileIron 1586 
API account created previously. Detailed instructions on using the script are available on the Appthority 1587 
support portal at https://help-1588 
mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html. The first two steps ask for 1589 
Appthority-supplied credentials necessary to verify your subscription and to link the connector with the 1590 
correct instance of their cloud service. In the third step you will provide details to integrate with your 1591 
on-premises instance of MobileIron core. Our results from completing the third step are shown below. 1592 

1. Obtain a copy of Run the EMM Connector Deployment Script from the Appthority support 1593 

portal at https://help-1594 

mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html (authentication 1595 

to the portal is required). 1596 

2. Execute the script. The third step in the script involves providing settings to enable the 1597 

Appthority Connector to communicate with MobileIron Core. The results of our completion 1598 

of that step are provided below as a reference. 1599 

Figure 2-133 Appthority Connector CLI Configuration 1600 

 1601 
 1602 

3. Once the script has been completed, verify successful synchronization with the Appthority 1603 

cloud service by accessing the Appthority MTP portal and navigating to Admin > EMM and 1604 

viewing items under Connector Status. 1605 

https://help-mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html
https://help-mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html
https://help-mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html
https://help-mtp.appthority.com/SetUp/EMM/EMM_Script/RunEMMDeployScript.html
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Figure 2-134 Appthority EMM Connector Status 1606 

 1607 

2.9 Registering Devices with MobileIron Core 1608 

In this scenario, the employee manages their own personal apps, data, and many device functions. The 1609 

organization manages work-related apps and data, and has control over specific device functions, such 1610 

as requiring a complex device unlock PIN or being able to remotely wipe a lost device. The mechanisms 1611 

to achieve similar security characteristics between iOS and Android devices differ. 1612 

2.9.1 Supervising and Registering iOS Devices 1613 

Many MDM-based security controls are only applicable to iOS devices that are running in Supervised 1614 

Mode. The following steps outline how to place an iOS device into this mode, and then register with 1615 

MobileIron Core. 1616 

2.9.1.1 Resetting the iOS Device 1617 

Before a device can be placed into Supervised Mode, it must be in a factory-reset state with the 1618 

Activation Lock on the device removed. If Activation Lock is in-place, Configurator 2 will be unable to 1619 

place the device into Supervised Mode. 1620 
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2.9.1.1.1 Reset an Unsupervised Device Using Settings App 1621 
If a device is not already in Supervised Mode, it is recommended to have the current device user 1622 

manually reset and activate the device to factory settings using the following steps: 1623 

1. Navigate to Settings > General > Reset. 1624 

2. Select Erase All Content and Settings. 1625 

Figure 2-135 iOS Reset Screen 1626 

 1627 

1. At the warning that this will delete all media and data and reset all settings, select Erase 1628 

iPhone. 1629 
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Figure 2-136 Erase iPhone Confirmation 1630 

 1631 

1. At the warning that all media, data, and settings will be irreversibly erased, select Erase 1632 

iPhone. Once the reset process is complete, the device will reboot and need to be 1633 

activated. 1634 
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Figure 2-137 Erase iPhone Final Confirmation 1635 

 1636 

1. Once the device displays the Hello screen, press the Home key. 1637 

2. At the Select Your Language screen, select English. 1638 

3. At the Select Your Country or Region screen, select United States. 1639 

4. At the Quick Start screen select Set up Manually. 1640 

5. At the Choose a Wi-Fi Network screen, select the Service Set Identifier (SSID) for the 1641 

network and authenticate to your on-premises SSID Wi-Fi network; the device should 1642 

indicate it is being activated. Note: you may need to attempt activation again if there is a 1643 

delay in the device establishing connectivity to the internet. 1644 

6. Stop at the Data & Privacy screen. At this point, the device should be placed into 1645 

Supervised Mode using Configurator 2. 1646 
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2.9.1.1.2 Reset a Supervised Device Using Configurator 2 1647 
1. Connect the iOS device with the system running Configurator 2 over Universal Serial Bus 1648 

(USB). 1649 

2. On the device at the Enter Passcode screen (if locked), enter the device unlock passcode. 1650 

Figure 2-138 Entering iOS Passcode 1651 

 1652 

3. At the Trust this Computer? dialogue, select Trust. Note that this step, along with step that 1653 

follows, is only encountered the first time a device is paired with a given system. 1654 
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Figure 2-139 iOS Trust Computer Confirmation 1655 

 1656 

4. At the Enter Device Passcode to Trust This Computer screen: 1657 

a. Enter the device unlock passcode. 1658 

b. Select OK. 1659 
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Figure 2-140 Entering Passcode to Trust Computer 1660 

 1661 

5. In Configurator 2, select the representation of the connected device. 1662 

6. From the context menu, select Advanced > Erase All Content and Settings. 1663 
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Figure 2-141 Resetting iPhone in Configurator 2 1664 

 1665 

7. At the Are you sure you want to erase "<device name>"? dialogue, select Erase. 1666 

Figure 2-142 Configurator 2 Erase Confirmation 1667 

 1668 

8. At the License Agreement screen: 1669 

a. Review the license agreement. 1670 

b. Select Accept to agree to the license and continue using the software. 1671 
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Figure 2-143 Configurator 2 License Agreement 1672 

 1673 

9. Configurator 2 will take several minutes to restore the device to factory default settings. 1674 

Configurator 2 will also activate the device following restoration. 1675 

Figure 2-144 Restoring iPhone 1676 

 1677 
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2.9.1.2 Placing an iOS Device into Supervised Mode 1678 

iOS devices that have been factory reset and subsequently activated (the Activation Lock has been 1679 

removed) can be placed into Supervised Mode using software available from Apple, Configurator 2, by 1680 

the following steps: 1681 

1. Pair the target iOS device with the system running Configurator 2 over USB. 1682 

2. Navigate to Configurator 2 > Unsupervised; a representation of the connected device 1683 

should appear. 1684 

3. On the All Devices tab: 1685 

a. Select the representation of the paired device. 1686 

b. From the context menu, select Prepare; a wizard will open to guide the process. 1687 

Figure 2-145 Prepare Option in Configuration 2 1688 

 1689 

4. For the Prepare Devices step: 1690 

a. Enable Supervise Devices. 1691 

b. Select Next. 1692 
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Figure 2-146 Device Preparation Options 1693 

 1694 

5. For the Enroll in MDM Server step: 1695 

a. Ensure the Server drop-down menu has Do not enroll in MDM selected. 1696 

b. Select Next. 1697 
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Figure 2-147 Preparation MDM Server Selection 1698 

 1699 

6. For the Sign into the Device Enrollment Program step, select Skip. 1700 
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Figure 2-148 Signing into Apple Account 1701 

 1702 

7. For the Assign to Organization step: 1703 

a. If you have previously created your organization, select Next and continue with Step 9. 1704 

b. If you have not created your organization, from the Organization drop-down menu, 1705 

select New Organization... 1706 
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Figure 2-149 Organization Assignment Dialogue 1707 

 1708 

8. At the Create an Organization screen: 1709 

a. In the Name field, enter the name of your organization. 1710 

b. In the Phone field, enter an appropriate support number for your mobility program. 1711 

c. In the Email field, enter an appropriate support email for your mobility program. 1712 

d. In the Address field, enter the address for your organization. 1713 

e. Select Next. 1714 
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Figure 2-150 Creating an Organization 1715 

 1716 

9. If your organization has established a digital identity for placing devices into Supervised 1717 

Mode: 1718 

a. Continue with Step 10. Note: that the same digital identity must be used for any given 1719 

device. 1720 

b. Otherwise, continue with Step 14. 1721 

10. In the Create an Organization screen: 1722 

a. For the Generate or choose a supervision identity option, select Choose an existing 1723 

supervision identity. 1724 

b. Select Next. 1725 
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Figure 2-151 Supervisory Identity Configuration 1726 

 1727 

11. Select Choose... 1728 
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Figure 2-152 Organization Selection 1729 

 1730 

12. At the Choose a supervising identity for the organization dialogue: 1731 

a. Select the digital certificate from the list of those available to the system. 1732 

b. Select Choose. 1733 

Figure 2-153 Supervising Identity Selection 1734 

 1735 

13. At the Create an Organization screen, select Next. 1736 
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Figure 2-154 Selected Organization 1737 

 1738 

14. In the Create an Organization screen: 1739 

a. For the Generate or choose a supervision identity option, select Generate a new 1740 

supervision identity. 1741 

b. Select Next. 1742 
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Figure 2-155 Create an Organization Supervision Identity Configuration 1743 

 1744 

15. For the Configure iOS Setup Assistant step: 1745 

a. Ensure the Setup Assistant drop-down menu shows Show only some steps selected; 1746 

additional options will appear. 1747 

b. Enable each of the Privacy, Passcode, Apple ID, and Location Services check-boxes. 1748 

c. Select Prepare. 1749 
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Figure 2-156 Setup Assistant Configuration 1750 

 1751 

16. Configurator 2 will take several minutes to prepare the device and place it into Supervised 1752 

Mode. 1753 

Figure 2-157 Waiting for iPhone 1754 

 1755 

2.9.1.3 Registration with MobileIron Core 1756 

The following steps will register an iOS device in Supervised Mode with MobileIron Core, which uses a 1757 

web-based process rather than the Mobile@Work app. 1758 
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1. Using Safari, navigate to MobileIron Core page, substituting <FQDN> for that of your 1759 

organization's instance of MobileIron Core. In our example implementation, the resulting 1760 

URL is https://mi-core.govt.mdse.nccoe.org/go . 1761 

Figure 2-158 MobileIron Registration Page 1762 

 1763 

2. At the warning that the web site is trying to open Settings to show a configuration profile, 1764 

select Allow; the Settings built-in app will open. 1765 

https://mi-core.govt.mdse.nccoe.org/go
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Figure 2-159 Opening Settings Confirmation 1766 

 1767 

3. At the Settings > Install Profile screen: 1768 

a. Verify the Signed by field indicates the server identity is Verified. 1769 

b. Select Install. 1770 

Figure 2-160 Profile Installation 1771 

 1772 

4. At the Installing Profile screen, select Install. 1773 
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Figure 2-161 Profile Installation 1774 

 1775 

5. At the Warning screen: 1776 

a. Verify that information under Root Certificate and MDM is consistent with information 1777 

provided by your mobile device administrator. 1778 

b. Select Install. 1779 
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Figure 2-162 Profile Installation Warning 1780 

 1781 

6. In the Remote Management dialogue, select Trust. 1782 
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Figure 2-163 Profile Installation Trust Confirmation 1783 

 1784 

7. At the Profile Installed screen, select Done. The device is now registered with MobileIron. 1785 

Figure 2-164 Profile Installation Confirmation 1786 

 1787 

2.9.2 Activating Lookout for Work on iOS 1788 

The configuration of the Lookout for Work (iOS) app in the MobileIron app catalog causes a 1789 

configuration file to be included during automatic install. As a result, when a user first launches Lookout 1790 
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for Work, it should be activated without any user interaction. Additional action is required to grant 1791 

Lookout for Work the permissions necessary for it to provide optimal protection. 1792 

1. Launch the Lookout for Work app; activation occurs silently at the splash screen. 1793 

Figure 2-165 Lookout for Work Splash Screen 1794 

 1795 

2. At the welcome screen, select Continue. 1796 
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Figure 2-166 Lookout for Work Permission Information 1797 

 1798 

3. At the "Lookout Work" Would Like to Send You Notifications dialogue, select Allow. 1799 
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Figure 2-167 Notifications Permissions Prompt 1800 

 1801 

4. At the Allow "Lookout Work" To Access Your Location? dialogue, select Always Allow. 1802 
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Figure 2-168 Locations Permission Prompt 1803 

 1804 

5. Lookout for Work should automatically perform scans of device and app activity and 1805 

provide feedback to the user. 1806 
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Figure 2-169 Lookout for Work Home Screen 1807 

 1808 

2.9.3 Provisioning Work-Managed Android Devices with a Work Profile 1809 

In this scenario, Android devices are deployed as work-managed with a work profile. Enabling this 1810 

feature for AFW-capable devices requires a change to the AFW configuration. It also requires that the 1811 

device user already has a personal Google account to provision the work profile; it is not created as part 1812 

of the workflow to register a device with MobileIron Core. 1813 

2.9.3.1 Enable Work Profile on Work-Managed Devices 1814 

1. In the MobileIron Admin Portal, navigate to Policies > Configs > Configurations. 1815 

2. Enable the check box in the row for the AFW configuration. 1816 

3. In the Configuration Details pane, select Edit. 1817 
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Figure 2-170 MobileIron AFW Configuration 1818 

 1819 

4. In the Edit Android enterprise (all modes) Setting dialogue: 1820 

a. Enable Enable Managed Devices with Work Profile on the devices. 1821 

b. Enable Add Google account. 1822 

c. In the Google Account text box, provide a valid Google domain account. The example in 1823 

our reference implementation will map a MobileIron user ID of gema to and email 1824 

address of mdse.gema@gmail.com. See MobileIron Core 9.4.0.0 Device Management 1825 

Guide for AFW for a list of variables to appropriately adapt this field to your existing 1826 

identity management strategy. 1827 

d. Select Save. 1828 
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Figure 2-171 AFW Configuration 1829 

 1830 

2.9.3.2 Registering Android Devices 1831 

The following steps can only be completed when working with an Android device that is still set to (or 1832 

has been reset to) factory default settings.  1833 

5. When prompted to sign in with your Google Account: 1834 

a. In the Email or phone field, enter afw#mobileiron.core. 1835 

b. Select Next. 1836 
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Figure 2-172 MobileIron Enrollment Process 1837 

 1838 

6. When AFW prompts you to install Mobile@Work, select Install; this will download the 1839 

Mobile@Work client to the device. 1840 
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Figure 2-173 AFW Enrollment 1841 

 1842 

7. At the prompt to install MobileIron, select Install. 1843 
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Figure 2-174 MobileIron Installation 1844 

 1845 

8. At the Set up your device screen, select Accept. 1846 
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Figure 2-175 Accepting AFW Terms and Conditions 1847 

 1848 

9. This screen notifies the user of the data that Mobile@Work collects and how it is used. 1849 

When this information has been reviewed, select Accept. Mobile@Work will minimize and 1850 

return to the operating system home screen. 1851 
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Figure 2-176 MobileIron Privacy Information 1852 

 1853 

10. When MobileIron sends a Configuration Required notification, select the notification. 1854 
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Figure 2-177 MobileIron Configuration Required Notification 1855 

 1856 

11. On the Device Status > Create Work Profile screen, select Continue. 1857 
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Figure 2-178 MobileIron Device Status 1858 

 1859 

12. At the AFW prompt, select Continue. 1860 
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Figure 2-179 AFW Configuration 1861 

 1862 

13. AFW will notify the user that it is creating the personal workspace. The next two screens 1863 

repeat Steps 7 and 8 as above. 1864 
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Figure 2-180 AFW Workspace Creation 1865 

 1866 

14. At the Device Status > Work Profile Lock Preferences screen, select Continue. 1867 
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Figure 2-181 MobileIron Work Profile Lock Preferences 1868 

 1869 

15. The user will be prompted to create a passcode to protect the AFW container. 1870 

16. At the Device Status > Add Google Account screen, select Continue. 1871 
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Figure 2-182 MobileIron Google Account Configuration 1872 

 1873 

17. The user will be prompted to authenticate to the same Google domain account mapped to 1874 

their MobileIron account based on the email address set in the AFW configuration in 1875 

MobileIron Core. In our example implementation, the mapped Google account is 1876 

mdse.gema@gmail.com. 1877 

18. Once the Mobile@Work app has been provisioned with the user's account, the Device 1878 

Status screen should appear; the device has now successfully been provisioned into 1879 

MobileIron. 1880 
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Figure 2-183 MobileIron Device Status 1881 

 1882 
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Appendix A List of Acronyms 
AD Active Directory 

AFW Android for Work 

API Application Programming Interface 

CA Certificate Authority 

CN Common Name 

CSP Common Service Provider 

DMZ Demilitarized Zone 

DN Distinguished Name 

DNS Domain Name System 

DPC Derived Personal Identity Verification Credential 

EMM Enterprise Mobility Management 

FQDN Fully Qualified Domain Name 

GOVT Government 

HTTP Hypertext Transfer Protocol 

HTTPS Hypertext Transfer Protocol Secure 

IMEI International Mobile Equipment Identity 

ID Identifier 

IP Internet Protocol 

LAN Local Area Network 

LDAP Lightweight Directory Access Protocol 

MDM Mobile Device Management 

MDS Mobile Device Security 

MES Mobile Endpoint Security 

MTP Mobile Threat Posture 

NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 

NTP Network Time Protocol 

OU Organizational Unit 

OVA Open Virtualization Appliance 

PLIST Property List 
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SCEP Simple Certificate Enrollment Protocol 

SSH Secure Shell 

SSID Service Set Identifier 

SSL Secure Sockets Layer 

TLS Transport Layer Security 

URL Uniform Resource Locator 

USB Universal Serial Bus 

VLAN Virtual Local Area Network 

VPN Virtual Private Network 

WAN Wide Area Network 
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Appendix B Glossary 
Application 
Programming Interface 
(API) 

A system access point or library function that has a well-defined 
syntax and is accessible from application programs or user code 
to provide well-defined functionality [1] 

App-Vetting Process The process of verifying that an app meets an organization's 
security requirements. An app vetting process comprises app 
testing and app approval/rejection activities [2] 

Authenticate Verifying the identity of a user, process, or device, often as a 
prerequisite to allowing access to resources in an information 
system [3] 

Certificate A data structure that contains an entity’s identifier(s), the 
entity's public key (including an indication of the associated set 
of domain parameters) and possibly other information, along 
with a signature on that data set that is generated by a trusted 
party, i.e. a certificate authority, thereby binding the public key 
to the included identifier(s) [4] 

Certificate Authority 
(CA) 

A trusted entity that issues and revokes public key certificates 
[5] 

Demilitarized Zone 
(DMZ) 

An interface on a routing firewall that is similar to the interfaces 
found on the firewall’s protected side. Traffic moving between 
the DMZ and other interfaces on the protected side of the 
firewall still goes through the firewall and can have firewall 
protection policies applied. [6] 

Derived Personal 
Identity Verification 
(PIV)  

A credential issued based on proof of possession and control of 
the PIV Card, so as not to duplicate the identity proofing process 
as defined in [SP 800-63-2]. A Derived PIV Credential token is a 
hardware or software-based token that contains the Derived PIV 
Credential. [7] 

Hypertext Transfer 
Protocol (HTTP) 

A standard method for communication between clients and 
Web servers [8] 

Hypertext Transfer 
Protocol Secure (HTTPS) 

HTTP transmitted over TLS [9] 

Internet Protocol (IP) 
addresses  

Standard protocol for transmission of data from source to 
destinations in packet-switched communications networks and 
interconnected systems of such networks [10] 
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Lightweight Directory 
Access Protocol (LDAP) 

The Lightweight Directory Access Protocol, or LDAP, is a 
directory access protocol. In this document, LDAP refers to the 
protocol defined by RFC 1777, which is also known as LDAP V2. 
LDAP V2 describes unauthenticated retrieval mechanisms. [11] 

Local Area Network 
(LAN) 

A group of computers and other devices dispersed over a 
relatively limited area and connected by a communications link 
that enables any device to interact with any other on the 
network [12] 

Mutual Authentication  The process of both entities involved in a transaction verifying 
each other [13] 

Passphrase A passphrase is a memorized secret consisting of a sequence of 
words or other text that a claimant uses to authenticate their 
identity. A passphrase is similar to a password in usage, but is 
generally longer for added security. [14] 

Personal Identity 
Verification (PIV)  

A physical artifact (e.g., identity card, “smart” card) issued to a 
government individual that contains stored identity credentials 
(e.g., photograph, cryptographic keys, digitized fingerprint 
representation) so that the claimed identity of the cardholder 
can be verified against the stored credentials by another person 
(human readable and verifiable) or an automated process 
(computer readable and verifiable). PIV requirements are 
defined in FIPS PUB 201. [15] 

Risk Analysis  The process of identifying the risks to system security and 
determining the probability of occurrence, the resulting impact, 
and the additional safeguards that mitigate this impact. Part of 
risk management and synonymous with risk assessment. [16] 

Risk Assessment The process of identifying risks to organizational operations 
(including mission, functions, image, reputation), organizational 
assets, individuals, other organizations, and the Nation, resulting 
from the operation of an information system. [17] 

Root Certificate 
Authority (CA) 

In a hierarchical public key infrastructure (PKI), the certification 
authority (CA) whose public key serves as the most trusted 
datum (i.e., the beginning of trust paths) for a security domain 
[18] 
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